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购买 Sony PXW-X500 Solid-State Memory 
Camcorder 之后，必须设置内部时钟的日期

和时间以及用户语言。

有关如何设置的详情，请参见 “第一次使用本
摄像机时”（第 30 页）。

注意

将选购元件或附件安装到 PXW-X500 （称为 “摄

像机”）上或将其从摄像机上取下时，务必关闭摄

像机电源。

使用本机前
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2/3 英寸 “Power HAD FX” CCD

配备一个 2/3 英寸的 IT （隔行传输）逐行扫

描图像传感器 （具有 220 万像素的全高清

(1920 × 1080) 分辨率），以及一个可在拍摄

高质量视频时实现高灵敏度 F11 (1080/59.94i)
或 F12 (1080/50i) 的新开发的信号处理器

LSI。

慢 & 快动作功能

支持将慢 & 快动作拍摄作为特殊记录功能。 
使用此功能可以在拍摄慢速移动或快速移动

的物体时获得特殊视频效果。可以使用最高

1080/120P 的帧频拍摄全屏 HD 1920 × 1080
分辨率的视频 （请参见第 64 页）。

数字扩展器功能

配备最大 4 倍的数字扩展器功能。 以电子方

式扩展变焦范围，防止传统镜头扩展器镜头

中出现灵敏度下降 (F-drop)。 该功能还可与镜

头扩展器配合使用。

图像缓存记录

拍摄期间，摄像机会始终以设定间隔时间

（最长 15 秒）在内存中缓存视频和音频数

据，让您可以在实际开始记录前记录几秒连

续镜头。

支持多格式

除了传统的 MPEG HD， MPEG IMX，和

DVCAM 外，摄像机还支持使用高清 XAVC 
HD 格式、 HDCAM SR 中部署的 MPEG-4 
SStP 格式、 Apple ProRes 格式、 Avid 
DNxHD® 格式进行记录，从而可以在各种记

录材料中使用摄像机 （请参见第 40 页）。
* 使用 ProRes 和 Avid DNxHD® 格式时需要安装

PXWK-501 编解码器选件和 PXWK-502 编解码器

选件密钥 （需另购）。

同步记录功能

可以使用同步记录功能将同一视频同步记录

到两个 SxS 存储卡中。此功能对于在拍摄过

程中进行视频备份十分有用 （请参见第 66
页）。

无线功能

无线 LAN 模块功能和随附的 IFU-WLM3 
USB 无线 LAN 模块可用于从智能手机或平

板电脑配置和操作摄像机 （请参见第 74
页）。

摄像机拍摄 / 记录系统配置

使用预安装的 50 针接口，在摄像机上安装一

个 CA-FB70/TX70 高清摄像机适配器并连接

到 CCU，便可配成一个拍摄 / 记录系统 （请
参见第 149 页）。

GPS 功能

通过使用内置的 GPS 模块，摄像机可以记录

已记录视频的位置信息和时间信息，从而可

以在后期制作中追踪拍摄位置 （请参见第 73
页）。

外部输入记录功能

外部输入记录功能是标准包含内容，用于记

录 SDI 输入信号 （请参见第 152 页）。

其他功能

• ALAC （镜头自动彩色误差补偿）功能极

大减少了镜头所产生色差的特定斑纹 （请
参见第 125 页）。

• 可以使用伽马校正功能 （利用 Power HAD 
CCD 传感器的动态范围）来适当调整视频

的对比度 （请参见第 114 页）。还可以使

用用户伽马创建自定义伽马曲线 （请参见
第 144 页）。

• 聚焦补正功能可以在取景器中轻松聚焦。

（请参见第 24 页）

第 1章 概述

特点
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软件下载

当本机与 PC 连接使用时，请从以下网站下载

您需要的任何设备驱动程序、插件以及应用

程序软件。

Sony 专业产品网站：

美国 http://pro.sony.com
加拿大 http://www.sonybiz.ca
拉丁美洲 http://sonypro-latin.com
欧洲 http://www.pro.sony.eu/pro
中东、非洲 http://sony-psmea.com
俄罗斯 http://sony.ru/pro/
巴西 http://sonypro.com.br
澳大利亚 http://pro.sony.com.au
新西兰 http://pro.sony.co.nz
日本 http://www.sonybsc.com
亚太地区 http://pro.sony-asia.com
韩国 http://bp.sony.co.kr
中国 http://pro.sony.com.cn
印度 http://pro.sony.co.in

Sony Creative Software 软件下载页面：
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

a LIGHT （视频灯）开关

决定与 LIGHT 接口 （请参见第 11 页）连接

的视频灯打开和关闭的方式。

AUTO：当视频灯上的 POWER 开关位于打

开位置时，在记录模式下的摄像机将自

动打开视频灯。

MANUAL：使用视频灯的开关手动打开或者

关闭视频灯。

注意

当摄像机设置为以图像缓存模式记录时，无法在执

行开始记录的操作之前（或正在将数据保存到存储

器时）打开该视频灯。

b POWER 开关

打开 (?) 和关闭 (1) 主电源。

c DC IN （直流电源输入）接口 （XLR 
型， 4 芯，针型）

如果要使用交流电源来操作此摄像机，需要

将一条选购的直流电源线连接到此端子，然

后将电源线连接到 BC-L70、 BC-L160、
BC-L500 或另一个电池充电器的直流输出

端。

部件的位置和功能

电源
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d DC OUT 12V （直流电源输出）接口

（4 芯，孔型）

为选购的 WRR-855S/860C/861/862 UHF 合成

分集调谐器或 HDVF-750/L770 取景器供电

（最大 1.8 A）。

注意

除 UHF 合成分集调谐器外，不要连接任何设备。

e 电池安装盒靴

安装 BP-L80S 电池组。 此外，如果安装一个

AC-DN2B/DN10 交流适配器，您可以使用交

流电源来操作摄像机。

有关详情，请参见 “准备电源”（第 26 页）。

有关详情，请参见 “连接 UHF 便携式调谐器
（用于 UHF 无线麦克风系统）”（第 35 页）。

注意

为了保证您的安全，并确保摄像机正常运行， Sony
建议使用 BP-L80S 电池。

f 摄像机适配器接口

能连接 CA-TX70/FB70 高清摄像机适配器。 
要连接适配器，请取下盖子。

a 肩带接头

连接附带的肩带 （请参见第 38 页）。

b 附件靴

安装选购的附件 （如视频灯）（请参见第 38
页）。

c 取景器前后定位杆

在前后方向调整取景器的位置 （请参见第 28
页）。

d 取景器左右位置调整环

松开此环调整取景器的左右位置 （请参见第
28 页）。

e 取景器安装盒靴

连接取景器 （请参见第 27 页）。

f VF （取景器）接口 （26 芯矩形和

20 芯圆形）

模拟接口 （20 芯）用于连接 HDVF 系列取

景器，而数字接口 （26 芯）用于连接 HD 取

景器 CBK-VF02。
使用连接电缆将取景器连接至对应的接口。

注意

不要同时在两个接口上连接取景器。

g 镜头座固定橡胶盖

使用镜头锁定杆将镜头锁定在固定位置后，

将此橡胶盖安装在两个突出部分的底部。 用
于固定镜头座，防止镜头分离。

h 取景器前后定位旋钮 （LOCK 旋钮）

松开此旋钮调整取景器的前后位置 （请参见
第 28 页）。

i 安装选购的麦克风支架

安装选购的 CAC-12 麦克风支架 （请参见第
34 页）。 

j 肩托

抬起肩托锁定杆调整前后位置。当您将摄像

机放置在肩膀上进行操作时可调整到最方便

的位置 （请参见第 39 页）。

k LIGHT （视频灯）接口（2 芯，孔型）

可连接最大功耗为 50 W 的视频灯，例如

Anton Bauer Ultralight 2 或同等品 （请参见第
38 页）。

l 镜头电缆夹

固定镜头电缆。

m MIC IN （麦克风输入）（+48 V）接口
（XLR 型， 5 芯，孔型）

将立体声麦克风与此接口相连。 电源

（+48 V）通过这个接口提供。

附件连接
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n LENS 接口 （12 芯）

将镜头电缆与此接口相连。

注意

将镜头电缆连接到此接口或从此接口断开时，请先

关闭摄像机电源。

o 三角架安装

如果需要将摄像机放置在三脚架上，可以安

装三角架适配器 （可选）。

p 镜头座 （特殊的刀环）

安装镜头。

有关可使用的镜头的详情，请联系 Sony 服务代
表。

q 镜头锁定杆

将镜头插入镜头座后，使用此锁定杆旋转镜

头座环可以将镜头锁定在固定位置。

锁定镜头后，务必使用镜头座固定橡胶盖防

止镜头分离。

r 镜头座盖

向上推镜头锁定杆取下此镜头盖。 如果没有

安装镜头，则不要取下此镜头盖以防止灰尘

进入。

前面

a REC START （开始记录）键

按一下此键开始记录。 再按一下将停止记

录。 其操作与镜头上的 REC 键完全相同。

b SHUTTER 开关

设置为 ON （开）可以使用电子快门。 推到

SELECT 切换快门速度或设置快门模式。 操
作此开关时，将会在取景器屏幕上显示新设

置，并保持大约三秒。

有关详情，请参见 “设置电子快门”（第 46
页）。

c FILTER 旋钮

在内置到此摄像机中的四个 ND 滤镜之间切

换。

在使用此选择开关时，将会在取景器屏幕上

显示新设置，并保持大约三秒。

可以改变 Maintenance 菜单设置，使不同的白

平衡设置保存在不同的 FILTER 旋钮位置。 
您可以根据与滤镜选择关联的当前拍摄条件

获得最佳的白平衡。

有关详情，请参见 “调整白平衡”（第 44
页）。

d MENU 旋钮

更改项目选择或菜单内的设置 （请参见第 95
页）。

e AUTO W/B BAL（自动调整白平衡 / 黑
平衡）开关

激活白平衡 / 黑平衡自动调整功能。

WHITE：自动调整白平衡。 当 WHITE BAL
开关 （请参见第 14 页）被设置为 A 或

者 B 时，白平衡设置将被保存在相应的

内存中。 如果 WHITE BAL 开关设为

PRST，白平衡自动调整功能不起作用。

操作和接口部分 FILTER 旋

钮设置

ND 滤镜

1 CLEAR

2 1/4ND （衰减到大约 1/4）
3 1/16ND （衰减到大约 1/16）

4 1/64ND （衰减到大约 1/64）
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BLACK：自动调整黑设置和黑平衡。

即使正在操作 ATW （自动跟踪白平衡）功

能，您也可以使用 AUTO W/B BAL 开关。

如果您在自动白平衡调整过程中再次将此开

关推至 WHITE 侧，调整将被取消且白平衡

设置将返回到初始设置。

如果您在自动黑平衡调整过程中再次将此开

关推至 BLACK 侧，调整将被取消且黑平衡

设置将返回到初始设置。

f MIC （麦克风） LEVEL 旋钮

调节音频通道 1、 2、 3 和 4 的输入电平（请
参见第 49 页）。

右侧 （靠近前面）

a ASSIGN. （可指定） 1/2/3 开关

您可以在设置菜单的“Operation > Assignable 
Switch”（请参见第 133 页）上为这些开关指

定需要的功能。

作为工厂预设值， ASSIGN. 1/2/3 开关指定为

Off。

ASSIGN. 1/3 开关配备有一个指示灯，用于表

示为此开关指定了某个功能 （ON）还是没

有 （OFF）。

b COLOR TEMP. （色温）键

拍摄时可使用此键更改色温 （工厂预设

值）。 可将此键用作可指定开关 （请参见第
134 页）。

c ALARM （警告音音量调整）旋钮

控制通过内置扬声器或选购的耳机输出的警

告音音量。将此旋钮转动到最小位置时，听

不到声音。

但是如果设置菜单的“Maintenance > Audio > 
Min Alarm Volume”被设置为 [Set]，则即使

此音量控制位于最小位置也能够听到报警

音。

d MONITOR （监视器音量调整）旋钮

控制除警告音之外的其它通过内置扬声器或

耳机输出的声音音量。将此旋钮转动到最小

位置时，听不到声音。

e MONITOR （音频监视器选择）开关

您可以通过组合这两个开关选择您要听的通

过内置扬声器或耳机输出的音频。

下方开关：CH-1/2

下方开关：CH-3/4

a) 通过将立体声耳机连接到EARPHONE接口，您可

以收听立体声音频。 （设置菜单中的

“Maintenance >Audio >Headphone Out”必须设置

为 “STEREO”。）

上方开关 音频输出

CH-1/CH-3 通道 1 音频

MIX 通道 1 和 2 混合音频 （立体

声） a)

CH-2/CH-4 通道 2 音频

上方开关 音频输出

CH-1/CH-3 通道 3 音频

MIX 通道 3 和 4 混合音频 （立体

声） a)

CH-2/CH-4 通道 4 音频

ALARM

最小 最大
13



f ASSIGN. （可指定） 0 开关

您可以在设置菜单中使用 “Operation > 
Assignable Switch”指定功能 （请参见第 133
页）。

摄像机在出厂时设置此开关为 Off。
这是一个瞬时开关。 每次按一下此开关，可

打开或关闭指定到此开关的功能。

g GAIN 开关

可以在拍摄过程中根据光照条件转换视频放

大器的增益。 可以使用设置菜单中的

“Operation >Gain Switch”选择与低、中和高

设置对应的增益值 （请参见第 107 页）（工

厂预设值为 L=0 dB、 M=6 dB 和 H=12 dB）。

在调节此开关时，将会在取景器屏幕上显示

新设置，并保持大约三秒。

h OUTPUT/DCC （输出信号 / 动态对比

度控制）开关

在下列两种从摄像机模块输出的视频信号之

间切换。

BARS：输出彩条信号。

CAM： 输出正在拍摄的视频信号。当选择此

信号时您可以打开和关闭 DCC 1)。
1) DCC （动态对比度控制）：

如果背景亮度非常高，当按照拍摄对象调整并打

开光圈时，背景中的目标将会在闪光时丢失。 
DCC 功能将会抑制高亮度，恢复大部分丢失的影

像。 特别是在以下环境中拍摄时效果非常明显。

• 在晴朗的天气下拍摄处于阴暗环境中的人物。

• 以窗户为背景拍摄室内物体

• 任何高对比度的场景

i WHITE BAL （白平衡存储器）开关

白平衡的控制调整。

PRST：将色温调整到预设值 （工厂预设

值： 3200K）。 当您没有时间调整白平衡

时可以使用此设置。

A 或 B： 调用已保存在 A 或 B 中的白平衡调

整设置。将 AUTO W/B BAL 开关（请参
见第 12 页）推向 WHITE 位置可自动调

整白平衡并在存储器 A 或存储器 B 中保

存调整设置。

B (ATW1)）：如果将此开关设置为 B，而将

“Operation > White Setting > White 
Switch<B>”设为 ATW，将会激活

ATW。

即使在使用 ATW 时您也可以使用 AUTO 
W/B BAL 开关。

在调节此开关时，将会在取景器屏幕上显示

新设置，并保持大约三秒。
1) ATW （自动跟踪白平衡）：将根据光线的变化自

动调整拍摄画面的白平衡。

注意

视光线和被摄物体条件而定，可能无法使用 ATW
调整到合适的颜色。

例如：

• 用单色表示被摄物体时，例如天空、大海、地面

或花朵。 
• 当景物处于色温极高或极低的光源下时。 
 

如果 ATW 功能执行自动跟踪花费太长时间，或者

最终效果并不理想，则可启用 AWB 功能。

j MENU ON/OFF 开关

如果要使用此开关，需要打开上盖。

使用此开关可以在取景器屏幕或者测试信号

屏幕上显示菜单。 每次推下此开关时，菜单

屏幕就会打开或关闭。 此开关的功能与缩略

图屏幕操作部分中的 MENU 键的功能相同。

注意

关闭上盖不会关闭菜单屏幕。

k MENU CANCEL/PRST （预设） /
ESCAPE 开关

如果要使用此开关，需要打开上盖。

根据菜单的显示与否，该开关具有不同的功

能。

显示菜单时，按下列方法使用开关。

CANCEL/PRST：当设置菜单上的设置更改

后上推此开关到此位置，将显示是否取

消前面的设置的确认信息。 再次将此开

关上推到此位置，就会取消前面的设置。

在设置菜单的设置更改之前或设置菜单

的设置更改取消后，上推此开关到此位

置将会显示是否将设置恢复到初始值的

确认信息。 再次将此开关上推到此位置，

设置就会恢复到初始值。

ESCAPE：当打开包含分级结构的菜单页面

时使用此开关。 每次将开关推到此位置

时页面就会返回到分级结构中的上一级

菜单。

不显示菜单时，按下列方法使用开关。

CANCEL/PRST：每次向上推此开关时，就

会在取景器屏幕上显示确认菜单设置的

窗口和摄像机状态 （请参见第 53 页）。 
此窗口包含五个页面，每次向上推此开

关时可在这五个页面之间切换。 每个页

面大约显示 10 秒。

ESCAPE：如果要在显示后立即清除此页

面，可以将此开关向下推到 OFF 位置。
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l UTILITY SD 卡插槽

插入用于保存摄像机设置的 SD 卡。

m ACCESS 指示灯

在访问 SD 卡时亮起橙色。

n 开关上盖

打开上盖使用 MENU ON/OFF 开关或 MENU 
CANCEL/PRST/ESCAPE 开关。

右侧 （靠近后面）
 

a 内置扬声器

在记录和播放声音时可以使用此扬声器监视

E-E 1) 声音。扬声器也可以发出警报以增强

视觉警告的效果 （请参见第 156 页）。

如果将耳机连接到 EARPHONE 插孔，扬声

器的声音输出将被自动设置为静音。
1) E-E：“Electric-to-Electric”（电路到电路）模式

的缩写。 在 E-E 模式中，输入到摄像机的视频和

音频信号在经过内部电路后就被输出。 这可以用

于检查输入信号。

b LCD 监视器

显示剩余电量、剩余介质容量、音频电平、

时间数据等等。也可用于检查摄像机并播放

图像 （请参见第 21 页）。

可调整 LCD 监视器的位置和角度。

c WARNING 指示灯

发生异常时变亮或者闪烁 （请参见第 156
页）。

d ACCESS 指示灯

将数据写入记录介质或者从记录介质读取数

据时亮蓝色。

e 音频控制部分的防护罩

打开以访问音频控制部分 （请参见第 17
页）。

f 缩略图屏幕操作部分的防护罩

打开以访问缩略图屏幕操作部分 （请参见第
17 页）。

g F REV （快退）键和指示灯

反向高速播放。每次按下该键，播放速度按

× 4 t × 15 t × 24 的顺序变换。 反向高速

播放过程中此指示灯变亮。

h PLAY/PAUSE 键和指示灯

按此键可以通过取景器屏幕或者 LCD 监视器

来观看播放的视频图像。 在播放过程中此指

示灯变亮。

播放过程中再次按此键暂停，并输出静止图

像。 此时指示灯将每秒闪烁 1 次。

在播放或暂停时按下 F REV 或 F FWD 键，

开始继续或反向高速播放。

i F FWD （快进）键和指示灯

向前高速播放。每次按下该键，播放速度按

× 4 t × 15 t × 24 的顺序变换。 向前高速

播放过程中此指示灯变亮。
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j PREV （上一个）键

跳转到当前剪辑的第一帧。

在按下此键的同时按下 F REV 键，将跳转到

记录介质上记录的第一个记录剪辑的第一

帧。

如果您快速连续按两次此键，将跳转到前一

个剪辑的第一帧或当前剪辑的第一帧 （当前

面没有剪辑时）。

k STOP 键

按一下此键可以停止播放。

l NEXT 键

跳转到下一个剪辑的第一帧。

在按下此键的同时按下 F FWD 键，将跳转到

记录介质上记录的最后一个记录剪辑的最后

一帧。

m DISP SEL （显示选择） /EXPAND
（扩展功能）键

每次按一下此键， LCD 监视器中的显示改变

如下。

将来升级后会支持 EXPAND 键功能。

n HOLD （显示保持）键

按此键将使 LCD 监视器显示的时间数据立即

停止计数。 （时间代码发生器继续运行。） 
再次按此键会释放保持。

有关时间数据显示的详情，请参见第 21 页。

o RESET/RETURN 键

重置 LCD 监视器上时间数据显示中所显示的

值。 根据 PRESET/REGEN/CLOCK 开关 （请
参见第 17 页）和 F-RUN/SET/R-RUN 开关

（请参见第 17 页）的设置，此键会按下列方

式重置显示。

a) 对于记录在介质上的各帧的时间代码位，可用于

记录对用户有用的信息 （例如场景编号、拍摄位

置等）。

有关详情，请参见 “设置时间数据”（第 51
页）。

在缩略图屏幕显示或基本标记缩略图屏幕显

示过程中按下此键时，可返回到前一屏幕。

p DISPLAY 开关

此开关可以按照 COUNTER、TC 和 U-BIT 的

顺序循环显示 LCD 监视器上时间数据显示中

所显示的数据 （请参见第 21 页）。

COUNTER：显示记录 / 播放持续时间计数

器。

TC：显示时间代码。

U-BIT：显示用户位数据。

q BRIGHT （亮度）键

切换 LCD 监视器背景灯的亮度。

每次按下此键，即按照下表所示的顺序显示

下一个设置。 如果在 LCD 监视器关闭的情况

下按下此键，则 LCD 背景灯会点亮为 H 状

态。

显示屏指示 说明

带有叠加信息的视

频 （CHAR）
LCD 监视器显示与取景器

相同的文本信息。

不带叠加信息的视

频 （MONI）
仅出现视频。

状态显示

（STATUS）
出现计数器指示、警告、

音频电平和类似信息。 没
有视频图像。

开关设置 RESET/RETURN
键操作

DISPLAY 开关：
COUNTER

将计数器重置为

00:00:00:00。

DISPLAY 开关： TC
PRESET/REGEN/CLOCK 
开关：PRESET
F-RUN/SET/R-RUN 开关：
SET

将时间代码重置为

00:00:00:00。

DISPLAY 开关： U-BIT
PRESET/REGEN/CLOCK 
开关：PRESET
F-RUN/SET/R-RUN 开关：
SET

将用户位数据 a)重

置为 00:00:00:00。

设置 LCD 监视器背景灯

H 高 （在室外日光下观看 LCD 监视器

时选择此项）

M 亮度介于 H 和 L 之间。

L 低 （在室内或夜晚的室外观看 LCD
监视器时选择此项）

OFF 关闭 （显示器也关闭）
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缩略图屏幕操作部分和音频控制部分

a 缩略图指示灯

显示缩略图屏幕时此指示灯变亮。

b THUMBNAIL 键

按下该键显示缩略图屏幕 （请参见第 85 页）
并执行缩略图操作。

再按一下可以返回初始显示。

c SET 键和箭头键

使用这些键进行时间代码和用户位设置，以

及进行缩略图屏幕操作 （请参见第 87 页）。

显示菜单时，按下此键选择项目或确认设置

更改。

d MENU 键

每按一次此键，打开或关闭设置菜单显示。

此键的功能与 MENU ON/OFF 开关的功能相

同。

e F-RUN/SET/R-RUN（独立运行 / 设置 /
记录运行）开关

选择内部时间代码发生器的运行模式。 根据

开关的位置而定，操作模式的设置说明如

下。

F-RUN：时间代码保持前进，不管摄像机是

否在进行记录。 在时间代码与外部时间

代码同步时使用此设置。

SET：设置时间代码或用户位。

R-RUN：时间代码只在记录过程中增加。 使
用此设置可以使记录介质上的时间代码

保持连续。

有关详情，请参见 “设置时间代码”（第 51
页）。

有关详情，请参见 “设置用户位”（第 51
页）。

f LEVEL CH1/CH2/CH3/CH4 （音频通

道 1/2/3/4 记录电平）旋钮

当 AUDIO SELECT CH1/CH2 和 AUDIO 
SELECT CH 3-4 开关设置到 MANUAL 时，

调整要记录至通道 1、 2、 3 和 4 的音频电

平。

g AUDIO SELECT CH3-4 （音频通道

3/4 调整方式选择）开关

可以选择音频通道 3 和 4 的音频电平调整方

式。

AUTO：自动调整

MANUAL： 手动调整

h ESSENCE MARK 键

在缩略图显示出现在屏幕上时 , 根据在屏幕

上显示列表中所选择的项目而定，可以通过

按此键查看所选剪辑的以下基本标记帧的缩

略图显示，

All：显示标有基本标记的所有帧的缩略图。

Rec Start：显示标有 “记录开始”标记的帧

和各剪辑第一帧的缩略图 （第一帧无

“记录开始”标记时）。

Shot Mark1：显示已标记有拍摄标记 1 的帧

的缩略图。

Shot Mark2：显示已标记有拍摄标记 2 的帧

的缩略图。

您还可选择拍摄标记 0 和拍摄标记 3 到拍摄

标记 9。
如果您使用定义拍摄标记 0 到拍摄标记 9 的

名称的计划元数据记录剪辑，则会按定义的

名称显示列表中的选择项。

i SHIFT 键

此键可以与其它键组合使用。

j PRESET/REGEN （重新生成） /
CLOCK 开关

选择记录的时间代码类型。

PRESET：在介质上记录新的时间代码。

REGEN：从介质记录的已有时间代码开始连

续记录时间代码。 无论 F-RUN/SET/R-
RUN 开关如何设置，摄像机将按照

R-RUN 模式运转。

CLOCK：记录与内置时钟同步的时间代码。 
无论 F-RUN/SET/R-RUN 开关如何设置，

摄像机将按照 F-RUN 模式运转。
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k AUDIO SELECT CH1/CH2 （音频通

道 1/2 调整方式选择）开关

可以选择音频通道 1 和 2 的音频电平调整方

式。

AUTO：自动调整

MANUAL： 手动调整

l AUDIO IN (CH1/CH2/CH3/CH4）（音

频通道 1/2/3/4 输入选择）开关

可以选择通过音频通道 1、 2、 3 和 4 记录的

音频输入信号。

FRONT：从连接到 MIC IN 接口上的麦克风

输入的音频信号。

REAR：从连接到 AUDIO IN CH-1/CH-2 接口

上的音频设备输入的信号。

WIRELESS： 来自 UHF 便携式调谐器的音频

输入信号 （如果有安装）。

左侧和上部

a ASSIGNABLE 4/5 开关

您可以在设置菜单的“Operation > Assignable 
Switch”（请参见第 134 页）上为这些开关指

定需要的功能。

摄像机在出厂时设置此开关为 Off。

b GPS 模块

包含一个内置 GPS 模块。

注意

请勿在使用 GPS 功能时抓住摄像机的这个部位。
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c PC 接口

用于使本摄像机处于 USB 连接模式并将其用

作电脑的外部存储设备。 当连接到此接口的

电脑没有 ExpressCard 插槽时，每个插入摄像

机的存储卡都会被识别为此电脑的驱动器。

d 外部设备接口

保留供未来升级时使用。

e USB 无线 LAN 模块接口

通过连接选购的 IFU-WLM3 USB 无线 LAN
模块，将摄像机与智能手机、平板电脑或其

他设备通过 Wi-Fi 连接起来。

有关详情，请参见 “安装 IFU-WLM3”（第 74
页）。

f SxS 存储卡插槽

这两个插槽 （A 和 B）可以接收 SxS 存储卡

或其它记录介质 （请参见第 56 页）。

g ACCESS 指示灯

指示插槽 A 和 B 的状态（请参见第 56 页）。 
即便插槽上盖关闭，也可检查指示灯是否亮

起。

h EJECT 键 （SxS 存储卡）

要从插槽上取下记录介质，按一下 EJECT 键
以释放卡锁，然后再按一次此键。这样介质

就从插槽中出来一部分 （请参见第 56 页）。

i 插槽上盖

左右推动进行打开和关闭。

j PROXY SD 卡插槽

插入用于记录代理数据的 SD 卡。

k ACCESS 指示灯

在访问 SD 卡时亮起橙色。

l SLOT SELECT（SxS 存储卡选择）键

当插槽 A 和 B 内都装有 SxS 存储卡时，按此

键选择您要使用的卡 （请参见第 57 页）。

m HDMI 接口

连接 HDMI 设备 （如监视器或记录装置）以

输出 HD 或 SD HDMI 视频和音频信号。

n GENLOCK IN （强制同步信号输入）

接口 （BNC 型）

当摄像机被强制同步或者时间代码与外部设

备同步时，此接口将输入参考信号。 支持的

参考信号因下表中所示的当前系统频率而不

同。

o TC IN （时间代码输入）接口 （BNC
型）

要在本摄像机的时间代码上采用外部锁定，

输入参考时间代码。

有关详情，请参见 “设置时间代码”（第 51
页）。

p VIDEO OUT 接口 （BNC 型）

输出用于监视的视频信号。

q TC OUT （时间代码输出）接口
（BNC 型）

要将外部 VTR 的时间代码锁定到本摄像机的

时间代码，请将此接口连接到外部 VTR 的时

间代码输入接口。

系统频率 支持的参考信号

59.94i 1080/59.94i, 480/59.94i

59.94P 1080/59.94i, 480/59.94i

50i 1080/50i, 576/50i

50P 1080/50i, 576/50i

29.97P 1080/59.94i, 480/59.94i

25P 1080/50i, 576/50i

23.98P 1080/23.98PsF
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后面

a TALLY （后部讯号）指示灯 （红色）

在记录过程中变亮。 如果 TALLY 开关设为

OFF，则不变亮。操作 WARNING 指示灯

（请参见第 15 页）时，此灯也会闪烁。 取景

器前部的讯号指示灯和取景器屏幕上的 REC
指示以相同方式点亮或闪烁。

有关详情，请参见 “错误 / 警告系统”（第 156
页）。

b TALLY 开关

设置为 ON 激活 TALLY 指示灯功能。

c EARPHONE 插孔 （立体声，微型插

孔）

您可以在记录和播放声音时通过此插孔可以

监听 E-E 声音。 当发生报警时，您可以通过

耳机听到报警声音。 将耳机插入此插孔将自

动关闭内置扬声器。

您可以在设置菜单的“Maintenance > Audio > 
Headphone Out”上选择单声道或立体声。

d AUDIO IN 选择开关

选择连接到 AUDIO IN CH-1/CH-2 接口的音

频源。

LINE：当连接立体声放大器或其它外部音频

信号源时

AES/EBU：连接外部数字音频信号源时

MIC：连接麦克风时。

e +48V/OFF （打开 / 关闭 +48V 外部电

源）开关

根据用于音频输入的麦克风，在以下设置之

间切换。

+48V：麦克风需要使用外部电源 （幻像电

源）

OFF：麦克风使用内部电源或不使用电源

f SDI IN （SDI 输入）接口 （BNC 型）

将 HD SDI 信号源连接到摄像机时使用的接

口。

g AUDIO IN CH-1/CH-2（音频通道 1 和
通道 2 输入）接口 （XLR 型， 3 芯，

孔型）

这些是可连接音频设备或麦克风的通道 1 和

2 的音频输入接口。

h 底盖

用于保护连接至后面板接口的电缆。

松开将盖子固定到摄像机底部的螺丝，可根

据麦克风电缆插头或音频线插头的大小形状

调整盖子的位置。 调整好位置后，拧紧螺丝

以固定盖子。

i AUDIO OUT 接口（XLR 型，5 芯，针
型）

输出从音频通道 1 和 2 或者音频通道 3 和 4
记录的音频信号。

音频信号通过 MONITOR 开关选择。

j REMOTE 接口 （8 芯）

连接远程控制设备以远程控制摄像机。

注意

将远程控制设备连接到摄像机或者从摄像机上断开

远程控制设备的连接之前，务必关闭摄像机的 
POWER 开关。

k SDI OUT 1/2 接口 （BNC 型）

输出 HDSDI 或 SDSDI 信号 （带嵌入式音

频）。 您可以用设置菜单的 “Operation > 
Input/Output > SDI Out1 Output 或 > SDI Out2 
Output”来打开或关闭此接口的输出。
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a 分辨率指示灯

指示输出视频的分辨率。

b 记录格式指示灯

指示当前记录格式或当前正播放剪辑的记录

格式。

c 记录模式指示灯

d 文件格式指示灯

e 状态显示

PB：在介质播放过程中出现。

NDF：在选择全帧时间代码时出现。

EXT-LK：当内部时间代码发生器被锁定到连

接在 TC IN （时间代码输入）接口的外

部信号输入时出现。

HOLD：内部时间代码发生器的操作模式设

为 R-RUN 且停止时出现。

f 系统频率指示灯

指示当前正在播放或记录的视频的系统频

率。

g 音频格式指示灯

指示音频记录格式或当前正播放剪辑的音频

格式。

h 音频电平指示灯

指示通道 1 到 4 的音频记录或播放电平。

i 时间数据显示

根据 DISPLAY 开关的位置而定，在持续时

间、时间代码和用户位数据之间切换显示。

显示当前出现在时间数据显示中的数据类型

如下。

TCG：记录的时间代码

TCR：播放时间代码

UBG：记录的用户位

UBR： 播放用户位

CNT：计数器

DUR：持续时间

CLK：时间显示 （PRESET/REGEN/CLOCK
开关设为 CLOCK 时）

按下 HOLD 键时可以保留此时的时间代码

值，并按照以下格式显示时间代码。 再次按

HOLD 键将释放锁定功能，并按照正常格式

显示时间代码。

j 剪辑名称显示

在记录期间显示当前正在记录的剪辑的名称；

在记录待机期间显示要记录的下一个剪辑的名

称。

k 警告指示灯区域

在发生记录故障或者湿气凝结时显示警告。

有关详情，请参见 “错误 / 警告系统”（第 156
页）。

l 剩余介质容量指示灯

显示表示插槽内记录介质的剩余容量的条显

示段。

屏幕显示

信息屏幕

dB

指示灯 记录格式

16 位 • HD420 HQ
• DVCAM
• MPEG IMX 50

24 位 • HD422 50
• MPEG IMX 50
• XAVC Intra
• XAVC Long
• SStP
• DNxHD
• ProRes

这三个点表示时间代码以保持模式显示。
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m 剩余电池电量指示灯

显示电池剩余电量图标和剩余记录时间。

在拍摄 （记录或记录待机）和播放期间，取

景器屏幕会显示图像并在显示屏上附加摄像

机信息。

您可以使用 DISPLAY 开关在打开 / 关闭信息

显示之间切换。

待显示的信息与设置菜单的 “Operation > 
Super Impose”中的设置以及相应开关的设置

有关。

显示信息 （屏幕顶部）

a 扩展器指示灯

显示数字扩展器功能和镜头扩展器功能的状

态。

EX：镜头扩展器功能打开时显示

X2D：数字扩展器功能 (2 × ) 打开时显示

X3D：数字扩展器功能 (3 × ) 打开时显示

X4D：数字扩展器功能 (4 × ) 打开时显示

EX2D：镜头扩展器功能和数字扩展器功能

(2 × ) 同时打开时显示

EX3D：镜头扩展器功能和数字扩展器功能

(3 × ) 同时打开时显示

EX4D：镜头扩展器功能和数字扩展器功能

(4 × ) 同时打开时显示

使用通过数字扩展器功能分配的可指定开关

来打开 / 关闭数字扩展器。

注意

启用 Slow & Quick Motion 后，无法打开数字

扩展器。

b 白平衡模式指示灯

显示当前选择的白平衡自动调整存储器。

ATW：ATW （自动跟踪白平衡）模式

W:A：存储器 A 模式

W:B：存储器 B 模式

W:C：存储器 C 模式

W:P：预设模式

3200K：当分配了 Color Temp SW 3200K 的

可指定开关打开时显示

4300K：当分配了 Color Temp SW 4300K 的

可指定开关打开时显示

5600K：当分配了 Color Temp SW 5600K 的

可指定开关打开时显示

6300K：当分配了 Color Temp SW 6300K 的

可指定开关打开时显示

c 变焦位置指示灯 （装上镜头）

显示变焦镜头的变焦位置，从 0 到 99。

d 色温指示灯

显示白平衡的色温。

e 聚焦点指示灯 （装上镜头）

以与被摄物体的距离 （单位：米）来显示聚

焦点。

f 电子色温滤镜指示灯

当 CC5600K 功能打开时显示。

g 光圈位置指示灯 （装上镜头）

显示光圈位置设置。

h 记录模式指示灯

显示摄像机的下列记录操作状态。

取景器屏幕

SxSA SxSB Proxy

指示灯 含义

zRec 在记录过程中

Stby 在剪辑连续记录模式中停止

记录或在所有其他模式中记

录待机。

zCont Rec 正在进行剪辑连续记录

Cont Stby 在剪辑连续记录模式下记录

待机

zS&Q Rec 正在慢 & 快动作记录模式中

进行记录

S&Q Stby 在慢 & 快动作模式中记录待

机

zRec 在图像缓存模式下记录

zCache Stby 在图像缓存模式下记录待机

（z 为绿色）

CALL （红色） 受到外部连接设备的访问
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绿色讯号指示灯

表示摄像机处于下列状态。

• 在设置菜单的 “Maintenance > Camera 
Config > HD-SDI Remote I/F”设为 “Green 
Tally”，并从 SDI OUT 接口输出记录控制

信号。

• 接收到绿色指示信号 （摄像机上装有摄像

机适配器且连接摄像机扩展单元时）

i 无线接收器功能指示灯

摄像机中安装了插卡式接收器时显示

“W”，并显示可供接收器使用的各通道

（通道 1、通道 2 或通道 4）的接收电平。

正常：通过白色发光段指示灯的数量显示接

收信号电平的强度。

模拟接收器静音 / 数字接收器错误率警告：

通过灰色发光段指示灯的数量显示接收

信号电平的强度。

如果接收到的电平超过峰值：在指示灯位置

显示 “P”。 1)

接收器电池电量低：相应通道编号和指示灯

闪烁。 1)

1)当使用 DWR-S02D 时。

j S&Q Motion （慢和快）帧频指示灯

摄像机设为 “S&Q 动作”记录模式时显示拍

摄帧频。

k 电池电量 / 电压显示

根据电池电源类型显示如下指示灯。

l ND 滤镜指示灯

显示当前选择的 ND 滤镜的位置编号 （请参
见第 12 页）。
将 “Electrical CC”分配给可指定开关时，电

子 CC 滤镜的位置 （A/B/C/D）会显示在 ND
滤镜指示灯 （1 到 4）的右侧。

m 增益指示灯

显示使用 GAIN 开关设置的视频放大器的增

益设置 (dB)。

n 快门模式 / 快门速度指示灯

显示快门模式或快门速度。

有关详情，请参见 “设置电子快门”（第 46
页）。

o 景深指示灯 （安装了系列镜头）

使用条形显示景深。 在设置菜单的

“Operation > Display On/Off > Lens Info”中设

置显示单位 （可设为米或英尺）。

p GPS 指示灯

显示 GPS 状态。

有关详情，请参见 “获取位置信息 (GPS)”（第
73 页）。

q 记录格式 （图像大小）指示灯

显示 SxS 存储卡上记录的剪辑的图像大小。

r 记录格式 （系统频率和扫描方法）指

示灯

显示当前配置的摄像机系统频率和记录格式

扫描方法。

s 记录格式 （编解码器）指示灯

显示 SxS 存储卡上记录的剪辑的格式名称。

显示信息 （屏幕底部）

a AE （自动光圈）模式指示灯

使用图标和自动光圈优先级别显示自动光圈

功能的当前操作模式。

b ALAC 指示灯

当 ALAC （镜头自动彩色误差校正）设为自

动执行时显示 “ALAC”。

当安装了兼容 ALAC 的镜头、 ALAC 功能处

于开启状态且设置菜单中的 “Maintenance > 

电池类型 指示灯

Info 电池 电池剩余电量图标和剩余

记录时间

Anton/Bauer 电池 剩余电池电量 （用 % 表

示）

其他电池 输入电压

图标 含义
 

背景灯模式

 

标准模式

 

聚光灯模式

SxSA SxSB Proxy
23



Camera Config > ALAC”设置为 “Auto”
时，将会自动执行 ALAC。

c SDI 输出 REC 触发指示灯

显示发送到 SDI 接口输出的记录命令的叠加

状态。

当设置菜单中的 “Maintenance > Camera 
Config > HD SDI Remote I/F”设为

“Characters”时显示。

d 聚焦补正指示灯

显示表示检测聚焦度的区域的检测帧（Focus 
Area Marker），以及表示该区域内聚焦度的

水平条 （Focus Assist Indicator）。

e 代理指示灯

当代理记录打开时显示 “Proxy”（将设置菜

单中的 “Operation >Proxy Recording Mode 
>Setting”设为 “On”）。 设置时 “Proxy”
会闪烁。在传输代理文件期间显示 和传输

率 （%）。传输完成后， 会消失，表示

100% 完成传输。

f Wi-Fi 指示灯

使用图标显示 Wi-Fi 设置和接收状态。

g 时间代码外部锁定指示灯

当从外部信号源输入时间代码时显示时间代

码锁定。

状态 图标

Operation 
> Display 
On/Off 
> Wi-Fi 
Condition

Maintenance 
> Wi-Fi 
> Setting

Wi-Fi 操
作状态

Off – – –

On Off – –

Access Point 初始化 AP

（闪烁）

等待 / 连
接中

AP

Station 初始化
 

（闪烁）

接入点搜

索  

接入点连

接  

图标视信

号强度而

不同。

接入点授

权错误  
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h 伽马指示灯

显示伽马设置。

i 用于保存配置数据的 SD 卡指示灯

显示插入 UTILITY SD 卡插槽的 SD 卡 （用

于保存配置数据）的状态。

j 时间数据显示

显示用 DISPLAY 开关选择的剩余记录 / 播放

经过的时间、时间代码、用户位等 （请参见
第 16 页）。

k 剪辑名称显示

在记录期间显示当前正在记录的剪辑的名称；

在记录待机期间显示要记录的下一个剪辑的名

称。

l 音频电平表指示灯

显示音频通道 1 和 2 的电平。

m 适用于各个介质插槽的记录介质状态 /
剩余容量指示灯

显示 SxS 插槽 A、 SxS 插槽 B 和 PROXY SD
卡插槽中介质的状态和剩余容量。

SxS 插槽图标指示灯

例如：SxS 插槽 A （“SxSA”）。 SxS 插槽 B
的图标标有 “SxSB”标签。

SD 卡 （用于记录代理数据）图标指示灯

以数字形式显示剩余记录时间。

n 视频信号指示灯

以波形、矢量显示器或直方图实时显示视频

信号。

菜单设置 指示灯

Operation
> Display 
On/Off 
> Gamma

Paint > Gamma
Gamma Gamma 

Category
Gamma 
Select

Off – – – –

On Off – – Gamma 
Off

On STD STD1 
DVW

STD1

STD2 
x4.5

STD2

STD3 
x3.5

STD3

STD4 
240M

STD4

STD5 
R709

STD5

STD6 
x5.0

STD6

HG HG1 
3250G36

HG1

HG2 
4600G30

HG2

HG3 
3259G40

HG3

HG4 
4609G33

HG4

User User 1 User 1

User 2 User 2

User 3 User 3

User 4 User 4

User 5 User 5

图标 状态

已安装 SD 卡

SD 卡受到保护

（闪烁）

正在安装 SD 卡

图标 介质状态

– 未插入或未安装介质

 

已安装介质

 

（闪烁）

介质正在使用中

（橙色条）

记录 （激活）

（绿色指示灯）

播放 （激活）

（橙色条 + 绿色

指示灯）

记录 / 播放 （激活）

图标 介质状态

– 未插入或未安装介质

已安装介质

（闪烁）

介质安装

（橙色条）

记录 （激活）
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为安全起见，请仅使用下列 Sony 电池和交流

适配器。

• BP-L80S 锂离子电池

• AC-DN2B/DN10 交流适配器

注意

如果更换的电池不正确，就会有爆炸的危险。

只更换同一类型或制造商推荐的电池型号。

报销电池时，必须遵守当地的法律。

使用 BP-L80S 电池时，摄像机的连续操作时

间约为 145 分钟。

警告

请勿将电池放在阳光直晒、靠近明火或类似过热的

地方。

注意

电池的操作时间取决于电池的使用频率，以及使用

时的环境温度。

使用摄像机之前，请使用适合各电池的充电

器为电池充电。

有关电池充电步骤详情，请参见电池充电器的
操作手册。

使用电池时的注意事项

发热的电池可能无法重新充足电。

安装电池

1 将电池朝摄像机的背面按下，让电池
一侧的边线与摄像机的对准线对齐。

2 向下滑动电池，直至其 “LOCK”箭
头指向摄像机的对准线。

注意

如果电池组安装不正确，可能会损坏端子。

第 2章 准备工作

准备电源

使用电池 1BP-L80S
2将摄像机与电池线对齐。

1“LOCK”箭头
2摄像机上的对准线
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取出电池

按下此释放键，然后向上拔出电池。

注意

• 在记录和播放过程中 （右侧面板上的 ACCESS 指

示灯亮蓝色而卡槽部分的 ACCESS 指示灯亮橙色

时），千万不要取出电池。否则可能会损坏存储

卡上记录的数据。

• 更换电池前请先确保摄像机的电源已关闭。

使用与安装电池相同的方法将 AC-DN2B/
DN10 安装到摄像机上，然后将其连接到交

流电源上。

注意

当安装有取景器时，请勿将摄像机放在接目镜镜头

对着太阳的地方。 
直射阳光可通过镜头进入，在取景器内聚焦并导致

着火。

注意

取景器需另行购买。

以下步骤为安装 HDVF-20A 的示例。

有关安装其他取景器的步骤，请参见各取景器
附带的手册。

注意

安装取景器时，请注意以下几点。

• 将取景器接口耦合到摄像机的 VF 接口（20 芯）之

前，务必关闭摄像机的电源。 如果您在摄像机电

源打开时进行连接，取景器可能无法正常工作。

• 将取景器接口牢固地耦合到摄像机的 VF 接口上。 
如果耦合松动，视频上可能会出现干扰，或者讯

号指示灯可能无法正常运行。

有关取景器和摄像机连接的详情，请联系 Sony
服务代表。

1 1 松开取景器左右位置调整环，2 将
取景器安装到取景器安装靴上，然后

3 拧紧取景器左右位置调整环。

使用交流电源

释放键

连接到交流插座

安装取景器

安装取景器

取景器左右位置调整环

滑块制动器
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2 将取景器接口耦合到 VF 接口（20 芯）

上。

分离取景器

可以按照与下列安装步骤相反的顺序执行此

操作。 但是，从安装靴上分离取景器时，应

向上拉制动器。

要调整取景器的左右位置，请松开左右位置

固定环；要调整前后位置，请松开前后位置

锁定旋钮。

安装选购的 BKW-401 取景器旋转架后，您可

以将取景器旋转到垂直位置，以便在通过握

住手柄携带摄像机时，您的腿不会撞到取景

器。

1 松开前后取景器定位杆和前后取景器
定位旋钮，然后向前拉出取景器滑动

组件。

2 使用直径为 2.5 mm 的六角扳手，取下
取景器滑动组件。

3 使用附带的螺栓安装 BKW-401。

调整取景器位置

VF 接口 （20 芯）

取景器左右位置调整环

取景器前后定位旋钮 （LOCK 旋钮）

使用 BKW-401 取景器旋转架

带六角孔的
螺栓

取景器滑动组件

BKW-401 附带的螺栓
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4 调整前后位置，以使 BKW-401 的臂上

升时不会与手柄发生接触。

取下接目镜时，可以在较远的地方更为清楚

地观看屏幕。 另外，在分离接目镜后，您还

可以轻松清除取景器屏幕和反射镜上的灰

尘。

1 逆时针方向完全旋转接目镜锁定环，

将锁定环上的红色标记与取景器镜头
筒对齐。

2 分离接目镜。

还可以安装市面有售的保护滤光镜、特

写镜头等，即直径为 52 mm 的镜头。

重新安装接目镜

1 使接目镜锁定环上的红色标记与取景
器镜头筒对齐。

2 使接目镜末端的红色标记与接目镜锁

定环和取景器镜头筒上的红色标记对
齐。 然后，将接目镜插入取景器镜头

筒。

3 顺时针旋转接目镜锁定环，直到其
“LOCK”箭头指向取景器镜头筒上的

红色标记。

取景接目罩报废时，请更换新取景接目罩。

有关更换部件的详情，请联系 Sony 服务代表。

调整取景器焦距

旋转屈光度调节环，直到取景器图像达到最

清晰为止。

分离接目镜

调整位置以使臂不与
手柄发生接触

1锁定环
2锁定环对准标记
3取景器镜头筒对准标记

调整取景器焦距和屏幕

接目镜末端的对准标记

屈光度调节环
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调节取景器屏幕

通过如下所示的控制来调节取景器屏幕的亮

度、对比度和峰值。

轮廓：使用 PEAKING 旋钮调节。

对比度：使用 CONTRAST 旋钮调节。

亮度：使用 BRIGHT 旋钮调节。

第一次使用本摄像机时，请在菜单中配置以

下设置。

有关菜单操作的详情，请参见 “基本设置菜单
操作”（第 95 页）。

设置时区

设置使用区域的时区。 默认值为 “UTC 
Greenwich”。

1 在设置菜单中选择 “Operation > 
Time Zone > Time Zone”。

2 选择要使用的时区。

设置内部时钟的日期和时间

设置内部时钟的年、月、日和星期几。

1 在设置菜单中选择 “Maintenance > 
Clock Set > Date”。
出现 “Date”屏幕。

2 转动 MENU 旋钮选择年、月或日，然

后按一下此旋钮。
所选年、月或日变为可编辑。

3 旋转 MENU 旋钮选择年、月或日，然

后按一下此旋钮。

4 重复步骤 2 和 3 设置剩余位数。

5 按一下 SET 键。
内部时钟被设置为步骤 2 到 4 中设置的

日期。

接下来，设置时间。

1PEAKING 旋钮
2CONTRAST 旋钮
3BRIGHT 旋钮

第一次使用本摄像机时
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6 在设置菜单中选择 “Maintenance > 
Clock Set > Time”。
出现 “Time”屏幕。

7 时间的设置方式与日期的设置方式相
同。

8 按一下 SET 键。
内部时钟中已注册时间。

取消设置

按一下 “Cancel”键。

注意

安装或拆卸镜头前，务必关闭摄像机的电源。

有关镜头使用方法的信息，请参见镜头的操作
手册。

注意

镜头需另行购买。

1 向上推镜头锁定杆，然后从镜头座上
取下镜头座盖。

2 使镜头上的中心销与镜头座上的中心

定位插槽对齐，然后将镜头插入镜头
座。

3 按下镜头直至就位，然后向下推动镜
头锁定杆以锁定镜头。

安装后调整镜头

镜头座固定橡胶盖
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注意

如果镜头锁定不牢固，镜头可能会在使用摄像

机时脱落下来。 这样一来，可能会造成严重的

事故。 请务必牢固锁定镜头。 建议您在镜头锁

定杆上放置镜头座固定橡胶盖，如上图所示。

4 将镜头线连接到 LENS 接口。

5 使用电缆夹固定镜头线。

如果安装了像差补正镜头

像差补正功能将自动激活。 装上像差补正镜

头启动摄像机，可能需要比平时更长的时

间，因为启动时要加载数据。

有关像差补正镜头的详情，请联系 Sony 服务

代表。

如果镜头从长焦变至广角时没有对准焦距，

请调整基面焦距 （镜头安装基面到成像平面

之间的距离）。

安装或更换镜头之后只需如此调节一次。

调整时，请使用基面焦距调整图作为拍摄

物。

注意

• 如果您使用对比度不足的被摄物体，或者在调整

过程中移动摄像机或被摄物体，将导致调整错

误。

• 将目标 （基面焦距调整图）放置在成像于长焦端

屏幕中心的位置。 调整使得近距目标 （距离摄像

机比调整图更近的物体）无法进入广角端屏幕。

进行调整

1 将光圈设置为手动。

2 增大光圈，将附带的基面焦距调整图
放在距离摄像机大约 3 米的位置，然

后调整照明以获得满意的视频输出电
平。

3 松开 F.f 或 F.B 环 （基面焦距调整环）

上的固定螺丝。

4 使用手动或电动变焦将镜头设置为长
焦。

5 将摄像机对准调节图，同时旋转焦距

调整环以聚焦于该图。

6 将变焦环设置为广角。

7 旋转 F.f 或 F.B 环，直到调整图处于聚

焦状态。在此期间，千万不要触动聚
焦环。

8 重复执行步骤 4 到步骤 7 中的操作，直

到从广角到长焦模式下该调整图一直
处于聚焦状态。

9 拧紧 F.f 或 F.B 环的固定螺丝。

调整基面焦距

大约 3 m
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您可在取景器的麦克风支架 （可选）上安装

选购的 ECM-680S 立体声麦克风。

以下步骤为将麦克风支架安装至 HDVF-20A
的示例。

有关将麦克风支架安装至其他取景器的步骤，
请参见各取景器附带的手册。

1 松开螺丝并打开麦克风支架夹。

2 将麦克风放置在麦克风支架上。

1剥去麦克风衬垫两侧保护片的同
时，将麦克风衬垫缠绕在麦克风
上。

2将麦克风放置在支架中，使 “UP”
位于顶部。

3合上麦克风支架。
4拧紧螺丝。

有关如何执行此操作，请参见麦克风的操作
手册。

3 将麦克风电缆插入 MIC IN 接口，然后
将要从此麦克风记录音频的通道的

AUDIO IN 开关设置为 FRONT。

4 使用电缆夹固定麦克风电缆。

准备音频输入系统

将麦克风连接到 MIC IN 接口

麦克风支架夹
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通过选购的 CAC-12 麦克风支架，您最多可

以将两个单声道麦克风连接到 AUDIO IN CH-
1/CH-2 接口上。

下面是电容式麦克风 （例如 ECM-674/678）
的安装步骤。

有关如何安装 CAC-12，请参见 CAC-12 的操作
手册。

1 安装电容式麦克风。

1松开球节锁定杆。
2剥去麦克风衬垫两侧保护片的同

时，将麦克风衬垫 （薄片型，麦克
风附带）缠绕在麦克风上。

3将麦克风放置在支架中，使 “UP”
位于顶部。

4合上麦克风支架。
5拧紧螺丝。

6将麦克风定位至不干扰取景器的位
置，然后紧固球节锁定杆。

2 将麦克风电缆连接到 AUDIO IN CH-1
或 CH-2 接口上。

3 开关的设置方式如下。
• 将 AUDIO IN 开关设为 MIC 位置。

• 根据所用麦克风的类型，将 +48V/OFF
开关设置如下。

内部电源： OFF
外部电源： +48V

• 根据麦克风的连接通道，相应将

AUDIO IN CH1/CH2 开关设置为

REAR。

4 切换输入电平，使之与使用的麦克风
的灵敏度相匹配。
通过更改设置菜单“Maintenance >Audio 
>Rear MIC >CH1/CH2 Ref”的设置来切

换输入电平 （工厂预设值为 –60dB）。 有
关详情，请参见第 121 页。

注意

• 如果摄像机上的输入电平与麦克风的灵敏度不匹

配，高音可能会失真，而且信噪比可能会受影

响。

• 为了让摄像机上的AUDIO IN CH-1和CH-2接口能

够提供 48 V 的幻像电源，该接口为请安装 XLR
孔型接口 （3 芯）。 如果麦克风电缆本身为凹型

带有孔型接口，请使用转接器。

• 分离 CAC-12 麦克风支架之后，将用于安装支架底

座的螺丝装回原来的位置。

将麦克风连接到 AUDIO IN 接

口

麦克风

1AUDIO IN 选择开关
2单声道麦克风
3AUDIO IN CH1/CH2 开关
4至 AUDIO IN CH-1 或 CH-2 接口
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要使用 Sony 的 UHF 无线麦克风系统，请关

闭摄像机电源，然后安装下列 UHF 便携式调

谐器之一。

• DWR-S01D 数字无线接收器

• WRR-855S UHF 合成调谐器装置

• WRR-860A/861/862 UHF 合成分集式调谐器

有关这些装置的详情，请参见它们的的操作手
册。

注意

安装 WRR-862 必需选购 WRR 安装托架（维修部

件号：A-8278-057-B）。

有关详情，请联系您的经销商或 Sony 服务代表。

安装 DWR-S02D 或 WRR-855S

1 取下位于摄像机后面的固定便携式调

谐器 / 接收器压紧槽盖子的四个固定螺
丝，取下盖子。

2 将DWR-S02D或WRR-855S插入压紧

槽，然后拧紧这四个螺丝。

3 为想要输入音频信号的通道，将
AUDIO IN 选择开关设为 WIRELESS
（请参见第 18 页）。

要安装 WRR-862 （当使用 BP-L80S
电池时）

1 安装 WRR 调谐器配件（不附带；维修

部件号：A-8278-057-B）到摄像机的
后面。

1使用十字螺丝刀拧紧调谐器配件中

的四颗螺丝。

注意

确保所有四个螺丝都完全拧紧。

2松开调谐器配件的调整螺丝。
3调整所要连接的 BP-L80S 电池的调

谐器安装位置，然后拧紧调整螺丝
将其安装到位。

4安装 WRR-862 附带的安装盘。

有关 WRR 调谐器配件 （维修部件号：
A-8278-057-B），请联系 Sony 服务或销售代
表。

2 安装电池组。

有关如何安装电池组，请参见 “安装电池”
（第 26 页）。

连接 UHF 便携式调谐器 （用于

UHF 无线麦克风系统）

DWR-S02D 或 WRR-855S

BP-L80S

调整螺丝

安装盘 （随
WRR-862 附带）

十字螺丝刀
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3 在 WRR 调谐器配件上安装调谐器。

4 将调谐器电缆连接到摄像机的DC OUT
接口上，同时将音频输出电缆连接到

AUDIO IN CH-1 或 CH-2 接口上。

5 开关的设置方式如下。
• 将连接音频输出电缆的通道的 AUDIO 

IN 选择开关设置为 MIC。
• 设置音频输出电缆连接到 REAR 时的通

道 AUDIO IN (CH1/CH2/CH3/CH4）开

关。

如果 XLR 连接自动检测功能处于打开

状态，将自动选择音频记录的输入信

号，因此无需进行这样的设置。

连接向 AUDIO IN CH-1 或 CH-2 接口提供线

路输入信号的音频设备的音频输出接口。

开关设置

将连接音频信号源的通道的 AUDIO IN 选择

开关设置为 LINE。

选择要记录的音频输入

• 当 XLR 连接自动检测功能处于关闭状态

（工厂预设值）：必须为音频记录选择信

号，方法是将 AUDIO IN CH1 或 CH2 开关

设置为 REAR，这取决于连接外部音频设备

时使用的是 AUDIO IN CH-1 和 CH-2 接口

中的哪个接口。

• 当XLR连接自动检测功能处于打开状态时： 
将电缆连接到 AUDIO IN CH-1 或 CH-2 接

口上时，无论 AUDIO IN CH1 或 CH2 开关

如何设置，将为音频记录自动选择该接口

的输入。

可通过设置菜单中的“Maintenance > Audio > 
Rear XLR Auto”来打开或关闭 XLR 连接自

动检测功能。

WRR-862

1AUDIO IN CH1/CH2 开关
2至 DC OUT 接口
3至 AUDIO IN CH-1 或 CH-2 接口
4AUDIO IN 选择开关

连接线路输入音频设备

1AUDIO IN CH1/CH2 开关
2至 AUDIO IN CH-1 或 CH-2 接口
3音频设备
4AUDIO IN 选择开关
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1 将选购的VCT-14/U14三脚架转接器安
装到三脚架上。

2 将三角架转接器安装到摄像机上。

3 前后来回移动摄像机，确保其已牢固

连接。

从三角架转接器上卸下摄像机

按住红色键的同时按照箭头所示方向拉出锁

定杆。

注意

即便在取下摄像机之后，三角架转接器的固定销可

能依然处于啮合位置。 如果发生这种情况，按下红

色键并移动锁定杆 （如上所示），直到固定销返回

到收起位置。 如果固定销一直处于啮合位置，就不

能在三脚架转接器上安装摄像机。

三角架安装

三角架安装

摄像机安装

沿着转接器中的凹槽向前滑动摄像机，
直至听到一声 “卡嗒”声。

锁定杆

红色键
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使用本摄像机，你可以使用 Anton Bauer 
Ultralight 2 或同等的视频灯 （12 V 电源，最

大功耗 50 W）。

• 如果您将视频灯连接到摄像机上的 LIGHT
接口并将 LIGHT 开关设置到 AUTO，您可

以在开始和停止记录在摄像机上时自动打

开和关闭此灯。

• 摄像机上的 LIGHT 接口的输出被控制在

12 V，即使摄像机的供电是 12 V 以上的电

源 （通过 DC IN 接口或电池供电）。 此灯

的亮度或色温不会根据电压的增大而改变。

注意

• 请勿连接功耗为 50 W 或更高的视频灯。

• 当供电电压 （通过 DC IN 接口或电池供电）低于

12 V 时，此灯的亮度或色温将改变。

安装视频灯

将视频灯安装在摄像机手柄上的附件靴上，

并将视频灯电缆连接到 LIGHT 接口。

注意

本摄像机上的附件靴为 1/4 英寸螺纹孔型。 如果要

更换为滑动型靴，可使用附带的冷靴套件。

安装肩带

1 将其中一个卡扣安装在肩带接头上。

2 按照相同的方式将另一个卡扣安装在

手柄另一侧的肩带接头上。

取下肩带

连接视频灯 使用肩带

向上拉动肩带锁住接头。

剪辑

按此处，然后沿着箭头所示的
方向将其释放。
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您可以在 40 mm 范围内前后滑动肩托。 做此

调整有助于您将摄像机放置在肩膀上进行拍

摄时获得最佳平衡。

1 抬起位于肩托中央的调整杆，松开肩

托。

2 将肩托向前或向后滑动，直至处于最
方便的位置。

3 放下锁定杆将肩托锁定到所选位置。

调节肩托位置

肩托
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有关菜单操作，请参见 “基本设置菜单操作”（第 95 页）。

可以为不同的视频分辨率和系统频率组合选择以下记录格式。

第 3章 调整和设置

设置视频格式

系统频率 视频格式

（设置菜单中的“Operation > Format > Rec Format”）

图像大小

59.94/50 XAVC-I 1080i 1920 × 1080
XAVC-I 720P 1280 × 720
XAVC-L 50 1080P 1920 × 1080
XAVC-L 50 1080i 1920 × 1080
XAVC-L 50 720P 1280 × 720
XAVC-L 35 1080P 1920 × 1080
XAVC-L 35 1080i

XAVC-L 25 1080i

HD422 50 1080i

HD422 50 720P 1280 × 720

HQ 1920 × 1080i 1920 × 1080

HQ 1440 × 1080i 1440 × 1080

HQ 1280 × 720P 1280 × 720

SStP SR-Lite 422 c) 1920 × 1080

DNxHD 220x 1080i a) c) 1920 × 1080

DNxHD 145 1080i a) c)

ProRes 422 HQ 1080i b) c)

ProRes 422 1080i b) c)

MPEG IMX 50 720 × 486/720 × 576
DVCAM 720 × 480/720 × 576
40



a) 使用PXWK-502编解码器选件时

b)使用PXWK-501编解码器选件时

c) 不支持代理记录和无线LAN连接功能。

SDI OUT 接口、 HDMI 输出接口和 VIDEO OUT 接口输出格式

下表中显示了根据设置菜单中的 “Operation >Format”设置，可以从 SDI OUT 接口、 HDMI 输
出接口和 VIDEO OUT 接口输出的信号。

29.97/25/23.98 XAVC-I 1080P 1920 × 1080
XAVC-L 50 1080P

XAVC-L 35 1080P

HD422 50 1080P 1920 × 1080
HD422 50 720P 1280 × 720

HQ 1920 × 1080P 1920 × 1080

SStP SR-Lite 422 c)

DNxHD 220x 1080P a) c) 1920 × 1080

DNxHD 145 1080P a) c)

ProRes 422 HQ 1080P b) c)

ProRes 422 1080P b) c)

操作菜单 VIDEO OUT 信号格式

Format Input/Output
Frequency Rec Format

（忽略编解码器）

Output Format 代理记录 / 无线 LAN 连接功

能

SDI HDMI OFF ON

59.94 1920 × 1080 P 1920 × 1080P
（Level A）

1920 × 1080P HD Y

1920 × 1080P
（Level B）

无信号 HD Y

1920 × 1080i 1920 × 1080i HD Y

720 × 486i 720 × 480i Composite HD Y

1920 × 1080 i 1920 × 1080i 1920 × 1080i HD Y

720 × 486i 720 × 480i Composite f) HD Y

1440 × 1080 i 1920 × 1080i 1920 × 1080i HD Y

720 × 486i c) 720 × 480i c) Composite —

1280 × 720 P 1280 × 720P 1280 × 720P HD Sync a)

720 × 486i 720 × 480i Composite HD Sync a)

720 × 480 i 720 × 486i 720 × 480i Composite Composite d)

无信号 720 × 480P Composite HD Y

29.97 1920 × 1080 P 1920 × 1080PsF 1920 × 1080i HD Y f)

720 × 486i 720 × 480i Composite f) HD Y

1280 × 720 P 1280 × 720P 1280 × 720P HD Y b)

720 × 486i 720 × 480i Composite HD Y b)

系统频率 视频格式

（设置菜单中的“Operation > Format > Rec Format”）

图像大小
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a) 1080i同步信号输出。

b) 1080PsF同步信号输出。

c) 代理记录和无线LAN连接功能打开时不支持。

d)字符信息 （叠加）的打开/关闭与SDI OUT2接口的输出同步。

e) HD同步，当选择Apple ProRes或Avid DNxHD®时。

f) 选择SStP、 Apple ProRes或Avid DNxHD®时，与SDI OUT2接口输出的打开/关闭设置同步。

g)选择SStP时，与SDI OUT2接口输出的打开/关闭设置同步。

23.98 1920 × 1080 P 1920 × 1080PsF 无信号 HD Y f)

1920 × 1080i
(2-3PD)

1920 × 1080i
(2-3PD)

HD Y/
HD Sync e) f) g)

HD Y

720 × 486i 
(2-3PD)

720 × 480i
(2-3PD)

Composite f) HD Y

1280 × 720 P 1280 × 720P
(2-3PD)

1280 × 720P
(2-3PD)

HD Y b)

720 × 486i 
(2-3PD)

720 × 480i
(2-3PD)

Composite HD Y b)

50 1920 × 1080 P 1920 × 1080P
（Level A）

1920 × 1080P HD Y

1920 × 1080P
（Level B）

无信号 HD Y

1920 × 1080i 1920 × 1080i HD Y

720 × 576i 720 × 576i Composite HD Y

1920 × 1080 i 1920 × 1080i 1920 × 1080i HD Y

720 × 576i 720 × 576i Composite f) HD Y

1440 × 1080 i 1920 × 1080i 1920 × 1080i HD Y

720 × 576i c) 720 × 576i c) Composite —

1280 × 720 P 1280 × 720P 1280 × 720P HD Sync a)

720 × 576i 720 × 576i Composite HD Sync a)

720 × 576 i 720 × 576i 720 × 576i Composite Composite d)

无信号 720 × 576P Composite HD Y

25 1920 × 1080 P 1920 × 1080PsF 1920 × 1080i HD Y f)

720 × 576i 720 × 576i Composite f) HD Y

1280 × 720 P 1280 × 720P 1280 × 720P HD Y b)

720 × 576i 720 × 576i Composite HD Y b)

操作菜单 VIDEO OUT 信号格式

Format Input/Output
Frequency Rec Format

（忽略编解码器）

Output Format 代理记录 / 无线 LAN 连接功

能

SDI HDMI OFF ON
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可根据需要切换系统频率。 摄像机将在切换

系统频率后自动重启。

1 在设置菜单中选择 “Operation > 
Format > Frequency”。

2 转动 MENU 旋钮选择系统频率，然后
按一下该旋钮。
出现一个确认对话框。

3 选择 [Execute]执行，或选择[Cancel]取
消，然后按一下 MENU 旋钮。

注意

记录 / 播放期间或当显示缩略图屏幕时，不能更改

系统频率。

可根据需要切换视频格式。

1 在设置菜单中选择的 “Operation > 
Format > Rec Format”。

2 转动 MENU 旋钮更改视频格式，然后

按一下该旋钮。
出现一个确认对话框。

3 选择 [Execute]执行，或选择[Cancel]取
消，然后按一下 MENU 旋钮。

为了确保使用此摄像机拍摄时获得绝佳的影

像质量，可能需要对黑平衡和白平衡进行调

整。

黑平衡和白平衡的调整值是由摄像机自动设

置的。另外，各种设置都存储在摄像机的存

储器中。即便关闭摄像机的电源，这些设置

将一直保留其中。

在下列情况下，需要对黑平衡进行调整：

• 第一次使用本摄像机时

• 长时间不使用摄像机时

• 在周围温度变化很大的环境下使用摄像机

时

• 已经使用设置菜单的 “Operation > Gain 
Switch”对 GAIN 开关 （L/M/H/Turbo）的

值进行更改时。

通常，在关闭摄像机后使用时，无需调整黑

平衡。

在自动黑平衡模式下，将按照下列顺序进行

调整： 黑设置和黑平衡。 您可以从设置菜单

选择手动调整黑平衡。

下列情况下禁用自动黑平衡调节。

• 在记录过程中

• 特殊记录模式过程中

• 快门模式为 SLS 时

1 将 OUTPUT/DCC 开关设置到 CAM。

2 将AUTO W/B BAL开关推到BLACK然

后松开该开关。
执行过程中出现消息 “Executing...”，调

整结束时更改为 “OK”。

调整值被自动保存在存储器中。

注意

• 在调整黑平衡过程中，将自动关闭光圈。

• 在调整黑平衡过程中，将自动激活增益选择电

路，以便于您可以看见取景器屏幕上出现的抖

动，但这不属于故障。

切换系统频率

切换视频格式

调整黑平衡和白平衡

调整黑平衡
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如果无法自动调整黑平衡

如果无法正常完成黑平衡调整，取景器屏幕

上将出现一则错误消息，显示时间大约是 3 
秒。

下面列出了可能出现的消息。

如果出现上面任何一则错误消息，请重新调

整黑平衡。

如果再次出现这则错误消息，则需要进行内

部检查。

有关这项内部检查的信息，请参见维护手册。

注意

如果镜头线与 LENS 接口连接得不牢固，则无法对

镜头光圈进行调整。 如果发生这种情况，黑平衡将

是不正确的。

务必在光线条件变化时重新调整白平衡。

1 按如下所示设置开关和选择开关。
• GAIN 开关： L （设置为尽可能小的增

益值）

• OUTPUT/DCC 开关： CAM
• WHITE BAL 开关： A 或 B1)

1)仅当设置菜单的“Operation > White Setting > 
White Switch<B>”设为 [Memory] 时，调整

值才保存到存储器 B。

2 对 FILTER 旋钮进行设置，使其适于下
列光线条件。

3 使白测试卡和所要拍摄的物体处于相
同的光线条件下，然后放大被摄物体。
或者，还可以使用任意白色目标，如织

物或墙面。

最小绝对白色区域如下所述。

注意

确保矩形区域内没有亮点。

4 调整镜头光圈。
手动调整镜头：设置合适的光圈。

通过自动光圈调整镜头： 将镜头上的自

动 / 手动开关设置为自动。

5 将AUTO W/B BAL开关推到WHITE然
后将其释放。
执行过程中出现消息 “Executing...”，调

整结束时更改为 “OK：（被摄物体的色

温）”。

调整值被自动保存至在步骤 1 选择的存

储器 （A 或 B）中。

注意

如果摄像机具备带有自动光圈的变焦镜头，调

整过程中光圈可能会自动捕捉 1) 物体。 为了防

止出现这种情况，请调整镜头上的光圈增益旋

钮 （如 IG、 IS 或 S）。

有关详情，请参见镜头操作手册。

1)捕捉：影像重复变亮变暗是由重复响应自动

光圈控制引起的。

如果无法自动调整白平衡

如果无法正常完成白平衡调整，取景器屏幕

上将出现一则错误消息，显示时间大约是 3 
秒。下面列出了可能出现的消息。

错误消息 含义

NG：Iris not Closed 镜头光圈没有关闭；无法

进行调整。

NG：Timeout 按照标准尝试次数无法完

成调整。

NG：Out of Range 当前值和参考值之间的差

异超出调整范围，无法调

整值。

调整白平衡

错误消息 含义

NG：Low Light 白色视频电平太低。 可以增

大镜头光圈，或者提高增益。

NG：Timeout 按照标准尝试次数无法完成

调整。

NG：High Light 白色视频电平太高。 可以缩

小镜头光圈，或者更改 ND 
滤镜。

它是位于屏幕中央的矩形区域。
该矩形的两边是屏幕长度和宽度的 70%。
矩形区域内图像的 10% 或更大表面区域
必须为白色。
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如果显示上面任何一则错误消息，请重新调

整白平衡。如果再次出现这则错误消息，则

需要进行内部检查。

有关这项内部检查的信息，请参见维护手册。

如果没时间调整白平衡

将 WHITE BAL 开关设置为 PRST。

在切换 ND 滤镜后更改色温

切换 ND 滤镜后，可以将电子 CC （色彩校

正）滤镜分配给可以自动更改色温的 ND 滤

镜 （请参见第 12 页）。

1 在设置菜单中将 “Maintenance 
>White Filter >ND Filter C.Temp”设

为 “On”（请参见第 126 页）。

2 要将电子 CC 滤镜分配给 FILTER 旋钮
位置编号 1，请选择 [ND FLT 
C.Temp<1>]。要分配给位置 2 到 4，
请选择 [ND FLT C.Temp<2–4>]。

3 转动 MENU 旋钮选择想要的色温。

4 根据需要重复步骤 2 和 3。

用可指定的开关在电子 CC 滤镜之间
切换

您可以将在电子 CC 滤镜之间切换的功能指

定给一个可指定开关。 每次按一下此可指定

开关就会在已指定给最多四个位置 （A 到

D）的色温 （3200K/4300K/5600K/6300K）

之间切换。

与可指定开关的指定无关，您也可以用

RM-B150/B170/B750 远程控制设备在指定到

各位置的色温之间切换。

1 选择设置菜单中的 “Maintenance > 
White Filter”。

2 通过选择 [Electrical CC<A>] 到
[Electrical CC <D>] 中的一个选项来选
择用于指定 CC 滤镜的位置，然后转

动 MENU 旋钮选择想要的色温。

不设置色温

在选择电子 CC<C> 或 <D> 后选择

“-----”。

按下此可指定开关时，不显示该位置的

设置。 例如，如果为一个位置设置了

“-----”，然后在剩余的三个位置之间进

行切换。

3 根据需要重复步骤 2。

4 将电子 CC 滤镜切换功能

（ELECTRICAL CC）指定给某个可指
定开关 （请参见第 133 页）。

白平衡存储器

即使摄像机的电源关闭，也会保存储存在存

储器中的值，直到下次调节白平衡之时。

摄像机有两个白平衡存储器， A 和 B。您可

以将各 ND 滤镜的调整值自动保存到与

WHITE BAL 开关设置 （A 或 B）对应的存

储器中。 摄像机有四个内置的 ND 滤镜，一

共可以保存八个调整值 （4 × 2）。 但是，在

以下情况中存储器的内容与 ND 滤镜的设置

无关。

• 当把设置菜单的“Operation > White Setting 
> Filter White Memory”设为 Off，将分别分

配给 A 和 B 的存储器的数目限制为一个

时。

• 当电子 CC 滤镜切换功能被指定给某个可指

定开关时，或者链接了远程控制设备时。 
（在这些情况下，白平衡存储器的内容与电

子 CC 滤镜位置 （A 到 D）有关。）

此外，当将设置菜单的 “Operation > White 
Setting > White Swithch<B>”设为 [ATW （自

动跟踪白平衡） ]”，并且 WHITE BAL 设为

B 时， ATW 功能激活以根据光线的变化情况

自动调节拍摄画面的白平衡。

NG：Color 
Temp. High

照明物体的色温太高，无法

调整。 调整照明的色温，然

后更新存储器。

NG：Color 
Temp. Low

照明物体的色温太低，无法

调整。 调整照明的色温，然

后更新存储器。

NG：Out of 
Range

当前值和参考值之间的差异

超出调整范围，无法调整值。

NG：Poor White 
Area

被摄物体的白色表面太窄，

无法调整。

错误消息 含义
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下面列出了电子快门所能使用的快门模式和

所能选择的快门速度。

标准模式

选择此模式用于拍摄快速移动且有点模糊的

物体。

您可以将快门速度设置为两种快门模式之

一： Speed （速度）模式 （速度以秒为单位

设置）和 Angle （角度）模式 （速度以度为

单位设置）。

Speed 模式

a) 当摄像机处于 “慢&快动作”模式，且设置菜单

的 “Operation > Rec Function > Frame Rate”设为

大于系统频率的值时，无法选择此速度。

Angle 模式

180°、 90°、 45°、 22.5°、 11.25°

ECS （扩展的清晰扫描）模式

选择此模式用于拍摄监视器屏幕这类物体时

获得没有水平噪声带的影像。

如下表所示，可设置的快门速度范围根据慢

& 快动作 （S&Q）功能是打开还是关闭而变

化。

SLS （低速快门）模式

此模式用于在低照度情况下进行拍摄。 可在

设置菜单的 “Operation > Slow Shutter > 
Number of Frames”中将使用低速快门功能时

的累积拍摄帧数设为 2、3、4、5、6、7、8、
16。

注意

• 本摄像机处于 “慢 & 快动作”模式时，无法使用

SLS 模式。

• 无法在记录期间打开或关闭 SLS 模式，或者更改

累积的帧数。

注意

• 如果使用自动光圈，则快门速度增加时，光圈会

开得更大，从而降低景深。

• 可选快门速度会因当前系统频率而不同。

在 Speed 模式和 Angle 模式之间切
换

1 选择设置菜单中的 “Operation > 
Shutter > Mode”。

2 旋转 MENU 旋钮选择 [Speed] 或
[Angle]，然后按一下此旋钮。

设置快门模式和标准模式下的快门速
度

选定快门速度后，即使关闭了摄像机，仍一

直保留该快门速度。

1 将 SHUTTER 开关从 ON 推至

SELECT。
当前快门设置指示会在取景器中显示大

约 3 秒。

设置电子快门

快门模式

系统频率 快门速度 （单位： 秒）

59.94i
59.94P
50i
50P

1/60、
1/100、

1/120、
1/125、

1/250、 
1/500、

1/1000、
1/2000

29.97P 1/40
 a)、1/50

 a)、1/60、
1/100、

1/120、 
1/125、

1/250、
1/500、

1/1000、
1/2000

25P 1/33
 a)、1/50

 a)、1/60、
1/100、

1/120、 
1/125、

1/250、
1/500、

1/1000、
1/2000

23.98P 1/32
 a)、1/48

 a)、1/50
 a)、1/60、1/96、 

1/100、
1/120、1/125、1/250、1/500、 

1/1000、 1/2000

系统频率 快门速度 （单位： Hz）

S&Q：Off S&Q：On
59.94i 60.00 到 7000 —

59.94P 60.00 到 8000 60.00 到 8000
29.97P 30.00 到 8000 30.00 到 8000
23.98P 23.99 到 6000 30.03 到 6000
50i 50.00 到 7000 —

50P 50.00 到 7000 50.00 到 7000
25P 25.02 到 7000 30.00 到 7000

选择快门模式和快门速度
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2 在步骤 1 中的快门设置消失前，再次将

SHUTTER 开关下推至 SELECT。 重
复此步骤直到出现所需模式或速度。
在显示了所有模式和速度后，显示按照

下列顺序改变。
 

注意

根据帧频设置 （请参见第 64 页），某些快门速度

无法在慢 & 快动作模式中进行选择。 这些速度被最

慢的可选快门速度取代。

例如：如果将帧频设为 60 并将视频格式设为

HQ1280/29.97P 时进行慢 & 快动作拍摄：

快门速度指示如下。

慢 & 快动作模式关闭时

1/40t1/50t1/60t1/100t…

慢 & 快动作模式打开时

1/60t1/60t1/60t1/100t…

在 ECS 模式下设置快门速度

1 将快门模式设置为 ECS （参见前一个

项目）。

2 转动 MENU 旋钮选择想要的频率或帧
数。

在 SLS 模式下设置快门速度

1 选择设置菜单中的“Operation > Slow 
Shutter > Setting”并将快门模式设为
[On]。

2 选择设置菜单的 “Operation > Slow 
Shutter > Number of Frames”并选择
所需帧数。

为了便于将背光的物体拍摄成清晰的图像，

或者防止出现淡出的亮区，可以对自动光圈

调整的参考值进行更改。

设置自动光圈操作模式

设置使用自动光圈调节电平时使用的操作模

式。

1 选择设置菜单的 “Operation > Auto 
Iris > Mode”。

2 旋转 MENU 旋钮选择操作模式，然后

按一下此旋钮。

设置自动光圈的目标收敛电平

1 选择设置菜单的 “Operation > Auto 
Iris > Level”。

2 旋转 MENU 旋钮选择电平（–99 到 +99
之间），然后按一下此旋钮。

Speed 模式 （系统频率为 59.94i）

ECS 模式

设置自动光圈

操作模式 说明

Backlight 适用于在背光条件下拍

摄的模式

Standard 标准模式

Spotlight 适用于在聚光灯集中在

被摄物体时减少淡出的

亮区的模式。

收敛电平 说明

–99 将光圈设置为 2 f 光阑

或更暗

± 0 参考电平

+99 将光圈设置为 2 f 光阑

或更亮
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设置自动光圈速度

设置使用自动光圈调节电平时的操作速度。

1 选择设置菜单的 “Operation > Auto 
Iris > Speed”。

2 旋转 MENU 旋钮在 –99（最慢）到 +99
（最快）之间选择速度，然后按一下此
旋钮。

更改镜头光圈的参考值

根据标准值，可以在下列范围内设置镜头光

圈的参考值。

• +0.25 到 +1（增幅为 0.25）：光圈增大约 0.25
到 1 光阑

• –0.25 到 -1（增幅为 0.25）：光圈缩小约 0.25
到 1 光阑

另外，您还可以在进行光线检测的情况下设

置此范围。

1 将设置菜单中的 “Operation > Auto 
Iris > Iris Override”设为 “On”。

2 将 MENU ON/OFF 开关设为 OFF。

3 转动 MENU 旋钮更改参考值。

注意

一定要确认当前的快门模式不是 ECS。

取景器屏幕上的光圈位置指示灯 （请参
见第 22 页）将显示当前参考值。

要将光圈增大

从面向摄像机前部的视角逆时针转动

MENU 旋钮。

选择 +0.25、 +0.5、 +0.75 和 +1 中的一

个。

要缩小光圈

从面向摄像机前部的视角顺时针转动

MENU 旋钮。

选择 –0.25、 –0.5、 –0.75 和 –1 中的一

个。

更改后的参考值将一直保留，直到关闭

摄像机的电源为止。 即使更改了参考值，

每次打开摄像机的电源时，该参考值仍

还原为标准值。

设置自动光圈窗口

1 将设置菜单的 “Operation > Auto Iris 
> Detect Window Indication”设为
On。
此时，屏幕上将出现当前自动光圈检测

窗口。

如果不需要在屏幕上显示自动光圈检测

窗口，则将其设为 Off。

2 选择设置菜单的 “Operation > Auto 
Iris > Detect Window”。

3 转动 MENU 旋钮直至出现所需的自动

光圈检测窗口，然后按一下该旋钮。

如果选择 Var 在设置菜单中设置

“Operation > Auto Iris >  Iris Var Width、
Iris Var Height、 Iris Var、 Iris Var H 
Position、 Iris Var V Position”。

当您退出菜单时，在步骤 3 中选择的自动光

圈检测窗口将出现。

除非需要保持此窗口显示，可将设置菜单的

“Operation > Auto Iris > Detect Window 
Indication”设为 Off。

防止出现光线强度非常高的亮区问题

如果物体太亮，则光圈可能会缩小得很多，

导致整个影像很暗，这种情况称为过度曝

光。 在此情况下，打开剪辑亮区功能将会在

某一电平上修剪信号，降低自动光圈的影

响。

将设置菜单的 “Operation > Auto Iris > Clip 
High Light”设为 On。

项目 设置

Iris Var Width 窗口的宽度

Iris Var Height 窗口的高度

Iris Var H 
Position

窗口在水平方向的位置

Iris Var V 
Position

窗口在垂直方向的位置

阴影部分表示光线检测的区域。
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当您将 AUDIO SELECT 开关设置为 AUTO
时，自动调整记录在各通道上的模拟音频信

号的输入电平。 您也可以进行手动调整。

注意

即使您将 AUDIO SELECT 开关设置为 AUTO，数

字音频信号的输入电平也不会自动调整。

手动音频电平调整的目标音频电平

使用 –20 dB 作为目标电平进行调整。

如果音频电平表显示最大电平为 0 dB，则表

示输入电平过高。

1 要调整输入到 AUDIO IN CH-1 或 CH-2
接口的信号，请将 AUDIO IN CH1 或
CH2 开关设置为 REAR。
要调整两种输入信号，请将这两个开关

均设置为 REAR。

2 将与第 1 步选择的通道对应的 AUDIO 
SELECT 开关设置为 MANUAL。

3 使用步骤1中选择的通道的LEVEL旋钮

调整，使音频电平表的正常输入音量
最高显示为 –20 dB。

记录电平调整和音频电平控制之间的
对应关系

在设置菜单的 “Maintenance > Audio”中，

您可以选择由哪个音频电平控制来控制输入

到 AUDIO IN CH-1/CH-2 各接口的音频记录

电平。下面是菜单项目的设置与控制钮之间

的对应关系。

注意

如果输入 AES/EBU 数字音频信号，则无法使用摄

像机调整记录电平。

Rear1/WRR Level：通道 1 的记录电平

Rear2/WRR Level：通道 2 的记录电平

注意

将 LEVEL (CH1/CH2) 旋钮和 MIC LEVEL 旋钮的操

作联系在一起时，如果将 MIC LEVEL 旋钮设置为

0，则无法记录通道 1 和 2 中的音频信号。 调整

LEVEL (CH1/CH2) 旋钮之前，请先检查 MIC 
LEVEL 旋钮的位置。

1 将一个或两个 AUDIO IN 开关设置为
FRONT。

2 将第 1 步选择的所需通道的 AUDIO 
SELECT 开关设置为 MANUAL。

3 转动 MIC LEVEL 旋钮，然后进行调

整，使音频电平表的正常输入音量最
高显示为 –20 dB。

调整音频电平

手动调整 AUDIO IN CH-1/
CH-2 接口音频输入的音频电平

目标输入电平

输入电平过高

Setting 旋钮

Side1 LEVEL (CH1) 旋钮

Front MIC LEVEL 旋钮

Front+Side1 LEVEL (CH1) 旋钮和 MIC 
LEVEL 旋钮 （关联操作）

Setting 旋钮

Side2 LEVEL (CH2) 旋钮

Front MIC LEVEL 旋钮

Front+Side2 LEVEL (CH2) 旋钮和 MIC 
LEVEL 旋钮 （关联操作）

手动调整 MIC IN 接口的音频电

平
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记录电平调整和音频电平控制之间的
对应关系

在设置菜单的 “Maintenance > Audio”中，

您可以选择由哪个音频电平控制来控制前麦

克风输入的音频记录电平。下面是菜单项目

的设置与控制钮之间的对应关系。

MIC CH1 Level：通道 1 的记录电平

MIC CH2 Level：通道 2 的记录电平

注意

将 MIC LEVEL 旋钮和 LEVEL (CH1/CH2) 旋钮的操

作联系在一起时，如果将 LEVEL (CH1/CH2) 旋钮

设置为 0，则无法记录通道 1 和 2 中的音频信号。 
调整 MIC LEVEL 旋钮之前，请先检查 LEVEL 
(CH1/CH2) 旋钮的位置。

选择记录的音频

您可以用 AUDIO IN CH3/CH4 开关选择记录

在音频通道 3 和 4 上的音频。

调整音频记录电平

自动调整

将 AUDIO SELECT CH 3-4 开关设置为

AUTO。

手动调整

1 将AUDIO SELECT CH 3-4开关设置为

MANUAL。

2 通过设置菜单的 “Maintenance > 
Audio”下的 “Audio CH3 Level”和

“Audio CH4 Level”项目，选择用于
调整音频电平的旋钮。

Audio CH3 Level：通道 3 的记录电平

Audio CH4 Level：通道 4 的记录电平

此时，您可以使用这里选择的旋钮调整

音频通道 3 和 4 的电平。

Setting 旋钮

Side1 LEVEL (CH1) 旋钮

Front MIC LEVEL 旋钮

Front+Side1 LEVEL (CH1) 旋钮和 MIC 
LEVEL 旋钮 （关联操作）

Setting 旋钮

Side2 LEVEL (CH2) 旋钮

Front MIC LEVEL 旋钮

Front+Side2 LEVEL (CH2) 旋钮和 MIC 
LEVEL 旋钮 （关联操作）

记录通道 3 和 4 中的音频

CH3 开关 通道 3 的记录目标

FRONT 前麦克风音频

REAR 输入到 AUDIO IN CH-1 接口

的音频信号

WIRELESS 无线麦克风音频

CH4 开关 通道 4 的记录目标

FRONT 前麦克风音频

REAR 输入到 AUDIO IN CH-2 接口

的音频信号

WIRELESS 无线麦克风音频

Setting 旋钮

Side3 LEVEL (CH3) 旋钮

Front MIC LEVEL 旋钮

Front+Side3 LEVEL (CH3) 旋钮和 MIC 
LEVEL 旋钮 （关联操作）

设置 旋钮

Side4 LEVEL (CH4) 旋钮

Front MIC LEVEL 旋钮

Front+Side4 LEVEL (CH4) 旋钮和 MIC 
LEVEL 旋钮 （关联操作）
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时间代码的设置范围为 00 : 00 : 00 : 00 到 
23 : 59 : 59 : 29 （小时 ：分钟 ：秒 ：帧数）。

1 按下DISP SEL/EXPAND键将LCD监视
器中的显示切换至状态显示。

2 将 DISPLAY 开关设置为 TC。

3 将PRESET/REGEN/CLOCK开关设置
为 PRESET。

4 将 F-RUN/SET/R-RUN 开关设置为 
SET。
时间代码的第一位 （最左边）的数字会

闪烁。

5 使用上下箭头键更改此数字值，并使

用左右箭头键移动闪烁的数字。重复
此操作直至所有数字设置完毕。

将时间代码值重置为 00:00:00:00
按一下 RESET/RETURN 键。

6 将 F-RUN/SET/R-RUN 开关设置为

F-RUN 或 R-RUN。
F-RUN：独立运行。 时间代码发生器将

一直处于运行状态。

R-RUN：记录运行。 时间代码发生器只

在记录期间运行。

注意

当图像缓存模式激活时，不能通过将 F-RUN/SET/
R-RUN 开关设置为 SET 来设置时间数据。 要设置

时间数据，请关闭图像缓存模式。

设置 DF/NDF
您可以使用设置菜单的 “Maintenance > 
Timecode > DF/NDF”选择失帧 （DF）模式

或全帧 （NDF）模式。

保持连续的时间代码

将 F-RUN/SET/R-RUN 开关设置为 R-RUN
时，在介质上记录众多场景通常会产生连续

的时间代码。 但是，取出介质而在其它介质

上进行记录之后，即使重新使用原来的介质

进行记录，时间代码也不再连续。

在这种情况下，要使时间代码连续，请将

PRESET/REGEN/CLOCK 设置为 REGEN。

采用时间代码保存实际时间

将 PRESET/REGEN/CLOCK 开关设置为

CLOCK 时，可以采用时间代码保存实际时

间。 摄像机内部时钟的时间使用实际时间。

有关调整内部时钟的详情，请参见 “设置内部
时钟的日期和时间”（第 30 页）。

通过设置用户位 （最多可以设置 8 个十六进

制数字），您可以记录用户信息，如时间代

码跟踪的日期、时间或场景编号。

1 按下DISP SEL/EXPAND键将LCD监视

器中的显示切换至状态显示。

2 将 DISPLAY 开关设置为 U-BIT。

3 将 F-RUN/SET/R-RUN 开关设置为 
SET。
第一位 （最左边）的数字闪烁。

4 使用上下箭头键更改此数字值，并使
用左右箭头键移动闪烁的数字。重复

此操作直至所有数字设置完毕。

将用户位数据重置为 00 00 00 00
按一下 RESET/RETURN 键。

5 将 F-RUN/SET/R-RUN 开关设置为 F-
RUN 或 R-RUN，以便与时间代码发

生器的相关操作模式相对应。

注意

视频格式设为 ProRes 时，无法设置用户位。

用户位存储器功能

即使关闭了电源，用户位设置 （实际时间除

外）仍将自动保留在存储器中。

您可以将此摄像机的内部时间代码发生器和

外部发生器同步。  另外，您还可以将其它摄

像机 / VTR 的时间代码发生器与此摄像机的

内部发生器同步。

时间代码同步的连接

连接参考视频信号和外部时间代码，如下图

所示。

设置时间数据

设置时间代码

设置用户位

同步时间代码
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例 1： 与外部时间代码同步

示例 2： 互联多个摄像机 （包括一个参考摄

像机）

将时间代码锁定到外部信号源

1 打开 POWER 开关。

2 将PRESET/REGEN/CLOCK开关设置

为 PRESET。

3 将 F-RUN/SET/R-RUN 开关设置为

F-RUN。

4 将 DISPLAY 开关设置为 TC。

5 分别向TC IN接口和GENLOCK IN接口
提供符合 SMPTE 标准且具有适当相

位关系的时间代码信号和参考视频信
号。
这项操作可以将内部时间代码发生器与

外部时间代码同步。 如果时间码已锁定

约 10 秒钟，即使断开外部参考时间代码

源，外部锁定状态也会保持不变。

注意

• 完成上述步骤后，内部时间代码会立刻与外部时

间代码同步，且时间数据显示将显示外部时间代

码的值。 但是，记录之前，要等待几秒钟的时

间，直到同步发生器处于稳定状态。

• 如果参考视频信号的频率与摄像机的系统频率不

相同，就无法强制同步该摄像机。 如果发生这种

情况，由于外部时间代码被锁定，无法成功获取

时间代码。

同步时间代码时的用户位设置

同步时间代码时，只有时间数据与外部时间

代码值同步。

释放外部锁定

首先，切断外部时间代码，然后将 F-RUN/
SET/R-RUN 开关设置为 R-RUN。

在同步时间代码期间将电源从电池更改为外

部电源

要维持连续的电源，请在取出电池之前，将 
DC IN 接口连接到外部电源上。 如果先取出

电池，时间代码可能会不同步。

在同步时间代码时同步摄像机

在同步时间代码过程中，将该摄像机与

GENLOCK IN 接口的参考视频信号输入强制

同步。

外部时间代码

1GENLOCK IN 接口
2TC IN 接口

参考视频信号

1VIDEO OUT 接口
2TC OUT 接口
3TC IN 接口
4GENLOCK IN 接口

至要同步的其它摄像机
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状态屏幕允许您检查摄像机设置和各种类型

的状态信息。

具有如下表所示的七种状态屏幕。

显示状态屏幕

如果未显示菜单，将 MENU CANCEL/PRST/
ESCAPE 开关上推到 CANCEL/PRST 位置。 
每推一次按照上表给出的顺序选择下一个状

态屏幕。

摄像机状态屏幕

音频状态屏幕

系统状态屏幕

检查摄像机设置和状态
信息 （状态屏幕）

状态屏幕 显示屏指示

摄像机状态 与拍摄有关的设置和状态信息

音频状态 与音频输入和输出有关的设置

和状态信息

系统状态 与记录有关的设置和状态信息

视频输出状态 与视频输出有关的设置和状态

信息

可指定键状态 指定给可指定开关的功能名称

电池状态 安装到摄像机中的电池的状态

介质状态 有关记录介质的状态信息

显示项目 说明

Gain 增益电平 （单位：dB）
Shutter 电子快门状态

Gamma 伽马类别和曲线

White 白平衡模式设置

Gain Switch GAIN 开关状态

Zebra 斑马条纹状态

Iris 光圈 f 光阑值

Focal Length 焦距

Focus Distance 对焦距离

Depth Of Field 景深

Zoom Speed 为镜头 ZOOM 键配置的变

焦速度

显示项目 说明

CH 1/CH 2/CH 3/
CH 4

关于各通道的音频电平、输

入信号源、参考输入电平和

降风噪滤波器设置

显示项目 说明

System Frequency 系统频率

Rec Format 记录格式

Title Prefix 剪辑名称前缀

Picture Size 图像大小

Rec Function 已启用特殊记录格式和

设置

Picture Cache 打开 / 关闭图像缓存功能

Number 剪辑名称后缀

Gamma 正在使用的伽马类别

Proxy Recording 
Mode

打开 / 关闭代理数据记录

功能
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视频输出状态屏幕

可指定键状态屏幕

电池状态屏幕

介质状态屏幕

如果介质受到保护，会显示 标记。

显示项目 说明

SDI SDI OUT 接口输出设置 （输

出图像大小、输出形式、输出

率、叠加）

HDMI HDMI 接口输出设置 （输出图

像大小、输出形式、输出率、

叠加）

Video VIDEO OUT 接口输出设置

（输出图像大小、叠加）

显示项目 说明

Detected Battery 检测到的电池类型

Remaining 剩余电量 (%)
Charge Count 充电的次数

Capacity 剩余电量 (Ah)
Voltage 电压

Manufacture Date 电池制造的日期

Power Source 电源

Supplied Voltage 提供的电源电压

显示项目 说明

SxSA 插槽 A 中介质的剩余容量

（柱状图和剩余时间显示）和

介质寿命

SxSB 插槽 B 中介质的剩余容量

（柱状图和剩余时间显示）和

介质寿命

SD Proxy PROXY SD 卡插槽中介质的剩

余容量 （柱状图和剩余时间显

示）和介质寿命 （仅当可用时

显示）

SD Utility UTILITY SD 卡插槽中介质的

剩余容量 （柱状图和剩余容

量）和介质寿命 （仅当可用时

显示）
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本摄像机可将视频和音频记录到装载在一个

或两个存储卡插槽内的 SxS 存储卡 （不附

带）上。

可以结合以下设备使用摄像机来进行记录。

• MEAD-SD02 介质适配器 （仅支持 SDXC）
或 QDA-EX1 XQD ExpressCard 适配器

SxS 存储卡

请在本摄像机内使用 Sony SxS 存储卡 （SxS 
PRO 或 SxS-1）。

SxS PRO+ 系列

SxS PRO 系列

SxS-1 系列

以上列出的存储卡符合 ExpressCard 存储卡标

准。

• SxS、SxS PRO和SxS-1是Sony Corporation的
商标。

• ExpressCard标签和标志归Personal Computer 
Memory Card International Association 
(PCMCIA）所有， Sony Corporation 获准使

用。 所有其他商标和商品名称属于它们各自

的所有者。

使用 SxS 存储卡时的注意事项

• 在以下情况中记录数据可能会丢失或损坏。

- 在读取、写入或格式化 SxS 存储卡过程中

摄像机受到剧烈冲击或振动时，以及在读

取、写入或格式化过程中摄像机电源被关

闭或 SxS 存储卡被取出时

- 在易受静电或电磁噪声干扰的环境使用摄

像机时

• 请勿在以下环境中使用或存放 SxS 存储卡：

- 指定的环境范围之外

- 高温，比如夏天停泊在阳光照射下的汽车

里，阳光直晒或靠近加热器的地方

- 潮湿和有腐蚀性物质的地方

• 插入存储卡时，使带有标签的一侧面向正

确的方向。

• 使用携带盒携带和存放 SxS 存储卡，并牢固

地锁紧携带盒。

• 为了防止意外和不慎丢失数据，请备份保

存在 SxS 存储卡中的数据。 Sony 不对保存

在 SxS 存储卡中的数据损坏和丢失承担任

何责任。

• 请勿在指定的标签位置粘贴除附带标签外

的任何其它标签。 粘贴标签时，确保其未超

出标签位置。

• 使用本摄像机的格式化功能格式化在本摄

像机上使用的 SxS 存储卡。用其它设备格

式化的卡将被识别为无效卡，必须在本摄

像机上再次格式化。

但是，请注意本摄像机的格式化和删除功

能无法完全存储卡的数据。 丢弃或处理存储

卡之前，请使用商业数据擦除软件删除数

据，或进行物理性销毁。

• Sony 不对未完全擦除数据承担任何责任。 
介质的剩余容量不足时可能无法执行剪辑

操作。 这种情况下，请用电脑删除不需要的

文件后再执行。

第 4章 拍摄

使用 SxS 存储卡

关于 SxS 存储卡

SxS PRO   8
GB

标签位置
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• 将存储卡放入携带盒中或从盒中取出存储

卡之前，请完全打开盒子。

防止误删除

您可以通过将写保护开关推至 WP 位置来防

止意外记录、编辑和删除 SxS 存储卡上的数

据。

注意

当卡插槽内都装有 SxS 存储卡时，不要触摸写保护

开关。 请在设置写保护开关之前弹出存储卡。

装入 SxS 存储卡

1 将盖子滑到左边打开。

2 将 SxS 存储卡插入存储卡插槽。

ACCESS 指示灯将亮以橙色，然后亮以

绿色表示存储卡已可以使用。

3 关闭盖子。

ACCESS 指示灯状态

卡插槽 A 和 B 各有一个用于指示插槽状态的

ACCESS 指示灯。

弹出 SxS 存储卡

1 打开盖子，然后按下 EJECT 键以释放

卡锁并取出该键。

2 再按一次 EJECT 键弹出此卡。

注意

如果您在访问存储卡的过程中关闭摄像机电源或取

出存储卡，则无法保证数据的完整。卡上记录的所

有数据都可能会被丢弃。 在关闭摄像机电源或取出

存储卡之前，请始终确保 ACCESS 指示灯未亮起或

以绿色点亮。

装入和弹出 SxS 存储卡

写保护开关

将标签面向右插入。

指示灯 插槽状态

亮以橘黄色 正在访问 SxS 存储卡 （在读

取和写入数据时点亮）

亮以绿灯 待机 （装入的 SxS 存储卡已

准备好记录或播放）

不亮 • 未装入任何 SxS 存储卡。

• 装入了不可用卡。

• 已装入 SxS 存储卡，但选择

了另一个插槽。

按一下此键释
放卡锁。
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当插槽 A 和 B 内都装有 SxS 存储卡时，您可

以按 SLOT SELECT 键选择要使用的 SxS 存

储卡。

记录过程中如果选定的卡已满，摄像机自动

切换到另一张卡。

注意

播放过程中 SLOT SELECT 键被禁用。 即使按下此

键也不会切换存储卡。此键在显示缩略图屏幕 （请
参见第 85 页）时可用。

插入未格式化的 SxS 存储卡或按其他规格格

式化的存储卡时，会出现一条消息，通知您

此介质使用不同文件系统。 此时，按如下方

式格式化存储卡。

按工厂预设以 FAT 模式格式化 SxS 存储卡。

注意

必须在支持 exFAT 文件系统的 XDCAM 设备或本

摄像机上格式化 SxS 存储卡。 其它设备上格式化的

卡无法使用。

通过菜单操作进行格式化 （初始化）

可以通过菜单操作执行格式化。

1 选择设置菜单中的 “Operation > 
Format Media”。

2 选择 Media(A) （插槽 A）或 Media(B)
（插槽 B）。

3 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
出现提示您是否格式化此卡的确认屏幕。

4 转动 MENU 旋钮，在确认消息屏幕上

选择 [Execute]，然后按一下此旋钮。
开始格式化。

在格式化过程中，会显示消息和进度状态

（%），且 ACCESS 指示灯将亮以橘黄色。

格式化结束后，会出现一条完成消息。 按一

下 MENU 旋钮取消此消息。

格式化过程中的记录和播放

即使在格式化过程中，也可以使用装在另一

个插槽中的 SxS 存储卡进行记录和播放。

如果格式化失败

格式化操作可能会因为 SxS 存储卡被写保护

或此卡不是本摄像机可使用的指定类型而失

败。

此时将出现错误提示。 请按照错误提示中的

说明进行操作或更换为本机可用的 SxS 存储

卡。

注意

• 格式化存储卡会删除包括记录的视频数据和设置

文件在内的所有数据。 
• 使用本摄像机的格式化功能格式化在本摄像机上

使用的 SxS 存储卡。用其它设备格式化的卡将被

识别为无效卡，必须在本摄像机上再次格式化。

您可以通过检查显示在取景器内的记录介质

剩余容量指示器来检查装在两个插槽中的

SxS 存储卡的剩余容量。

通过各插槽内介质的剩余容量和当前视频格

式 （记录位速率）来计算剩余记录时间，并

以分钟为单位显示。

通过显示 “介质状态”屏幕，可查看柱状图

上的剩余容量 （请参见第 54 页）。

注意

标记在存储卡被写保护时出现。

何时更换 SxS 存储卡

• 记录过程中当两张存储卡的总剩余记录时

间下降至 5 分钟时，将出现警告消息

“Media Near Full”， WARNING 指示灯和

取景器屏幕上的 REC 指示开始闪烁且蜂鸣

器会鸣响。

请用一张有可用记录容量的存储卡替换记

录介质。

• 当总剩余记录时间下降至 0 时，如果您继续

记录，将出现消息 “Media Full”并停止记

录。

注意

一张 SxS 存储卡上最多可记录大约 600 个剪辑。

到达剪辑限制时，剩余记录时间显示更改为“0”
并出现消息 “Media Full”。

如果由于任何原因导致存储卡错误，必须在

重新使用此卡之前进行恢复。

当您装入需要恢复的 SxS 存储卡时，取景器

内将出现一条询问您是否要恢复的消息。

选择要使用的 SxS 存储卡

格式化 （初始化） SxS 存储卡
检查剩余记录时间

恢复 SxS 存储卡
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恢复卡

转动 MENU 旋钮选择 [Execute]，然后按一下

此旋钮。

开始恢复。

在恢复过程中，出现执行消息、进度指示

(%) 且 ACCESS 指示灯将亮以橙色。

恢复结束后，会出现一条完成消息。按一下

MENU 旋钮取消此消息。

如果恢复失败

• 被写保护的 SxS存储卡和发生存储器错误的

卡无法恢复。 恢复这类卡将出现警告信息。 
按照消息中的说明操作并取消保护或换另

一张卡。

• 如果您重新格式化，发生存储器错误的 SxS
存储卡可能还有用。

• 某些情况下，有些剪辑可以恢复而其它则

无法恢复。 已恢复的剪辑可以正常播放。

• 如果重复修复数次之后仍然出现消息

“Could not Restore Some Clips”，或许可能

通过下列步骤修复 SxS 存储卡。

1使用应用程序软件（请参见第 148 页）
将所需的剪辑复制到其他 SxS 存储
卡。

2在摄像机上格式化不可用的 SxS 存储
卡。

3将需要的剪辑复制到最新格式化的SxS
存储卡中。

在恢复过程中记录和播放

即使正在进行恢复，您也可以记录和播放另

一个卡插槽内的 SxS 存储卡。

注意

要恢复通过本摄像机记录的介质，请务必使用本摄

像机。

对于用除本摄像机外的其他设备或本摄像机的不同

版本 （即使型号相同）记录的介质，可能无法使用

本摄像机进行恢复。

支持用于保存配置数据的 SD 卡

SDHC 存储卡 * （Speed Class：4 到 10/ 非
UHS/ 容量：2 到 32 GB）
SD 存储卡 * （容量：最多 2 GB）
* 本手册中称为 “SD 卡”。

首次在摄像机中使用 SD 卡时，必须先进行

格式化。

必须使用摄像机的格式化功能对要在摄像机

中使用的 SD 卡进行格式化。 如果在将 SD 卡

插入摄像机时出现消息，请格式化 SD 卡。

1 选择设置菜单的“Operation > Format 
Media > SD Card (Utility)”。
出现提示您是否格式化此卡的确认屏幕。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
开始格式化。

在格式化过程中，会显示消息和进度状

态 （%），且 ACCESS 指示灯将亮以橘

黄色。

格式化结束后，会出现一条完成消息。 
按一下 MENU 旋钮取消此消息。

注意

格式化 SD 卡会擦除卡上的所有数据。数据一旦删

除，即无法恢复。

插入 SD 卡 （用于保存配置数据）

1 打开开关盖。

2 将 SD 卡 （用于保存配置数据）插入
UTILITY SD 卡插槽。

3 关闭开关盖。

使用 SD 卡保存配置数

据

格式化 （初始化） SD 卡

插入 / 弹出用于保存配置数据的

SD 卡
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弹出 SD 卡 （用于保存配置数据）

1 打开开关盖。

2 轻按 SD 卡，然后取出卡。

注意

• 如果在访问SD卡时关闭摄像机或取出SD卡，则无

法保证卡上数据的完整性。卡上记录的所有数据

都可能会被丢弃。 关闭摄像机或取出 SD 卡前，

务必确认 ACCESS 指示灯已熄灭。

• 插入 / 弹出 SD 卡时，注意不要让卡冲出。

可在 “介质状态”屏幕中检查 SD 卡上的剩

余容量 （请参见第 54 页）。

要在其他设备的插槽中使用在本摄像机上格

式化的 SD 卡，请先对卡进行备份，然后在

要使用的设备中重新格式化该卡。

注意

• 对于专业应用，使用其他介质将无法获得与使用

SxS 存储卡所获得的同样高的可靠性和耐久性。

• 我们不保证所有存储卡都可用于此摄像机。 有关

兼容的存储卡，请联系您的 Sony 经销商。

通过使用选购的 QDA-EX1 XQD ExpressCard
适配器，您可以将 XQD 存储卡插入 SxS 存

储卡插槽，并代替 SxS 存储卡将其用于记录

和播放。

有关使用 QDA-EX1 XQD ExpressCard 适配器的
详情，请参见适配器附带的使用手册。

注意

• 使用 XQD 存储卡可能无法恰当进行高速播放。

• 使用 “Slow & Quick Motion”记录功能的慢动作

记录不能与 XQD 存储卡一起使用。

格式化 （初始化）

首次在本摄像机中使用 XQD 存储卡时，必须

先进行格式化。

应使用摄像机的格式化功能对要在摄像机中

使用的 XQD 卡进行格式化。 如果在将 XQD
存储卡插入摄像机时出现消息，请格式化

XQD 存储卡。

如果插入未格式化的 XQD 存储卡或按其他规

格格式化的 XQD 存储卡，会出现要求确认格

式化介质的消息或通知您此介质使用不同文

件系统的消息。

1 选择设置菜单中的 “Operation > 
Format Media”。

2 选择 Media(A) （插槽 A）或 Media(B)
（插槽 B）。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
出现提示您是否格式化此卡的确认屏幕。

4 转动 MENU 旋钮，在确认消息屏幕上
选择 [Execute]，然后按一下此旋钮。

检查剩余容量

使用介质适配器

XQD 存储卡
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开始格式化。

在格式化过程中，会显示消息和进度状态

（%），且 ACCESS 指示灯将亮以橘黄色。

格式化结束后，会出现一条完成消息。 按一

下 MENU 旋钮取消此消息。

注意

格式化 XQD 存储卡会擦除卡上的所有数据，包括

受保护的视频。数据一旦删除，即无法恢复。

摄像机和电脑之间的连接

将记录的 XQD 存储卡插入摄像机中的插槽

中，然后使用 USB 电缆将摄像机连接到电

脑。

在其他设备的插槽中使用在本摄像机
上格式化的存储卡

首先请备份此卡，然后在要使用的设备中重

新格式化此卡。

通过使用选购的 MEAD-SD02 介质适配器，

您可以将 SDXC 卡插入 SxS 存储卡插槽，并

代替 SxS 存储卡将其用于记录和播放。

注意

请勿同时和其他存储卡一起使用 SDXC 卡。 如果同

时混用不同的卡，当介质存满时，摄像机无法切换

卡。

兼容的 SDXC 卡

SDXC 卡 （SD 速度等级：10 级）

有关使用 MEAD-SD02 介质适配器的详情，请参
见适配器附带的使用手册。

注意

• 如果记录格式为 ProRes，不能使用 SDXC 卡。

• 使用 SDXC 卡可能无法恰当进行高速播放。

• 使用 “Slow & Quick Motion”记录功能的慢动作

记录不能与 SDXC 卡一起使用。

格式化 （初始化）

首次在本摄像机中使用 SDXC 卡时，必须先

进行格式化。

应使用摄像机的格式化功能对要在摄像机中

使用的 SDXC 卡进行格式化。 如果在将

SDXC 卡插入摄像机时出现消息，请格式化

SDXC 卡。

如果插入未格式化的 SDXC 卡或按其他规格

格式化的 SDXC 卡，会出现要求确认格式化

介质的消息或通知您此介质使用不同文件系

统的消息。

使用下列步骤格式化卡。

1 选择设置菜单中的 “Operation > 
Format Media”。

2 选择 Media(A) （插槽 A）或 Media(B)
（插槽 B）。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
出现提示您是否格式化此卡的确认屏幕。

4 转动 MENU 旋钮，在确认消息屏幕上
选择 [Execute]，然后按一下此旋钮。

开始格式化。

在格式化过程中，会显示消息和进度状态

（%），且 ACCESS 指示灯将亮以橘黄色。

格式化结束后，会出现一条完成消息。 按一

下 MENU 旋钮取消此消息。

注意

格式化 SDXC 卡会擦除卡上的所有数据，包括受保

护的视频。数据一旦删除，即无法恢复。

摄像机和电脑之间的连接

将记录的 SDXC 卡插入摄像机中的插槽中，

然后使用 USB 电缆将摄像机连接到电脑。

在其他设备的插槽中使用在本摄像机
上格式化的存储卡

首先请备份此卡，然后在要使用的设备中重

新格式化此卡。

SDXC 卡

XQD 是 Sony Corporation 的注册商标。
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这部分介绍拍摄和记录的基本步骤。

开始拍摄之前，检查摄像机系统确认运行正

常。

1 安装一个完全充满的电池 （请参见第
26 页）。

2 装入一张或两张 SxS 存储卡 （请参见

第 56 页）。
如果您装入两张卡，摄像机在第一张卡存满

后自动切换到第二张卡。

3 将摄像机的 POWER 开关 （请参见第

10 页）设为 ON。

4 执行下列设置。
标记显示： On （请参见第 106 页）
光圈： 自动 （请参见第 47 页）
变焦：自动

摄像机输出：选择当前正在拍摄的图像

（摄像机图像），然后打开 DCC 功能

（请参见第 14 页）
时间代码超前模式：F-RUN （独立运

行）或 R-RUN （记录运行） （请参
见第 51 页）

音频输入通道选择： 自动 （请参见第 18
页）

5 将AUTO W/B BAL开关推到BLACK位

置来调整黒平衡 （请参见第 43 页）。

6 根据光线条件选择滤镜，并调整白平
衡 （请参见第 44 页）。

7 将摄像机对准目标并进行调焦和变焦。

8 如果您正在使用电子快门，请选择一

个合适的快门模式和速度 （请参见第
46 页）。

9 执行下列操作之一开始记录。
- 按一下 REC START 键 （请参见第 12
页）。

- 按一下镜头上的 VTR 键。

- 打开已指定了 Rec 功能的可指定开关

（请参见第 134 页）。

记录过程中，讯号指示灯、取景器的前

面板上的讯号指示灯以及取景器屏幕上

的 REC 指示均点亮。 根据需要进行调焦

和变焦。

注意

• 摄像机正在记录时 （右侧面板上的 ACCESS
指示灯亮以蓝色而卡槽部分的 ACCESS 指示

灯亮以橙色时），切勿将电池取出。 这样做

可能会丢失记录中断前数秒内的数据，因为

内部处理未正常结束。

• 记录过程中，播放控制键（EJECT、F REV、

F FWD、 NEXT、 PREV、 PLAY/PAUSE、
STOP）不起作用。

• 如果在 XAVC、 MPEG HD、 MPEG IMX 或

DVCAM 之间选择视频格式，可以在摄像机

打开时立刻开始记录。 但是，如果正在运行

同步记录功能 （请参见第 66 页）且时间代

码设为 REGEN，则不支持此功能。

10 如果要停止记录，请执行步骤 9 中列出

的操作之一。
TALLY 指示灯、取景器前面板上的讯号

指示灯以及取景器屏幕上的 REC 指示均

熄灭，且摄像机进入记录待机 (Stby) 模
式。

从步骤 9 和 10 之间记录的视频、音频和

元数据创建一个剪辑。

检查记录 （记录预览）

当摄像机在记录待机模式下时，按下分

配有 Rec Review 功能的可指定开关，以

正常速度播放剪辑的最后两秒。  按住分

配有 Rec Review 功能的可指定开关一秒

或更长时间，以四倍速度从在最后一帧

之前两秒的帧开始反向播放。  然后，释

放该键以正常速度从该点开始播放剪辑。  
剪辑播放到结束后， Rec Review 功能关

闭，摄像机返回 Stby 模式。

当 “Rec Review”功能被指定给镜头上

的 RET 键时，您也可以使用 RET 键进行

查看。

11 重复步骤 9 和 10 继续记录。
每重复一次，就在存储卡上创建另一个

剪辑。

注意

• 停止记录后，大约一秒钟内无法恢复记录。

基本操作

剪辑 1 剪辑 2 剪辑 3
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• 一张存储卡上最多可以记录600个剪辑。 即使存储

卡有足够的可用空间记录更多的剪辑，记录完

600 个剪辑后就无法继续记录。

剪辑名称

此摄像机会自动为所记录的剪辑生成一个八

字符剪辑名称 （包括四字符前缀和四位数

字）。

例如： ABCD0001
也可使用设置菜单中的 “Operation >Clip 
>Title Prefix”，将剪辑名称前缀设为用户指

定字符串 （长度为 4 到 46 个字符）。 （用

户指定前缀在记录以后无法更改。）

剪辑名称的后四位数字是自动生成的，按记

录的剪辑递增。

当摄像机处于待机 (Stby) 模式时，您可以播

放所有或部分最新记录的剪辑 （请参见第 61
页）。

1 插入要播放的 SxS 存储卡 （请参见第

56 页）。

2 按一下PREV键（请参见第16页）或F 
REV 键 （请参见第 15 页）定位要播

放的剪辑。

3 按一下 PLAY/PAUSE 键。
PLAY/PAUSE 指示灯点亮，且播放画面

出现在取景器内。

要暂停播放

按一下 PLAY/PAUSE 键。

暂停播放时， PLAY/PAUSE 指示灯闪烁。

再按一下此键返回到播放模式。

要高速播放

按一下 F FWD 键 （请参见第 15 页）或 F 
REV 键 （请参见第 15 页）。

要返回正常播放，按一下 PLAY/PAUSE 键。

要在存储卡之间切换

当装入两张存储卡时，按一下 SLOT SELECT
键 （请参见第 19 页）选择要激活的插槽。

不能在播放过程中切换存储卡。

停止播放

按一下 STOP 键：播放停止，且摄像机进入

E-E 模式。

按一下 THUMBNAIL 键：播放停止且取景器

中出现缩略图屏幕 （请参见第 85 页）。

当您在播放过程中开始记录时以及当您弹出

SxS 存储卡时，播放也停止且时间代码屏幕

出现在取景器。

播放已记录的剪辑
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本摄像机上可以用两种拍摄标记。 您可以将

它们记录在用户指定位置，以使编辑器更容

易找到这些位置。

每个剪辑上拍摄标记的最大数量为 999。

您也可以使用缩略图菜单在剪辑中添加和删除
拍摄标记。有关详情，请参见 “在剪辑上添加 /
删除基本标记”（第 90 页）。

要记录拍摄标记

支持下列两种方法。

• 打开分配有“Shot Mark 1”或 “Shot Mark 
2”功能的可指定开关。

记录拍摄标记后，“Shot Mark 1”或 “Shot 
Mark 2”指示将在取景器中的时间代码指示

附近显示大约 3 秒。

为了让编辑器更容易地选择好的剪辑，您可

以在记录的剪辑内设置剪辑标记。

添加 / 删除剪辑标记

您可以使用 “Thumbnail”菜单在以前记录的

剪辑中添加和删除剪辑标记。有关详情，请

参见 “在剪辑上添加 / 删除剪辑标记”（第
90 页）。

拍摄期间，摄像机会始终以设定间隔时间

（最长 15 秒）在内存中缓存视频和音频数

据，让您可以在开始记录前记录几秒连续镜

头。

当摄像机设为下列任一视频格式时，此功能

会启用 （请参见第 40 页）。
XAVC-I
XAVC-L
MPEG HD 422
MPEG HD 420
MPEG IMX 50

图像缓存模式和图像缓存时间设置

要在图像缓存模式下开始记录，必须先在

“Operation”菜单中设置图像缓存模式和内

存中的图像存储时间 （图像缓存时间）。

开始记录后，可以回溯方式记录的连续镜头

的持续时间由图像缓存时间决定。 下列情况

中，可以回溯方式记录的持续时间可能会减

少。

注意

• 选择图像缓存模式后，会开始在内存中存储视

频。 但是，如果在选择此模式后立即开始记录，

在选择图像缓存模式前立刻拍摄的图像部分将不

会被记录。

• 播放、记录预览或缩略图显示期间不会在内存中

存储图像，因此不支持在这些期间对图像进行图

像缓存记录。

设置图像缓存模式和图像缓存时间

1 在设置菜单中选择 “Operation >Rec 
Function >Picture Cache Rec”。

2 转动MENU旋钮选择 [On]，然后按一下

此旋钮。

3 在设置菜单中选择 “Operation >Rec 
Function >Cache Rec Time”。

4 转动 MENU 旋钮选择图像缓存时间设

置，然后按一下此旋钮。
可以选择 0 到 2、 2 到 4、 4 到 6、 6 到

8、 8 到 10、 10 到 12、 12 到 14 或 13 到

15 秒。

选择图像缓存模式后，除非更改设置，否则

会保持不变。

除了执行步骤 1 和 2 以外，还可以使用分配

了图像缓存功能的可指定开关 （请参见第
133 页）来选择图像缓存模式。

注意

• 一次只能使用一种特殊记录功能，如图像缓存记

录。

如果在使用图像缓存记录的同时启用了其他特殊

记录模式，图像缓存记录将自动释放。

• 更改系统设置 （如视频格式），清除内存中存储

的所有图像。 因此，如果在更改设置后立即开始

记录，则无法记录刚好在更改设置前拍摄的图

像。 系统会自动释放图像缓存模式。

• 记录期间无法设置图像缓存时间。

在图像缓存模式下记录时的设备操作

记录步骤基本相同，除了下列几点与正常操

作不同。

高级操作

记录拍摄标记

设置剪辑标记

记录回溯图像（图像缓存记录）
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• 如果在访问介质时开始记录，实际的记录

开始点可能延迟，甚至可能长于设置的图

像缓存时间。 延迟时间会随着记录的剪辑数

而增加，因此在图像缓存模式中应避免停

止记录后又快速重新开始记录。

• 无论 F-RUN/SET/R-RUN 开关如何设置，摄

像机将按照 F-RUN 模式运转。

• 在图像缓存模式中，不能通过将 F-RUN/
SET/R-RUN 开关设置为 SET 来设置时间数

据。

要设置时间数据，请先停止图像缓存模式。

• 如果当前选定插槽中介质的剩余记录时间

比图像缓存时间短，图像会被记录到非选

定插槽中的介质内 （如果该介质中有足够

的剩余记录时间）。

但是，如果非选定插槽中没有介质或如果

插槽中的介质没有足够的剩余记录时间，

则不会记录记录图像。 （取景器屏幕上将

会出现一条通知您剩余记录时间不足的消

息。）

• 即使在记录开始操作前设置了拍摄标记，

也不会记录拍摄标记。

如果在记录期间关闭本摄像机

• 如果将摄像机上的POWER开关设为OFF位

置，系统会访问该介质几秒钟直至电源关

闭以记录内存中存储的图像，然后会自动

关闭电源。

• 如果在记录期间取出电池、断开直流电缆

或关闭交流适配器，内存中存储的视频和

音频数据会被删除，且不会记录之前的图

像。 更换电池时应务必小心。

当视频格式 （请参见第 40 页）设为下列其

中一种格式时，您可以指定与播放帧速率不

同的记录帧频。

注意

如果在 XAVC 记录格式下拍摄，建议使用 SxS Pro+
存储卡。 使用其他 SxS 存储卡可能会受到限制，请

联系您的经销商。

a) 使用XAVC视频格式需要PXWK-503 Slow&Quick
选件 （需另购）。

通过用与播放帧频不同的帧频拍摄，您可以

获得比采用低速或高速播放以正常帧频记录

的内容更平滑的慢 & 快动作效果。

“Slow & Quick Motion”设置和拍摄

设置慢 & 快动作

1 选择设置菜单中的 “Operation > Rec 
Function > Slow & Quick Motion”。

2 转动MENU旋钮选择 [On]，然后按一下

此旋钮。
开始使用 “慢 & 快动作”功能，取景器

的记录状态指示灯区域中出现 “S&Q 
Stby”。

接下来，设置帧频。

3 选择设置菜单中的 “Operation >Rec 
Function >Slow & Quick Motion 
>Frame Rate”。

4 旋转 MENU 旋钮选择帧频，然后按一

下此旋钮。

完成设置后，在取景器屏幕的顶部出现系统

频率和帧频。 可在查看取景器中的显示时通

过转动 MENU 旋钮更改帧频。

即使在摄像机电源关闭后，慢 & 快动作模式

设置和帧频也会保留。

注意

• 如果视频格式设为 XAVC 且未安装 PXWK-503 
Slow&Quick 选件 （需另购）则无法使用 “Slow 
& Quick Motion”。

• 一次只能使用一种特殊记录功能，如 “慢动作和

快动作”。

• 如果在使用 “慢 & 快动作”时还启用了其他特殊

记录功能，则慢 & 快动作会被自动取消。

• 记录、播放期间或当显示缩略图屏幕时，不能设

置 “慢 & 快动作”。

• 如果设置了低速快门功能，则无法设置 “慢 & 快

动作”。

慢 & 快动作拍摄

记录格式 系统频率 S&Q 帧频

XAVC-I 
1080P a)

29.97P/23.98P/
25P

1 FPS 到 60 
FPS （1 个

FPS 单元）

72、 75、 80、
90、 96、 100、
110、 120 FPS

XAVC-L 50 
1080P a)

59.94P/50P/
29.97P/23.98P/
25P

XAVC-L 35 
1080P a)

59.94P/50P/
29.97P/23.98P/
25P

HD422 50 
1080P

29.97P 1 FPS 到 30 
FPS （1 个

FPS 单元）

23.98P

25P 1 FPS 到 25 
FPS （1 个

FPS 单元）

记录格式 系统频率 S&Q 帧频
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使用慢 & 快动作拍摄

按照 “基本操作”中的介绍进行拍摄 “基本
操作”（第 61 页）。

开始记录时，取景器中的 “S&Q Stby”指示

变为 “zS&Q Rec”。 TALLY 指示灯和取景

器前面板上讯号指示灯的点亮方式与正常记

录过程中的相同。

停止拍摄

停止记录。

注意

当帧频被设置为一个很低的值 （对于慢帧频）记录

停止时间会比正常情况长。

要退出慢 & 快动作模式

在摄像机处于记录待机模式时，将设置菜单

中的 “Operation > Rec Function > Slow & 
Quick”设置为 [Off]。

记录过程中的限制

• 与 F-RUN/SET/R-RUN 开关的设置无关，内

部时间代码发生器的超前模式始终是 R-
RUN。

• 当记录和播放帧频不同时，无法记录音频。

• 无法预览记录 (Rec Review)。
• 如果您将记录帧频更改为快于当前快门速

度的值，快门速度将更改为拍摄允许的最

小值。

例如：如果帧频为 32 且快门速度是 1/40，并

将帧频更改为 55，则快门速度更改为 1/60。

无法选择低于记录帧频的快门速度。

• 无法进行强制同步。

通常，剪辑在您每次开始和停止记录时作为

一个独立的文件创建。 但只要此功能保持有

效，将允许您在对同一剪辑进行连续记录时

开始和停止记录。

当不想要生成大量较短剪辑时和当想要进行

无须担心超过剪辑限制的记录时，此功能非

常方便。

其还易于找到记录开始点，因为在您每次开

始记录时会在记录开始点记录 “记录开始”

基本标记。

当摄像机设为下列任一视频格式时，此功能

会启用 （请参见第 40 页）。
XAVC-I
XAVC-L
MPEG HD 422

剪辑连续记录设置和拍摄

设置剪辑连续记录

1 选择设置菜单中的 “Operation > Rec 
Function > Clip Continuous Rec”。

2 转动MENU旋钮选择 [On]，然后按一下
此旋钮。
在取景器中出现 “Cont Stby”，并且启

用此功能。

注意

• 一次只能使用一种特殊记录功能，如 “Clip 
Continuous Rec”。

• 例如，如果在使用 “Clip Continuous Rec”的同时

启用了其他特殊记录模式，当前所选模式将自动

释放。

可以将剪辑连续记录打开 / 关闭功能指定给

其中一个 ASSIGN. 1/2/3 开关、

ASSIGNABLE 4/5 开关和 COLOR TEMP 键。

有关详情，请参见 “为可指定开关指定功能”
（第 133 页）。

使用剪辑连续记录进行拍摄

按照 “基本操作”中的介绍进行拍摄 “基本
操作”（第 61 页）。

开始记录时，取景器中的 “Cont Stby”指示

变为 “zCont Rec”指示。

TALLY 指示灯和取景器前面板上讯号指示灯

的点亮方式与正常记录过程中的相同。

注意

在记录过程中或记录待机模式中 （“Cont Stby”指

示点亮时），如果您取出介质、电池或关闭电源，

则需要恢复介质。 无法在除本摄像机以外的其他设

备上恢复介质。

退出剪辑连续记录模式 （请参见第 65 页）并取出

介质。

当“Cont Stby”指示闪烁时 （每秒闪烁 1 次），您

可取出介质。

停止拍摄

停止记录。

注意

记录 2 秒或以上后停止记录。

退出剪辑连续记录模式

在摄像机处于记录待机模式时，将设置菜单

中的 “Operation > Rec Function > Clip 
Continuous Rec”设置为 [Off]。

记录过程中的限制

如果您在摄像机处于记录或记录待机模式时

执行下列操作之一，则无法创建单个连续剪

使用剪辑连续记录功能记录
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辑。（当您下次开始记录时会创建新的剪

辑。）

• 对剪辑进行操作 （锁定、删除或重命名剪

辑）

• 切换插槽

• 更改记录格式

• 关闭 POWER 开关

• 播放

• 切换到缩略图屏幕

当视频格式 （请参见第 40 页）设为下表中

的选项之一时，可以将同一视频记录到两个

SxS 存储卡。 此功能对于在拍摄过程中进行

视频备份十分有用。

注意

建议在使用前先使用摄像机格式化 （初始化）两张

SxS 存储卡。

设置 Simul Rec

1 在设置菜单中选择 “Operation > Rec 
Function > Simul Rec”。

2 转动MENU旋钮选择 [On]，然后按一下
此旋钮。

注意

• 一次只能使用一种特殊记录功能，如 “Simul 
Rec”。

• 如果在使用 “Simul Rec”时还启用了其他特殊记

录功能，则 “Simul Rec”会被自动释放。

• 记录、播放期间或当显示缩略图屏幕时，不能设

置 “Simul Rec”。

使用 Simul Rec 拍摄

1 在存储卡插槽 A 和 B 中插入 SxS 存储
卡。
此时 SxS 插槽 A 和 B 的 ACCESS 指示灯

会亮起。同样，取景器中也会出现 SxS
插槽 A 和 B 的图标 （请参见第 25 页）。

2 按照 “基本操作”中的介绍进行拍摄

“基本操作”（第 61 页）。

注意

• 如果任一介质存在缺陷或介质被写保护，都不能

使用同步记录。

• 在同步记录过程中，如果任一介质容量变满或发

生错误而无法继续记录，则会停止向该介质记录

但会继续记录到另一介质。

停止拍摄

停止记录。

退出 Simul Rec
在记录待机模式下，将设置菜单中的

“Operation > Rec Function > Simul Rec”设置

为 “Off”。

将视频同步记录到两个 SxS 存

储卡 (Simul Rec)

设置菜单中的

“Operation > Format 
> Rec Format”

设置菜单中的

“Operation > Format > 
Frequency”

XAVC-I 1080P 29.97/25/23.98

XAVC-I 1080i 59.94/50

XAVC-I 720P 59.94/50

XAVC-L 50 1080P 59.94/50/29.97/25/23.98

XAVC-L 50 1080i 59.94/50

XAVC-L 50 720P 59.94/50

XAVC-L 35 1080P 59.94/50/29.97/25/23.98

XAVC-L 35 1080i 59.94/50

XAVC-L 25 1080i 59.94/50

HD 422 50 1080P 29.97/25/23.98

HD 422 50 1080i 59.94/50

HD 422 50 720P 59.94/50/29.97/25/23.98

HQ 1920 × 1080P 29.97/25/23.98

HQ 1920 × 1080i 59.94/50

HQ 144 × 1080i 59.94/50

HQ 1280 × 720P 59.94/50

HQ 1920 × 1080i 59.94/50
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代理数据由低分辨率的视频数据 (H.264) 和音

频数据 (AAC-LC) 组成。 可按与原始数据相

同的方法使用该低级代理数据，但其传输速

度更快，能更有效地进行查看和编辑。

剪辑记录过程中，代理数据会记录到插入

PROXY SD 卡插槽的 SD 卡中。 通过将 SD 卡

上记录的代理数据导入电脑，您可快速检查

记录的内容或进行快速脱机编辑。

• 代理记录在插入 SxS 存储卡后才会开始。

• 如果摄像机已开启约 45 秒， LCD 监视器和

取景器屏幕中的 图标 （Proxy SD 插

槽的介质状态指示灯）会打开，表示代理

记录已启用。

如果在 图标闪烁或未亮起时开始拍

摄，不会记录代理文件。

• 从摄像机中取出SD卡前，务必检查PROXY 
SD 卡插槽的 ACCESS 指示灯是否未亮起，

然后关闭摄像机或关闭代理记录 / 无线

LAN 连接功能。

要关闭代理记录 / 无线 LAN 连接功能，请

在设置菜单中进行下列设置。

- 将 “Operation > Proxy Recording Mode > 
Setting”设为 “OFF”。

- 将 “Maintenance > Wi-Fi >Setting”设为

“OFF”。

• 在代理记录或无线 LAN 连接功能启用时试

图取出 SD 卡，某些情况下可能会显示警告

(E91-1C0)。 如果记录时出现警告，数据仍

会正确记录到 SxS 存储卡，但不会记录代

理文件。 关闭摄像机并再次打开可以清除警

告消息。

支持用于记录代理数据的 SD 卡

SDHC 存储卡 * （Speed Class：4 或更高 / 容
量：最大 32 GB）
* 本手册中称为 “SD 卡”。

首次在摄像机中使用 SD 卡时，必须先进行

格式化。

必须使用摄像机的格式化功能对要在摄像机

中使用的 SD 卡进行格式化。 如果在将 SD 卡

插入摄像机时出现消息，请格式化 SD 卡。

1 选择设置菜单中的 “Operation > 
Proxy Recording Mode > Setting”。

2 转动MENU旋钮选择 [On]，然后按一下
此旋钮。

3 选择设置菜单的“Operation > Format 
Media > SD Card (Proxy)”。

4 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
出现提示您是否格式化此卡的确认屏幕。

5 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
开始格式化。

在格式化过程中，会显示消息和进度状态

（%），且 ACCESS 指示灯将亮以橘黄色。

格式化结束后，会出现一条完成消息。 按一

下 MENU 旋钮取消此消息。

注意

格式化 SD 卡会擦除卡上的所有数据。数据一旦删

除，即无法恢复。

可在 “介质状态”屏幕中检查 SD 卡上的剩

余容量 （请参见第 54 页）。

在其他设备的插槽中使用在本摄像机
上格式化的 SD 卡

首先请备份此卡，然后在要使用的设备中重

新格式化此卡。

1 选择设置菜单中的 “Operation > 
Proxy Recording Mode > Setting”。

2 转动MENU旋钮选择 [On]，然后按一下
此旋钮。

记录代理数据

使用摄像机进行代理记录

SD 卡

格式化 （初始化） SD 卡

检查剩余容量

记录代理数据
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3 将 SD 卡 （用于记录代理数据）插入

PROXY SD 卡插槽。

4 开始记录。
代理数据文件保存到 
SD 卡的 “/PRIVATE/PXROOT/Clip”目

录的同时，原始数据也将记录到 SxS 存

储卡。

停止记录时会自动停止代理数据记录。

关于记录的文件

文件系统为 FAT32，文件扩展名为

“.mp4”。 同时还会记录时间代码。

停止记录代理数据

将设置菜单中的 “Operation >Proxy 
Recording Mode >Setting”设为 [OFF]。

如果记录失败

将出现 “Media(Proxy) Error”或 “Write 
Error”。

如果因 SD 卡上的可用剩余容量不足而导致

记录失败，会出现 “NG：Not Enough 
Capacity”。

选择设置菜单中的 “Operation >Proxy 
Recording Mode Size”和 “Audio Channel”，

以分别更改代理记录格式大小和用于代理记

录的音频通道的设置。

选择设置菜单中的 “Operation >Proxy 
Recording Mode Frame Rate”和 “Bit Rate”
以分别查看视频帧频和视频比特率的设置。

计划元数据为有关拍摄和记录计划的信息，

记录在 XML 文件中。

计划元数据文件的示例

您可使用事先在计划元数据文件中定义的剪

辑名称和拍摄标记名称进行拍摄。

注意

定义剪辑名称和拍摄标记名称时，请使用与使用设

置菜单中“Maintenance >Language”的语言集兼容

的字体集。 使用与摄像机中的语言设置不同的语言

字体可能导致字符显示异常。

1 事先将计划元数据文件保存在SxS存储

卡上。
计划元数据文件存储在 “General/Sony/
Planning”目录中。

2 在插槽 A 或 B 中插入 SxS 存储卡。

3 选择设置菜单的 “Operation > 
Planning Metadata > Load Media(A)
或 Load Media(B)”。
出现文件列表屏幕。

列表中最多可显示 64 个计划元数据文

件。

4 转动 MENU 旋钮选择要加载的文件并

按一下此旋钮。

更改代理记录设置

查看代理记录设置

计划元数据操作

将包含剪辑名称的计划元数据
文件载入本摄像机
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5 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。

注意

无法从 SDXC 卡加载数据。

显示计划元数据中的详细信息

将计划元数据载入本摄像机后，您可检查其

包含的详细信息，如文件名、创建日期和时

间以及标题。

1 选择设置菜单中的 “Operation > 
Planning Metadata > Properties”。

2 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
此时即会显示计划元数据信息。

a) 资料组： 以相同计划元数据记录的一组剪

辑。

您可转动 MENU 旋钮滚动列表。

清除加载的计划元数据

1 选择设置菜单中的 “Operation > 
Planning Metadata > Clear 
Memory”。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
开始删除文件。

删除完成时出现消息 “Clear Planning 
Metadata File OK”。

可在计划元数据文件中写入以下两种类型的

剪辑名称字符串。

• 出现在取景器中的 ASCII 格式名称

• 实际注册为剪辑名称的 UTF-8 格式名称

您可通过设置菜单的 “Operation > Planning 
Metadata > Clip Name Disp”选择要显示的剪

辑名称类型。

通过计划元数据设置剪辑名称后，会显示该

剪辑名称。

注意

当您通过计划元数据同时定义 ASCII 格式名称和

UTF-8 格式名称时， UTF-8 格式字符串将用作剪辑

名称字符串。 如果您通过计划元数据定义 ASCII 格
式名称或 UTF-8 格式名称，则即使菜单设置未选

择，仍会显示定义的格式名称。

剪辑名称字符串示例

使用文本编辑器修改包含剪辑名称字符串的

<Title> 标签中的两个字段。

示例中的阴影字段为剪辑名称字符串。 
“Typhoon”表示为 ASCII 格式 （最多 44 个

字符）。 “Typhoon_Strikes_Tokyo”表示为

UTF-8 格式 （最多 44 个字节）。

“sp”表示空格而 3 表示回车。

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
P0001"spcreationDate="
2014-09-30T17:00:00+09:00"sp
lastUpdate="
2014-10-06T17:00:00+09:00"sp
version="1.00">3

<PropertiessppropertyId="
assignment"spupdate="
2014-10-06T17:00:00+09:00"sp
modifiedBy="Chris">3

<TitlespusAscii=" "sp
xml:lang="zh">
</Title>3

</Properties>3

</PlanningMetadata>3

注意

• 当您创建文件时，请仅在每句语句中最后一个字

符后输入回车将每句语句作为单个行，且不要输

入空格，除非是在指定处。

项目 信息

File Name 文件名

Assign ID 指定 ID
Created 创建日期和时间

Modified 最近修改日期和时间

Modified by 修改文件的人员姓名

Title 文件中指定的标题 1
（ASCII 格式的剪辑名称）

Title2 文件中指定的标题 2
（UTF-8 格式的剪辑名称）

Material 
Group

资料组中的剪辑数 a)

Shot Mark0

到 Shot 
Mark9

文件中为 “拍摄标记 0”到

“拍摄标记 9”定义的名称

定义计划元数据中的剪辑名称

Typhoon
Typhoon_Strikes_Tokyo
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• 剪辑名称最多可使用 44 个字节（或字符）的字符

串。

如果 UTF-8 格式字符串超过 44 个字节，则会将

44 个字节的字符串用作剪辑名称。

只要指定了 ASCII 格式名称，则将 44 个字符的字

符串用作剪辑名称。

当 ASCII 格式名称字符串和 UTF-8 格式名称字符

串均无法使用时，会使用标准格式剪辑名称。

设置剪辑名称

1 将包含剪辑名称的计划元数据文件载

入本摄像机 （请参见第 68 页）。

2 将设置菜单的 “Operation > Clip > 
Clip Naming”设为 [Plan]。
每当您记录剪辑时，本摄像机会自动生

成由计划元数据文件中所定义剪辑名称

组成的名称，并附带下划线 （_）和 5 位

序列号 （00001 到 99999）。

例如：Typhoon_Strikes_Tokyo_00001、
Typhoon_Strikes_Tokyo_00002、 ...

数字达到 99999 之后，下一个增量会将

数字恢复为 00001。

注意

当您加载另一计划元数据文件时，下一记录操作中

的序列号会返回至 00001。

选择剪辑名称显示格式

当同时以 ASCII 格式和 UTF-8 格式定义名称

时，您可使用设置菜单的 “Operation > 
Planning Metadata > Clip Name Disp”选择要

在 LCD 监视器和取景器屏幕上显示的名称。

要显示 ASCII 格式名称： 
请选择 Title1(ASCII)。 
剪辑名称变为

“Typhoon_Strikes_Tokyo_SerialNumber”，
但屏幕上会显示

“Typhoon_SerialNumber”。

要显示 UTF-8 格式名称： 
请选择 Title2(UTF-8)。
剪辑名称变为

“Typhoon_Strikes_Tokyo_SerialNumber”，
且屏幕上会显示相同的名称。

当您使用计划元数据设置拍摄标记时，您可

为 “Shot Mark 0”到 “Shot Mark 9”定义名

称。 当您记录拍摄标记时，您可添加计划元

数据中定义的拍摄标记名称字符串。

注意

只能在摄像机上记录 “Shot Mark 1”和 “Shot 
Mark 2”。

拍摄标记名称字符串示例

请使用文本编辑器修改 < Meta name> 标签中

的字段。

示例中的阴影字段为基本标记名称字符串。 
名称可以是 ASCII 格式 （最多 32 个字符）

或 UTF-8 格式 （最多 16 个字符）。

“sp”表示空格而 3 表示回车。

注意

如果名称字符串包含即使是一个非 ASCII 字符，则

该字符串的最大长度为 16 个字符。

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2014-09-30T08:00:00Z"splastUpdate="
2014-09-30T15:00:00Z"spversion=
"1.00">3

<PropertiessppropertyId=
"assignment"spclass="original"sp
update="2014-09-30T15:00:00Z"sp
modifiedBy="Chris">3

<TitlespusAscii="Football
Game"spxml:lang="zh">
Football Game 30/09/2014</
Title>3

<Metaspname="_ShotMark1"sp
content=" "/>3

<Metaspname="_ShotMark2"sp
content=" "/>3

<Metaspname="_ShotMark3"sp
content=" "/>3

<Metaspname="_ShotMark4"sp
content=" "/>3

<Metaspname="_ShotMark5"sp
content=" "/>3

<Metaspname="_ShotMark6"sp

定义计划元数据中的拍摄标记
名称

Goal

Shoot

Corner Kick

Free Kick

Goal Kick
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content=" "/>3

<Metaspname="_ShotMark7"sp
content=" "/>3

<Metaspname="_ShotMark8"sp
content=" "/>3

<Metaspname="_ShotMark9"sp
content=" "/>3

<Metaspname="_ShotMark0"sp
content=" "/>3

</Properties>3

</PlanningMetadata>3

注意

当您创建定义文件时，请仅在每句语句中最后一个

字符后输入回车将每句语句作为单个行，且不要输

入空格，除非是在指定处或在基本标记名称字符串

内。

当 RM-B170/B750 远程控制设备、RCP-1001/
1501 远程控制面板或其他控制设备已连接

时，摄像机的某些功能可从这些设备进行控

制。

您可以使用 RM-B750 上的显示屏或连接到远

程控制设备 MONITOR 接口的视频监视器来

操作摄像机菜单和监视摄像机图像。

进行连接

使用远程控制设备附带的远程电缆 (10 m)，
在摄像机 REMOTE 接口 （8 芯）和远程控制

设备的摄像机接口之间进行连接。

进行连接后打开摄像机时，摄像机将进入远

程控制模式。

您可以从远程控制设备控制菜单和记录操

作。

注意

• 如果已启用与摄像机的 USB 连接，则不支持远程

控制操作。

• 如果在远程控制时启用 USB 连接来连接摄像机，

则会释放远程控制模式。

• 请勿在摄像机打开时连接或断开远程控制设备。

连接远程控制设备后，摄像机的以下开关将

禁用。

• GAIN 开关

• WHITE BAL 开关

• AUTO W/B BAL 开关

• SHUTTER 开关

• OUTPUT/DCC 开关

• ASSIGN. 1/3 开关、 ASSIGNABLE 4/5 开关

和 COLOR TEMP. 键均已指定了 “Turbo 
Gain”功能。

释放远程控制模式

关闭摄像机并断开远程控制设备。

摄像机上的开关设置便会变成启用。

Foul

PK

1st Half

2nd Half

Kick Off

通过 REMOTE 接口操

作

从远程控制设备调整摄像机
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将监视器连接到 RM-B170/B750
RM-B170/B750 的 MONITOR 接口 （BNC
型）输出的信号与 VIDEO OUT 接口输出的

信号相同。

要将监视器连接到 RM-B170/B750 上的

MONITOR 接口，请使用 RM-B170/B750 附

带的黑色电缆。

RM-B170/B750 已连接时的图像质量
调整

RM-B170/B750 已连接时，摄像机图像质量

调整项目的参数 （画质设置数据）设为上次

连接 RM-B170/B750 时指定的参数。

RM-B170/B750 已连接时的记录开始 /
停止键的功能

使用设置菜单中的 “Maintenance > Camera 
Config > RM Rec Start”设置这些键的功能。

“RM Rec Start”设置和键的功能

图像质量调整数据的数据结构

摄像机用于存储摄像机图像质量调整数据

（画质设置数据）的非易失性存储器由如下

两个区域构成：远程控制设备未连接时使用

的 “主数据块”，以及远程控制设备连接时

使用的 “远程控制数据块”。 根据远程控制

设备 （如 RM-B170）是否已连接而定，画质

设置调整数据会自动选中并输出到摄像机部

分。

远程控制设备已连接时，“远程控制数据块”

将选作当前画质设置数据块，并将重新调用

上次使用远程控制设备时的有效画质设置调

整参数。

但是，如果远程控制设备上已设定绝对值控

件 1) 和绝对值开关 2) 的设置，远程控制设备

上的设置将覆盖摄像机上的设置。

断开远程控制设备与摄像机的连接后，“主

数据块”将重新启用，摄像机将返回连接远

程控制设备前的有效设置。
1)绝对值控件：输出与控件角位置相对应的数据。 

输出与旋转量相对应的数据的控件称为相对值控

件。

2)绝对值开关：位置必须与其功能一致的开关或旋

钮，例如拨动开关或滑动开关 （大部分瞬时开关

除外）即称为绝对值开关。

当设置菜单中的 “Maintenance >Camera 
Config >RM Common Memory”设为 [On]
时，即使连接远程控制设备，您也可以使用

主数据块中存储的画质设置调整数据的设

键的功能 “RM Rec Start”设置

RM Camera PARA

摄像机 REC 
START 键

已禁用 已启用 已启用

镜头 VTR 键 已禁用 已启用 已启用

ASSIGN. 1/3 开

关、
ASSIGNABLE 

4/5 开关和
COLOR TEMP.

键

已禁用 已启用 已启用

RM-B170/B750 

VTR 键

已启用 已禁用 已启用

主数据块
远程控制数据块

摄像机单元硬件

RM-B170 已连接

RM-B170 未连接

摄像机设置菜单

摄像机非易失性存储器

RM-B170
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置。 在这种情况下，当您更改远程控制设备

上的设置时，主数据块中存储的设置将更

新。 因此，即使移除远程控制设备后，也将

保留使用远程控制设备进行的画质设置数据

设置。 但是，如果远程控制设备上的开关位

置与摄像机上的开关位置不同，摄像机上的

开关位置将优先。

此外还可以保留连接远程控制设备前的有效

设置。 在这种情况下，必须在远程控制设备

上将控制旋钮设为相对值模式。

有关详情，请参见远程控制设备附带的操作手
册。

1 将 DISPLAY 开关设为 MENU 位置。
菜单显示在与 RM-B170 的 MONITOR 接

口连接的监视器上。

2 使用MENU SELECT旋钮和CANCEL/
ENTER 开关选择和设置菜单项目。

3 完成后，将 DISPLAY 开关设为 ON 或
OFF 位置以退出菜单。

有关 RM-B170 操作的详情，请参见 RM-
B170 的操作手册。

1 按 MONITOR 键将其打开，然后按 VF 
MENU 键。
菜单显示在 RM-B750 显示屏上或与 RM-
B750 的 MONITOR 接口连接的监视器

上。

2 使用 MENU SELECT 旋钮、ENTER 键
和 CANCEL 键选择和设置菜单项目。

3 完成后，按 VF MENU 键退出菜单。

有关 RM-B750 操作的详情，请参见 RM-
B750 的操作手册。

本摄像机会记录启用定位时拍摄的视频的位

置和时间信息。

GPS 功能在出厂时默认设置为 “Off”。

1 检查摄像机是否处于待机状态。

2 将设置菜单的“Operation > GPS”设
为 “On”。
本摄像机搜索 GPS 卫星时，取景器中会

显示 。 建立定位后，拍摄视频时即

会记录位置信息。

GPS 接收状态

取景器中显示的图标视从 GPS 卫星收到的信

号而不同。

• 打开摄像机后，可能需要一些时间才能开

始获取位置信息。

• 如果在几分钟后还未显示定位图标，则信

号接收可能有问题。 请不使用位置信息开始

拍摄，或移到视野清晰的位置。 在未显示定

位图标时拍摄意味着将不记录位置信息。

• 室内或高大建筑附近可能无法接收 GPS 信

号。 请移到视野清晰的位置。

• 即使显示了定位图标，位置信息的记录也

可能会中断，具体视接收信号的强度而定。

从 RM-B170 操作菜单

从 RM-B750 操作菜单

获取位置信息 (GPS)

定位状态 显示 GPS 接收状态

Off 不显示 GPS 设为 “Off”或发

生错误。

定位不可用 无法获取位置信息，

因为接收不到 GPS 信

号。 请移到视野清晰

的位置。

搜索卫星 搜索 GPS 卫星。 获取

卫星信号可能需要几

分钟时间。

定位 正在接收较弱的 GPS
信号。

正在接收 GPS 信号。

可以获取位置信息。

正在接收强烈的 GPS
信号。可以获取位置

信息。
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通过安装选购的 IFU-WLM3 USB 无线 LAN
模块，可使用无线 LAN 连接将本摄像机连接

到智能手机、平板电脑以及其他设备。

可以在使用无线 LAN 连接的本摄像机和设备

之间执行以下操作。

通过无线 LAN 远程操作

可以从使用无线 LAN 连接的智能手机、平板

电脑或电脑远程操作本摄像机。

通过无线 LAN 传输文件

可以通过无线 LAN 将本摄像机 SD 卡中存储

的代理文件 （低分辨率文件）和本摄像机上

记录的原始文件 （高分辨率文件）传输到服

务器。

通过无线 LAN 串流视频 / 音频

通过无线 LAN 可以使用 “Content Browser 
Mobile”应用程序从设备串流 （H.264 /
AAC-LC 压缩）摄像机视频或播放视频。

“Content Browser Mobile”应用程序可以在串

流内容时从设备屏幕远程操作本摄像机或用

于配置本摄像机。

有关 “Content Browser Mobile”应用程序的详
情，请联系您的 Sony 销售或服务代表。

注意

• 摄像机中 SD 卡内记录的代理文件 （低分辨率文

件）可通过无线 LAN 进行串流。

• 视频格式设为 MPEG-IMX 或 DVCAM 时不支持串

流播放。

兼容的设备

您可以使用智能手机、平板电脑或电脑配置

和操作本摄像机。 下表中显示了支持的设

备、操作系统和浏览器。

1 取下 USB 无线 LAN 模块接口的盖子。

2 将保护盖装到 IFU-WLM3 上。

3 将 IFU-WLM3 插入接口。

注意

• 连接或取下 IFU-WLM3 前，务必关闭本摄像机。

• 有关安装防护装置的详情，请联系 Sony 服务代

表。

使用无线 LAN 连接设

备

设备 操作系统 浏览器

智能手机 Android 4.4 Chrome

iOS8 Safari

平板电脑 Android 4.4 Chrome

iOS8

电脑 Microsoft 
Windows 7/
Microsoft 
Windows 8.1

Chrome

Mac OS 10.9/
10.10

Safari

安装 IFU-WLM3

设备 操作系统 浏览器

防护装置 （随附）
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如果不使用 IFU-WLM3

本摄像机可以连接到作为接入点设置的设

备。

使用配备 WPS 的设备进行连接

可使用 WPS 连接支持 WPS 的设备。

1 选择设置菜单的 “Maintenance > Wi-
Fi > Setting”。

2 转动 MENU 旋钮选择 [Access Point]，
然后按一下此旋钮。

注意

启用接入点模式可能需要一些时间 （30 秒到 1 分

钟）。请等到 LCD 监视器上或取景器中的 Wi-Fi

“AP”（接入点）指示灯 （请参见第 24 页）停止

闪烁。

3 选择设置菜单的 “Maintenance > Wi-
Fi > WPS”。

4 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。

5 打开设备的网络设置或 Wi-Fi 设置，然
后打开 Wi-Fi。

6 从 Wi-Fi 网络 SSID 列表中选择摄像机
SSID，显示 “Option”，然后选择

WPS 键。

注意

具体步骤取决于使用的设备。

7 启动设备上的浏览器并在 URL 栏中输
入 “http://192.168.1.1:8080/
index.html”。
出现用户名和密码输入屏幕。

8 输入用户名和密码，然后选择 [OK]。
有关用于验证访问权限的用户名和密码，

请参见设置菜单中的 “Maintenance > 
Basic Authentication”（请参见第 127
页）。

在设备上使用 SSID 和密码进行连接

在设备上输入 SSID 和密码进行连接。

1 选择设置菜单的 “Maintenance > Wi-
Fi > Setting”。

2 转动 MENU 旋钮选择 [Access Point]，
然后按一下此旋钮。

注意

启用接入点模式可能需要一些时间 （30 秒到 1 分

钟）。请等到 LCD 监视器上或取景器中的 Wi-Fi
“AP”（接入点）指示灯 （请参见第 24 页）停止

闪烁。

3 打开设备的网络设置或 Wi-Fi 设置，然
后打开 Wi-Fi。

4 从 Wi-Fi 网络 SSID 列表中选择摄像机

SSID，然后输入用于连接的密码。
有关摄像机 SSID 和密码，请参见设置菜

单中的 “Maintenance > Wi-Fi > SSID & 
Password”（请参见第 128 页）。

使用无线 LAN 接入点模式进行

连接

不要安装防护装置。

智能手机 /
平板电脑

电脑
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注意

具体步骤取决于使用的设备。

5 启动设备上的浏览器并在 URL 栏中输

入 “http://192.168.1.1:8080/
index.html”。
出现用户名和密码输入屏幕。

6 输入用户名和密码，然后选择 [OK]。
有关用于验证访问权限的用户名和密码，

请参见设置菜单中的 “Maintenance > 
Basic Authentication”（请参见第 127
页）。

本摄像机可以作为客户端连接现有无线 LAN
接入点。

可通过接入点连接设备。

使用 WPS 连接到接入点

如果接入点支持 WPS 功能，则可以使用基本

设置进行连接。如果接入点不支持 WPS 功

能，请参见 “在不使用 WPS 的情况下在工
作站模式中连接到接入点”（第 82 页）。

1 打开接入点。

2 打开本摄像机。

3 选择设置菜单的 “Maintenance > Wi-
Fi > Setting”。

4 转动MENU旋钮选择 [Station]，然后按
一下此旋钮。

注意

启用工作站模式可能需要一些时间 （30 秒到 1 分

钟）。请等到 LCD 监视器上或取景器中的 Wi-Fi 信
号水平指示灯 （请参见第 24 页）停止闪烁。

5 选择设置菜单的 “Maintenance > Wi-
Fi > WPS”。

6 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。

7 按一下接入点 WPS 键。
有关 WPS 键操作的详情，请参见接入点

的使用手册。

连接成功后， LCD 监视器上或取景器中

的 Wi-Fi 信号水平指示灯 （请参见第 24
页）将会显示强度 1 或更高强度。

注意

如果连接失败，请从步骤 1 再次执行步骤。

8 将设备连接到接入点。
有关如何连接的详情，请参见各设备的

使用手册。

9 启动设备上的浏览器并在 URL 栏中输
入 “http://<IP_address>:8080/
index.html”，其中 “<IP_address>”
是通过接入点分配给本摄像机的 IP 地
址。
有关摄像机的 IP 地址，请参见设置菜单

中的 “Maintenance > Wi-Fi > IP 
Address”。出现用户名和密码输入屏幕。

10 输入用户名和密码，然后选择 [OK]。
出现本摄像机的网络菜单。

有关网络菜单的详情，请参见 “网络菜
单”（第 81 页）。

有关用于验证访问权限的用户名和密码，

请参见设置菜单中的 “Maintenance > 
Basic Authentication”（请参见第 127
页）。

使用无线 LAN 工作站模式进行

连接

接入点

智能手机 /
平板电脑

电脑
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通过支持 3G/4G/LTE （选购）的接入点或使

用网络共享，可以连接到 Internet。
通过使用支持无线 LAN 工作站模式连接的兼

容 3G/4G/LTE 的接入点 （选购）或通过使用

设备网络共享，可以使用工作站模式连接到

Internet。

连接方法

如果接入点和设备都支持 WPS，可使用 “使
用 WPS 连接到接入点”（第 76 页）中的步

骤进行连接。如果不支持 WPS，可使用 “在
不使用 WPS 的情况下在工作站模式中连接到
接入点”（第 82 页）中的步骤进行连接。

首先，打开接入点和设备，如果计划使用网

络共享，请配置设备的网络共享功能。

通过接入点连接 Internet 时，可以将 SD 卡上

记录的代理文件和 SxS 存储卡上记录的原始

文件传输到 Internet 上的服务器。

连接 Internet
使用 “连接 Internet”（第 77 页）中的步骤

连接 Internet。

注册文件传输目的地

必须先注册要将文件传输到的服务器。有关

注册服务器的详情，请参见 “注册新的目的
地服务器”（第 84 页）。

可选择 SD 卡上的代理文件或 SxS 存储卡上

的原始文件用于传输到服务器。

传输 SD 卡上的代理文件

1 使用 LAN 连接方式连接本摄像机和设

备，然后在设备上启动浏览器以连接
到本摄像机 （请参见第 74 页）。

2 显示文件列表屏幕以选择文件。

3 点击 并选择 [Media Info]，然后点击

[SD Card]。
会出现 “SD Card”屏幕。

连接 Internet

接入点

智能手机 /
平板电脑

电脑

Internet

传输文件

准备工作

选择和传输文件
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4 选择要传输的文件。
点击某个文件将其选中。再次点击某个

文件会取消选择。 可双击播放文件来检

查内容。

5 点击 [Transfer to:]。
出现在 [Default Setting] 中指定的默认目

的地服务器 （请参见 “注册新的目的地
服务器”（第 84 页））。

要更改目的地服务器，点击目的地服务

器以显示列表，然后选择其他服务器。 
根据需要，输入目的地服务器的目录。

6 点击 [Transfer]。
开始传输选定的文件。要取消文件传输，

点击 [Cancel]。

传输 SxS 存储卡上的原始文件

1 选择设置菜单的“Maintenance > File 
Transfer > File Transfer”。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
文件传输模式启动。

3 使用 LAN 连接方式连接本摄像机和设
备，然后在设备上启动浏览器以连接

到本摄像机 （请参见第 74 页）。

4 显示文件列表屏幕以选择文件。

5 点击 并选择 [Media Info]，然后点击
“Slot A”（用于插槽 A 中介质上记录

的文件）或 “Slot B”（用于插槽 B 中
介质上记录的文件）。
出现 Slot A 或 Slot B 屏幕。

例如：Slot A 屏幕

6 选择要传输的文件。
点击某个文件将其选中。再次点击某个

文件会取消选择。

7 点击 [Transfer to:]。
出现在 [Default Setting] 中指定的默认目

的地服务器 （请参见 “注册新的目的地
服务器”（第 84 页））。

要更改目的地服务器，点击目的地服务

器以显示列表，然后选择其他服务器。

在 [Directory] 中输入目的地服务器的目

录。

8 点击 [Transfer]。
开始传输选定的文件。要取消文件传输，

点击 [Cancel]。

注意

以下情况下不能传输文件。

• 记录、播放期间或当显示缩略图屏幕时

• 当无线 LAN 接入点设为 “Access Point”模式时

监控文件传输

在 “SD Card”、“Slot A”或 “Slot B”屏幕

上点击 [Job List] 以显示 “Job List”屏幕并

查看文件传输的状态 （请参见第 84 页）。
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可通过无线 LAN 连接从智能手机、平板电脑

或其他设备访问本摄像机内置的 Wi-Fi 远程

控制功能。

使用 Wi-Fi 远程控制功能可以远程操作本摄

像机。 使用此功能可以远程启动 / 停止记录

或配置设置，例如，当摄像机固定在远处或

安装在三脚架上时会十分有用。

Wi-Fi 远程屏幕会自动缩放以匹配所连接设备

的屏幕大小。

1 使用无线 LAN 连接方式连接本摄像机
和设备 （请参见第 74 页）。

2 启动设备上的浏览器并在 URL 栏中输

入 “http://<IP_address>/rm.html”，
其中 “<IP_address>”是本摄像机的

IP 地址 （设置菜单中的
“Maintenance > Wi-Fi > IP 
Address”）。
例如，如果 IP 地址为 192.168.1.1，请在

URL 栏中输入 “http://192.168.1.1/
rm.html”。

3 在浏览器屏幕中输入用户名和密码
（设置菜单中的 “Maintenance > Wi-
Fi > SSID & Password”（请参见第

128 页））。
连接成功后，设备上会出现 Wi-Fi 远程控

制屏幕。

使用 Wi-Fi 远程控制屏幕操作本摄像机。

在屏幕上将锁定旋钮滑至右侧可禁用

REC 键操作。

也可以使用网络菜单的 [Cam Remote 
Control] （请参见第 81 页）显示 Wi-Fi
远程控制。

注意

• 要显示智能手机的页面，在 URL 中将“rm.html”
改为 “ms.html”。 要显示平板电脑的页面，在

URL 中将 “rm.html”改为 “rmt.html”。 输入

“rm.html”时，页面会自动切换为相应设备上的

显示。 但是，视设备而定，可能不会显示合适的

页面。

• 以下环境中，Wi-Fi 远程控制屏幕可能与本摄像机

设置不符。 如果发生这种情况，请重新加载浏览

器窗口。

- 如果在连接后重新启动了本摄像机

- 如果在连接后直接操作本摄像机

- 如果设备被重新连接

- 如果使用了浏览器的前进 / 返回键

• 如果无线信号强度变弱，Wi-Fi 远程控制可能不起

作用。

智能手机显示

Wi-Fi 远程控制

显示 Wi-Fi 远程控制

Wi-Fi 远程控制屏幕

Main 屏幕

• Status

• 拍摄设置

Iris、 Focus、 Zoom、

S&Q FPS、 Shutter、
White、 Gamma、
Auto Iris、 Gain、
ATW、 Color Bars、
Auto Black、 Auto 
White
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平板电脑显示Playback 屏幕

• Status

• 播放控制键

F Rev、 Play/Pause、
F Fwd、Prev、Stop、
Next

Cursor 屏幕

• Status

• 光标控制键、菜单 /
状态

Up、 Left、 Set、
Right、 Down、
Cancel/Back、Menu、
Status、 Thumbnail、
Option (SHIFT + SET)

Assign 屏幕

• Status

• 可指定键

可指定键 0、 1、 3、
4、 5

Main 屏幕

• Status

• 可指定键

可指定键 0、 1、 3、 4、 5
• 拍摄设置

S&Q FPS、 Shutter、 White、 Gamma、 Auto 
Iris、Gain、ATW、Color Bars、Auto Black、
Auto White

Playback 屏幕

• Status

• 播放控制键

F Rev、 Play/Pause、 F Fwd、 Prev、 Stop、
Next
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从使用无线 LAN 连接方式连接的设备上的浏

览器访问本摄像机时，会出现本摄像机的网

络菜单。 使用网络菜单可以配置与无线功能

有关的设置、传输文件以及执行其他操作。

配置菜单

从所连接设备的浏览器访问本摄像机时，本

摄像机上会出现关于介质信息的 SD 卡屏幕。

点击网络菜单屏幕左上方的 将会显示配置

菜单。 点击要配置的项目。

该菜单包含以下项目：Settings、 Media Info、
Job List 和 Cam Remote Control。

Settings
用于配置本摄像机。 本屏幕包含下列项目。

Media Info
显示介质信息，用于选择要从介质传输的文

件。

• SD Card：插入本摄像机的 PROXY SD 卡插

槽的介质

• Slot A：插入本摄像机卡插槽 A 的介质

• Slot B：插入本摄像机卡插槽 B 的介质

Job List
显示用于管理文件传输的 “Job List”屏幕

（请参见第 84 页）。

Cam Remote Control
显示 Wi-Fi 远程控制屏幕（请参见第 79
页）。

Cursor 屏幕

• Status

• 光标控制键、菜单 / 状态

Up、Left、Set、Right、Down、Cancel/Back、
Menu、 Status、 Thumbnail、
Option (SHIFT + SET)

Assign 屏幕

• 可指定键

可指定键 0、 1、 3、 4、 5

网络菜单

项目 说明 参见

Wireless 
Module 
>Format

格式化设置 “格式化设置”
（第 82 页）

Wireless 
LAN 
>Station 
Settings

无线 LAN 设

置

“无线 LAN 工作站
设置”（第 82 页）

Wireless 
LAN 
>Status

无线 LAN 设

置状态

“监控无线 LAN 状
态”（第 83 页）

Wireless 
LAN 
>Upload 
Settings

传输设置 “传输 （上载）设
置”（第 83 页）
81



使用 “Settings”屏幕的 “Format”选项卡来

设置在本摄像机的 SD 卡上记录代理文件的

相关设置，以及在使用设备进行串流时设置

串流格式的相关设置。

视频

• XAVC Proxy （AVC/H.264 主配置文件、

4:2:0 Long GOP）
• 在下表中选择大小。

音频

• AAC-LC 压缩

• 采样频率：48 kHz
• 比特率：128 kbps （立体声）

注意

• 代理文件的比特率为平均值，因此有时可能会超

出该值。

• 不支持视频帧频 24 fps。

使用 “Settings”屏幕的 “Station Settings”
选项卡进行设置，将本摄像机连接到无线

LAN。

在不使用 WPS 的情况下在工作站模
式中连接到接入点

1 使用接入点模式连接本摄像机和设备
（请参见第 75 页）。

2 在 “Station Settings”屏幕中配置设
置。
配置设置，使其符合接入点连接的设置。

格式化设置

项目 说明 设置

Streaming
Size

设置用于串流

的视频大小和

比特率。

640 × 360(3Mbps)/
480 × 270(1Mbps)/
480 × 270(0.5Mbps)

Streaming
Frame 
Rate

显示串流的视

频帧频。

23.98fps/25fps/
29.97fps/50fps/
59.94fps

Streaming
Bit Rate

显示串流的视

频比特率。

3Mbps/1Mbps/
0.5Mbps

Proxy File 
recording

Size

设置用于代理

文件的视频大

小和比特率。

1280 × 720(9Mbps)/
640 × 360(3Mbps)/
480 × 270(1Mbps)/
480 × 270(0.5Mbps)

Proxy File 
recording

Frame 
Rate

显示代理文件

的视频帧频。

23.98fps/25fps/
29.97fps/50fps/
59.94fps

Proxy File 
recording

Bit Rate

显示代理文件

的视频比特

率。

9Mbps/3Mbps/
1Mbps/0.5Mbps

Proxy File 
recording

Audio 
Channel 
Select

设置要记录到

代理数据的音

频通道。

Ch-1 & Ch-2

无线 LAN 工作站设置

项目 说明

Host Name 本摄像机的名称 （可以修改）

SSID 显示在 [ 接入点 ] 中选择的

SSID。

Key 输入接入点的密码。

DHCP 启用 / 禁用 DHCP。
当设为 [On] 时，系统会自动向

本摄像机分配 IP 地址。

要手动输入本摄像机的 IP 地

址，请设为 [Off]。
IP Address 输入本摄像机的 IP 地址。仅当

DHCP 为 [Off] 时启用。

Subnet mask 输入本摄像机的子网掩码。

仅当 DHCP 为 [Off] 时启用。

Gateway 输入接入点的网关。

仅当 DHCP 为 [Off] 时启用。

Primary DNS 
Server

输入接入点的主 DNS 服务器。

仅当 DHCP 为 [Off] 时启用。

Secondary DNS 
Server

输入接入点的次 DNS 服务器。

仅当 DHCP 为 [Off] 时启用。

Submit 应用无线 LAN 设置。
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有关接入点设置的详情，请参见接入点的使
用手册。

3 点击 [Submit]。
应用指定的设置。

4 选择设置菜单的 “Maintenance > Wi-
Fi > Setting”。

5 转动MENU旋钮选择 [Station]，然后按

一下此旋钮。
此步骤会在工作站模式中将本摄像机连

接到接入点。继续 “使用 WPS 连接到接
入点”（第 76 页）中的步骤 9，从设备

访问本摄像机。

监控无线 LAN 状态

使用 “Settings”屏幕的 “Status”选项卡来

监控无线 LAN 状态。

显示的设置将视本摄像机的无线 LAN 模式而

不同。

接入点模式
 

工作站模式
 

使用 “Settings”屏幕的 “Upload Settings”
选项卡来注册和设置用于传输本摄像机上记

录的代理文件或原始文件的服务器。

自动传输

如果 [Auto Upload] 为 [On] 且连接了

Internet，记录结束后，系统会自动将代理文

件传输到在 “Upload Settings”选项卡中指定

的默认服务器。

工厂预设将默认服务器设为 “Sony Ci”。

“Sony Ci”是 Sony 提供的介质云服务。 您可

以将文件传输到 “Sony Ci”云服务。

注意

要使用 “Sony Ci”云服务，需要先订阅。有关详

情，请访问 www.SonyMCS.com/wireless。

使用以下步骤注册 “Sony Ci”。

1 确认 [Upload Settings]选项卡中显示了

“Sony Ci”，然后点击 [Edit]。
出现 “Sony Ci”设置屏幕。

2 输入用户名和密码。
有关详情，请访问 www.SonyMCS.com/
wireless。

3 点击 [Link]。
稍后即会出现一条完成消息。

[Link] 会将用户与摄像机关联起来。 要执

行 [Link]，需要连接 Internet。

4 点击 [OK]。
注册 “Sony Ci”后，设置屏幕上即会出

现 [Unlink]。 点击 [Unlink] 会释放用户帐

户，之后其他用户帐户可与本摄像机关

联。

传输 （上载）设置
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注册新的目的地服务器

点击 [Create New] 显示配置屏幕。
 

指定设置后，点击 [OK] 应用设置。 点击

[Cancel] 取消设置。

更改已注册的服务器设置

选择要在 “Upload Settings”屏幕上更改设置

的服务器，然后点击 [Edit]。 在显示的配置屏

幕上更改设置。

有关项目详情，请参见 “注册新的目的地服务
器”（第 84 页）。

删除已注册的服务器

在 “Upload Settings”屏幕上选择要删除的服

务器，然后点击 [Delete]。 出现一个确认消

息。 点击 [OK] 删除服务器并返回上一屏幕。

可监控文件传输状态，在传输文件列表中管

理文件，也可以开始 / 停止文件传输。

本摄像机支持 FTP 恢复功能 （在传输停止时

继续传输文件）。

停止 / 重新开始文件传输或从传输列
表中删除文件

1 选择文件。

2 点击屏幕右上方的 。
选择菜单项目。

• Abort selected：停止文件传输。

• Delete from list：从传输列表删除文件。

• Start selected：开始文件传输。

• Select All：选择列表中的所有文件。

• Clear completed：从列表中删除所有已

传输的文件。

项目 说明

Default Server 设为 [On] 以设置默认文件

目的地服务器。 （显示在

服务器列表顶部，用于文件

传输。）

Display Name 输入要在列表中显示的服务

器的名称。

Service 显示服务器的类型。
FTP: FTP server

Host Name 输入服务器的地址。

User 输入用户名。

Password 输入密码。

PASV Mode 启用 / 禁用 PASV 模式。

Destination 
Directory

指定目的地目录。

Using Secure 
Protocol

设置是否使用安全 FTP。

Load Certification 加载 CA 证书。

* 要加载的证书必须是 PEM
格式，且应以
“certification.pem”文件名
写入 SD 卡的根目录中。

Clear Certification 清除 CA 证书。

监控文件传输 (Job List)

项目 说明

Total 所有文件的传输进度状态

Status 正在传输的文件的进度状态

Remain time 预估的剩余传输时间

Transfer data rate 传输速率
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如果您在 E-E 或播放模式下按 THUMBNAIL
键，就会出现缩略图屏幕。 缩略图屏幕以缩

略图形式显示 SxS 存储卡中所存储剪辑的图

像列表。 （如果您插入的存储卡中没有剪

辑，则会出现一条消息。）

您可以选择缩略图屏幕中的任何剪辑 （请参
见第 86 页）并开始播放该剪辑 （请参见第
86 页）。

还可以将剪辑标记添加到缩略图屏幕上的任

意剪辑，便于根据标记筛选剪辑。 也可以从

缩略图屏幕切换到基本标记缩略图屏幕，并

将基本标记 （例如，拍摄标记）添加到剪辑

中的任意帧。

a 缩略图 （索引图像）

剪辑记录后，它的第一帧会自动显示为索引

图像。您可以将索引图像更改为任意帧 （请
参见第 91 页）。

b 选择的介质图标 / 介质状态

如果介质受到保护，会显示 标记。

当本摄像机中插入两张 SxS 存储卡时，您可

以使用 SLOT SELECT 键在两张 SxS 存储卡

之间切换。

注意

当显示基本标记缩略图屏幕时，无法在 SxS 存储卡

之间切换。

第 5章 剪辑操作

缩略图屏幕上的剪辑操作

缩略图屏幕

OK S

光标 
（黄色）
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c 剪辑编号 / 剪辑总数

d 电池 / 电压状态

e 播放禁用指示灯

f 剪辑状态

使用图标显示剪辑状态。

g 缩略图信息

显示缩略图信息。显示的信息视“Customize 
View”设置而有所不同 （请参见第 92 页）。

h 剪辑选择复选框

勾选复选框以选择剪辑 （缩略图）。

i 剪辑名称 / 标题

显示选定剪辑的名称或标题。

j 记录视频格式

k 特殊记录模式

如果剪辑是使用特殊记录模式 （慢 & 快动

作）记录的，则显示记录模式。

对于慢 & 快动作剪辑， [ 记录帧频 / 播放帧

频 ] 会显示在右边。

l 剪辑时间长度

m 创建日期

要隐藏缩略图屏幕

按一下 THUMBNAIL 键。

选择剪辑缩略图

执行下列操作之一将黄色光标移动到您要选

择的缩略图。

• 按一下箭头键 （J、 j、 K、 k）。

• 转动 MENU 旋钮。

• 按一下 PREV 或 NEXT 键。

要选择第一个缩略图

按住 F REV 键，然后按 PREV 键。

要选择最后一个缩略图

按住 F FWD 键，然后按 NEXT 键。

从选定的剪辑开始依次播放剪辑

1 选择您要第一个播放的剪辑缩略图。

2 按一下 PLAY/PAUSE 键。
从选定剪辑的开头开始播放。

从选定的剪辑开始依次播放剪辑

当最后一个剪辑播放完后，本摄像机在最后

一个剪辑的最后一帧进入暂停 （静止图像）

模式。

按 THUMBNAIL 键返回缩略图屏幕。

注意

• 如果SxS存储卡上的剪辑使用不同记录格式混合记

录而成，则可能不会顺序播放所有剪辑。

• 不会播放在缩略图屏幕上显示的具有无法播放图

标的剪辑 （请参见第 86 页）。 相应的剪辑会被跳

过并继续顺序播放。

• 在剪辑之间的边界处，可能会有一瞬间的图像中

断或静止图像显示。 在这段时间内，播放控制和

THUMBNAIL 键无法操作。

• 当您选择缩略图屏幕中的一个剪辑并开始播放

时，剪辑的开头可能会有一瞬间的图像中断。 要
无中断地查看剪辑的开头，请将摄像机切换到播

放模式并暂停，然后使用 PREV 键返回到剪辑的

开头并再次开始播放。

要暂停播放

按一下 PLAY/PAUSE 键。

暂停播放时， PLAY/PAUSE 指示灯闪烁。

再按一下此键返回到播放模式。

要高速播放

按一下 F FWD 键 （请参见第 15 页）或

F REV 键 （请参见第 15 页）。

要返回正常播放，按一下 PLAY/PAUSE 键。

图标 含义

S、 OK、

NG、KP 图标

附加到剪辑的基本标记或剪辑

标记

“Lock”图标 剪辑已锁定 （受保护）

播放剪辑
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停止播放

按一下 STOP 键：播放停止，且摄像机进入

E-E 模式。

按一下 THUMBNAIL 键：播放停止且取景器

中出现缩略图屏幕 （请参见第 85 页）。

如果您弹出存储卡，播放也会停止。 在这种

情况下，摄像机图像出现在取景器内。

定位剪辑

返回到当前剪辑的开头

按一下 PREV 键。

• 在播放或 F FWD 过程中，按一下此键跳转

到当前剪辑的开头并开始播放。

• 在 F REV 或暂停过程中，按一下此键跳转到

当前剪辑的开头并显示静止图像。

• 每按一次此键就会移动到前一个剪辑。

从第一个剪辑的开头开始播放。

同时按下 PREV 和 F REV 键。 这样将跳转到

SxS 存储卡上的第一个剪辑的开头。

跳至下一个剪辑的开头

按一下 NEXT 键。

• 在播放或 F FWD 过程中，按一下此键跳转

到下一个剪辑的开头并开始播放。

• 在 F REV 或暂停过程中，按一下此键跳转到

下一个剪辑的开头并显示静止图像。

• 每按一次此键就会移动到下一个剪辑。

跳至最后一个剪辑

同时按下 F FWD 和 NEXT 键。 这样将跳转到

SxS 存储卡上记录的最后一个剪辑的最后一

帧。

在播放期间添加拍摄标记

在播放过程中您可以使用与记录过程中相同

的方式在剪辑上添加拍摄标记 （请参见第 63
页）。

注意

• SxS 存储卡被写保护时无法记录拍摄标记。

• 无法在各剪辑的第一帧或最后一个剪辑的最后一

帧添加拍摄标记。

“Thumbnail”菜单用于保护 / 删除剪辑、检

查属性、添加 / 删除剪辑中帧的剪辑标记和

基本标记，以及其他任务。

显示缩略图菜单

1 按一下 THUMBNAIL 键。
出现缩略图屏幕。

2 将 MENU ON/OFF 开关设置为 ON，或
按一下 MENU 键。
出现菜单屏幕。

3 转动 MENU 旋钮选择 [Thumbnail]，然
后按一下此旋钮。
也可以按一下 J 或 j 键选择

[Thumbnail]，然后按一下 SET 键。

要隐藏缩略图菜单，再按一次 THUMBNAIL
键。

要选择菜单项目和子项目

执行以下步骤之一。

• 旋转MENU旋钮选择一个项目或子项目，然

后按一下此旋钮。

• 按一下箭头键 （J、 j、 K、 k）选择

一个项目或子项目，然后按一下 SET 旋

钮。

根据选择的项目或子项目，出现一个选择列

表或剪辑属性屏幕 （请参见第 89 页）。

要返回到上一屏幕，请下推 MENU CANCEL/
PRST/ESCAPE 开关至 ESCAPE 位置。

注意

• 当 SxS 存储卡被写保护时，无法复制、删除、更改

索引图像或添加和删除剪辑标记以及拍摄标记。

• 当显示此菜单时，根据状态而定，某些项目无法

选择。

有关缩略图屏幕的详情，请参见
““Thumbnail”菜单”（第 92 页）。

基本缩略图菜单操作
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可保护某个指定剪辑或所有剪辑，使其不会

被删除。

受保护剪辑的缩略图中会出现 。

可在缩略图屏幕或筛选的剪辑缩略图屏幕上

删除剪辑 （请参见第 90 页）。

保护剪辑

1 选择设置菜单的 “Thumbnail > Lock/
Unlock Clip > Select Clip”。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
出现剪辑选择屏幕。

3 旋转 MENU 旋钮选择要保护的剪辑，

然后按一下此旋钮。
复选标记被添加到选定的剪辑上。

4 同时按下 SET 和 SHIFT 键。
出现一个确认对话框。

5 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
剪辑将被保护，并且会出现一条完成消

息。

6 按一下 MENU 旋钮取消此消息。

保护所有剪辑

1 选择设置菜单的 “Thumbnail > Lock/
Unlock Clip > Lock All Clips”。

2 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
所有剪辑将被保护，并且会出现一条完

成消息。

4 按一下 MENU 旋钮取消此消息。

解锁所有剪辑

1 选择设置菜单的 “Thumbnail > Lock/
Unlock Clip > Unlock All Clips”。

2 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
所有剪辑都将被解锁，并且会出现一条

完成消息。

4 按一下 MENU 旋钮取消此消息。

您可以删除 SxS 存储卡中的剪辑。可在缩略

图屏幕或筛选的剪辑缩略图屏幕上删除剪辑

（请参见第 90 页）。

1 选择设置菜单的“Thumbnail > Delete 
Clip > Select Clip”。

2 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
出现剪辑选择屏幕。

3 旋转 MENU 旋钮选择要删除的剪辑，
然后按一下此旋钮。
复选标记被添加到选定的剪辑上。

4 同时按下 SET 和 SHIFT 键。
出现一个确认对话框。

5 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
剪辑将被删除，并且会出现一条完成消

息。

6 按一下 MENU 旋钮取消此消息。

在缩略图屏幕中，已删除剪辑下面的剪辑会

向前移一个位置。

保护剪辑

删除剪辑
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删除所有剪辑

可以同时删除同一 SxS 存储卡上存储的所有

剪辑。

注意

• 剪辑一旦删除便无法恢复。

• 如果介质或剪辑受到保护，则此功能会被禁用。

1 选择设置菜单的“Thumbnail > Delete 
Clip > All Clips”。

2 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。
所有剪辑都将被删除，并且会出现一条

完成消息。

4 按一下 MENU 旋钮取消此消息。

当您选择设置菜单中的 “Thumbnail > Display Clip Properties”时，会出现选定剪辑的剪辑属性

屏幕。

a 当前剪辑图像

显示选定剪辑的索引图像和状态。

b 时间代码显示

TC Index：被显示图像的时间代码

Start：记录开始点的时间代码

End：记录结束点的时间代码

Duration：开始点和结束点之间的播放时间

c 创建日期和修改日期

d 剪辑名称

e 记录格式

Video Codec：视频编解码器

Size：图像大小

FPS：帧频

Audio Codec：音频编解码器

Ch/Bit：音频记录通道 / 音频记录的比特数

f 特殊记录模式

g 记录设备的名称

要隐藏剪辑属性屏幕

执行以下步骤之一。

按一下 RESET/RETURN 键：返回到缩略图

菜单屏幕。

按一下 THUMBNAIL 键：将本摄像机设为 E-
E 模式并显示摄像机图像。

按一下 PLAY/PAUSE 键：从选定的剪辑开始

播放。

显示剪辑属性

OK S
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可向剪辑添加剪辑标记 （OK、 NG 或 KP 标

记），以便根据剪辑标记筛选显示的剪辑。

在缩略图屏幕或筛选的剪辑缩略图屏幕上执

行此操作 （请参见第 90 页）。

添加剪辑标记

1 选择要添加剪辑标记的剪辑的缩略图，
然后选择设置菜单中的“Thumbnail > 
Set Clip Flag”。

2 旋转 MENU 旋钮选择剪辑标记，然后
按一下此旋钮。

剪辑标记被添加到选定剪辑的缩略图中。

您还可以使用已指定剪辑标记功能的可指定

开关来添加剪辑标记 （请参见第 133 页）。

删除剪辑标记

1 选择要删除剪辑标记的剪辑的缩略图，
然后选择设置菜单中的“Thumbnail > 
Set Clip Flag > Delete Clip Flag”。
此时，该剪辑标记便已删除。

1 选择设置菜单的 “Thumbnail > Filter 
Clips”。

2 旋转 MENU 旋钮选择要用于筛选剪辑

的剪辑标记，然后按一下此旋钮。

出现剪辑屏幕，显示按选定剪辑标记筛

选的剪辑 此屏幕称为筛选的剪辑屏幕。

可向剪辑中的任意帧添加 （和删除）基本标

记 （拍摄标记、记录开始标记）。 在基本标

记缩略图屏幕上添加／删除基本标记。

添加拍摄标记

1 选择设置菜单的 “Thumbnail > 
Thumbnail View > Essence Mark 
Thumbnail”。

2 旋转MENU旋钮选择 [All]，然后按一下
此旋钮。

3 在基本标记缩略图屏幕上选择要添加

基本标记的帧的缩略图，然后选择设
置菜单中的 “Thumbnail > Set Shot 
Mark”。

4 转动 MENU 旋钮选择以下操作之一，
然后按一下此旋钮。

拍摄标记被添加到选定的帧。

删除拍摄标记

1 选择设置菜单的 “Thumbnail > 
Thumbnail View > Essence Mark 
Thumbnail”。

2 选择要删除的拍摄标记的类型。

3 在基本标记缩略图屏幕上选择要删除

拍摄标记的帧的缩略图，然后选择设
置菜单中的 “Thumbnail > Set Shot 
Mark”。

4 转动 MENU 旋钮选择以下操作之一，
然后按一下此旋钮。

拍摄标记已从选定帧删除。

在剪辑上添加 / 删除剪辑标记

设置 添加的剪辑标记

Add OK OK

Add NG NG

Add KEEP KP

使用筛选的剪辑屏幕筛选剪辑

设置 筛选剪辑标记

OK OK

NG NG

KEEP KP

None （未筛选剪辑）

在剪辑上添加 / 删除基本标记

设置 操作

Add Shot Mark1 添加拍摄标记 1
Add Shot Mark2 添加拍摄标记 2

设置 操作

Delete Shot mark1 删除拍摄标记 1
Delete Shot mark2 删除拍摄标记 2
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基本标记缩略图屏幕仅显示已在缩略图视图

中记录了基本标志的剪辑中的帧。 显示缩略

图屏幕，然后按下 ESSENCE MARK 键 （请
参见第 17 页）或使用下列步骤显示基本标记

缩略图屏幕。

1 选择设置菜单的 “Thumbnail > 
Thumbnail View > Essence Mark 
Thumbnail”。

2 旋转 MENU 旋钮选择要用于筛选帧的
基本标记，然后按一下此旋钮。

按选定基本标记筛选后出现基本标记缩

略图屏幕。

如果您使用定义拍摄标记 0 到拍摄标记 9 的

名称的计划元数据记录剪辑，则会按定义的

名称显示列表中的选择项。

可将在基本标记缩略图屏幕上选择的帧设为

剪辑的索引图像。

选择要用作剪辑索引图像的帧的缩略图，然

后选择设置菜单中的“Thumbnail > Set Index 
Picture”。

使用基本标记缩略图屏幕筛选
剪辑 （帧）

设置 说明

All 所有已添加基本标记的帧

Rec Start 具有记录开始标记的帧和

没有记录开始标记的剪辑

的第一帧

Shot Mark0 到
Shot Mark9

具有各个拍摄标记的帧

更改剪辑的索引图像
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默认值会加粗显示。

“Thumbnail”菜单

Thumbnail

项目 子项目设置 说明

Display Clip 
Properties

－ 显示剪辑属性 （请参见第 89 页）。

Set Index Picture － 设置 / 更改剪辑的索引图像 （请参见第 91
页）。

Thumbnail View
更改显示的缩略图屏幕。

Essence Mark Thumbnail
All/Rec Start/Shot Mark1/
Shot Mark2/Shot Mark3/
Shot Mark4/Shot Mark5/
Shot Mark6/Shot Mark7/
Shot Mark8/Shot Mark9/
Shot Mark0

显示包含按基本标记筛选的剪辑的基本标记

缩略图屏幕 （请参见第 91 页）。

Clip Thumbnail 显示缩略图屏幕 （剪辑缩略图屏幕）（请参
见第 85 页）。

Set Shot Mark
添加 / 删除拍摄标记。

Add Shot Mark1 向帧添加拍摄标记 1 （请参见第 90 页）。

Delete Shot Mark1 删除拍摄标记 1 （请参见第 90 页）。

Add Shot Mark2 向帧添加拍摄标记 2 （请参见第 90 页）。

Delete Shot Mark2 删除拍摄标记 2 （请参见第 90 页）。

Set Clip Flag
添加 / 删除剪辑标记。

Add OK 向剪辑添加一个 OK 标记 （请参见第 90
页）。

Add NG 向剪辑添加一个 NG 标记 （请参见第 90
页）。

Add KEEP 向剪辑添加一个 KP （保持）标记 （请参见
第 90 页）。

Delete Clip Flag 删除一个剪辑标记 （请参见第 90 页）。

Lock/Unlock Clip
保护 / 解锁一个剪辑。

Select Clip 选择要保护的剪辑 （请参见第 88 页）。

Lock All Clips 保护介质上的所有剪辑 （请参见第 88 页）。

Unlock All Clips 解锁介质上的所有剪辑 （请参见第 88 页）。

Delete Clip
删除剪辑。

Select Clip 选择要删除的剪辑 （请参见第 88 页）。

All Clips 删除介质上的所有剪辑 （请参见第 89 页）。

Filter Clips
按剪辑标记筛选显示的

剪辑。

OK 按 OK 标记筛选显示的剪辑 （请参见第 90
页）。

NG 按 NG 标记筛选显示的剪辑 （请参见第 90
页）。

KEEP 按 KP （保持）标记筛选显示的剪辑 （请参
见第 90 页）。

None 未筛选剪辑 （请参见第 90 页）。

Customize View Thumbnail Caption
Date Time/Time Code/
Duration/Sequential Number

选择剪辑缩略图下方显示的信息。

Date Time：显示日期和时间。

Time Code：显示时间代码。

Duration：显示剪辑的播放时间。

Sequential Number：显示各个剪辑的序列

号。
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在本摄像机上，拍摄和播放设置都在出现在

取景器内的设置菜单中进行。

设置菜单也可以显示在外部视频监视器上

（请参见第 145 页）。

用于从设置菜单按任意选定顺序调整项目的

菜单 （请参见第 97 页）。

用于进行与拍摄有关的设置 （与图像质量有

关的设置除外）的菜单。

用于进行与图像质量有关的设置的菜单。

第 6章 菜单显示和设置

设置菜单的结构

“User”菜单

“Operation”菜单

项目 说明 页码

Format 系统设置 101

Format Media 介质格式设置 102

Input/Output 输入 / 输出信号设置 102

Super Impose 叠加文本设置 103

LCD LCD 监视器设置 103

Rec Function 特殊记录模式设置 103

Proxy Recording 
Mode

代理数据设置 104

Assignable Switch 为可指定开关指定功

能

104

VF Setting 取景器设置 105

Marker 标记设置 106

Gain Switch 增益值设置 107

Auto Iris 自动光圈设置 107

Zebra 斑马纹图形设置 108

Display On/Off 取景器显示项目设置 108

“!” LED 取景器 “!”设置 109

White Setting 白平衡设置 110

Offset White 偏置白平衡设置 110

Shutter 快门设置 110

Slow Shutter 低速快门设置 110

Time Zone 时钟设置 110

Clip 剪辑设置 111

Update Media 更新介质管理信息 111

GPS 位置信息 (GPS) 设置 111

Planning Metadata 计划元数据设置 111

“Paint”菜单

项目 说明 页码

Switch Status 校正功能和测试信号

打开 / 关闭设置

112

White 色温设置 112

Black 黑色电平设置 112

Flare 眩光校正设置 113

Gamma 伽马校正设置 114

Black Gamma 黑色伽马校正设置 115

Knee 拐点校正设置 115

White Clip 白限制设置 115

Detail(HD) 细节设置 116

Detail(SD) 细节设置 116

Aperture 光圈校正设置 116

Skin Detail 肤色细节校正设置 117

Matrix 矩阵校正设置 117

Multi Matrix 多种矩阵校正设置 118

V Modulation 视频调制阴影校正设

置

118

Low Key 
Saturation

暗色调饱和校正设置 118

Saturation Mode 饱和度校正设置 118

Noise Suppression 噪音抑制设置 119

项目 说明 页码
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用于进行与剪辑缩略图有关的设置的菜单

（请参见第 92 页）。

注意

缩略图菜单仅在显示缩略图屏幕 （请参见第 85
页）时可用。 未显示缩略图屏幕时不可用。

用于进行与摄像机维护和系统管理有关的设

置的菜单。

用于在文件上执行操作的菜单。

缩略图菜单

“Maintenance”菜单

项目 说明 页码

White Shading 白阴影校正设置 120

Black Shading 黑阴影校正设置 120

Battery 电池设置 121

DC Voltage Alarm 外部直流电压警报设

置

121

Audio 音频设置 121

WRR Setting 无线调谐器设置 124

Timecode 时间代码设置 124

Essence Mark 基本标记设置 125

Camera Config 摄像机操作设置 125

Preset White 色温预设设置 126

White Filter 滤镜设置 126

DCC Adjust DCC 设置 127

Genlock 强制同步设置 127

Auto Shading 自动黑阴影校正设置 127

APR APR 设置 127

Basic 
Authentication

基本验证设置 127

Wi-Fi Wi-Fi 设置 128

File Transfer Wi-Fi 传输设置 128

Clock Set 内部时钟设置 128

Language 显示语言设置 128

Hours Meter 数字时间计数器设置 128

Network Reset 网络重置 128

Fan Control 风扇控制设置 128

Option 软件选件设置 129

Version 版本设置 129

“File”菜单

项目 说明 页码

User Menu Item 用户菜单项目设置 130

User File 用户文件设置 130

All File 全文件设置 130

Scene File 场景文件设置 131

Reference File 参考文件设置 131

Lens File 镜头文件设置 131

User Gamma 伽马文件设置 132
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要显示设置菜单

将 MENU ON/OFF 开关设置为 ON，或按一

下 MENU 键。

摄像机进入菜单模式且菜单列表出现在屏幕

上。

例如： 光标位于 Operation 菜单上时

注意

设置菜单在摄像机处于焦距放大 （Focus Mag）模

式时不可用。 按一下已指定了焦距放大功能的可指

定开关退出焦距放大模式。

进行菜单设置

1 转动MENU旋钮，或按一下J或j键，

将光标移动到您要设置的项目上。
一个可选择的菜单项目列表出现在菜单

列表右侧的菜单项目选择区域内。

2 按一下 MENU 旋钮或 SET 键。
出现菜单项目选择屏幕。

您也可以通过按 k 键显示菜单项目选择

屏幕。

• 菜单项目选择区域最多可显示七行。 您
可以通过上下移动光标翻阅超过七行的

菜单。

3 转动MENU旋钮，或按一下J或j键，

将光标移动到您要设置的项目上，然
后按一下 MENU 旋钮或 SET 键进行

确认。
子项目区域出现在菜单项目选择区域的

右边，且光标移动到第一个子项目。

4 转动MENU旋钮，或按一下J或j键，
将光标移动到您要设置的子项目上，

然后按一下 MENU 旋钮或 SET 键确
认选择。
出行已选定子项目的设置，且光标移动

到当前选定值上。

基本设置菜单操作

菜单项目选择区域

菜单列表

菜单项目选择区域
• 如果选择的项目具有子项目，右侧将出现
子项目。

• 如果没有子项目，右侧将出现当前设置。
• 选择 [Back] 可返回上一级。

当下面存在更多
菜单项目时显示。

• 显示子项目和它们的当前设置
• 要返回上一级，可选择 [Back]、按一下

K 键或向下推 MENU CANCEL/PRST/
ESCAPE 开关至 ESCAPE 位置。

子项目区域

设置区域
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• 设置区域最多可显示九行。 您可以通过

上下移动光标翻阅超过九个子项目的菜

单。

• 对于有大设置范围（例如，–99 到 +99）
的子项目，则不显示设置区域。 当前设

置会高亮显示以表示可以更改值。

5 转动MENU旋钮，或按一下J或j键，
选择您要设置的值，然后按一下

MENU 旋钮或 SET 键进行确认。
设置被更改，且显示更新到表示新设置。

如果您为一个可执行项目选择 [Execute]，
则执行相应的功能。

执行之前需要确认的项目

在步骤 3 中，如果您选择需要在执行之前确

认的项目，菜单消失并出现确认消息。 按信

息中的说明执行或取消操作。

输入文本

选择需要输入字符的文件名等项目时，将会

出现字符输入屏幕。

1 按一下 MENU 旋钮选择要输入的字符

类型，然后按一下 MENU 旋钮或 SET
键。
ABC：大写字母字符

abc：小写字母字符

123：数字字符

!#$：特殊字符

2 从所选字符类型中选择一个字符，然
后按一下此旋钮。
光标移动到下一个字段。

Space：在光标位置输入空格字符。

T/t：移动光标的位置。

BS：删除光标左侧的字符 （退格）。

3 完成后，选择 [Done]，然后按一下此

拨盘。
字符串已确认，字符输入屏幕消失。

取消设置更改

1 或者，将 MENU CANCEL/PRST/
ESCAPE 开关下推至 ESCAPE 位置。

退出菜单

1 将 MENU ON/OFF 开关设置为 OFF，
或按一下 MENU 键。
重新出现正常摄像机图像。
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您可以编辑 “User”菜单，如添加项目、删

除项目和重新排列项目，使 “User”菜单在

使用 “Edit User Menu”时更有用。

您可以选择 “Operation”菜单、“Paint”菜

单或 “Maintenance”菜单中的任何项目，并

将其添加到 “User”菜单。

“User”菜单中最多可注册 20 个项目。 
“User”菜单出厂默认已注册 6 个项目，必须

始终存在其中一个项目，而且您可以添加最

多 19 个新项目。

在“Edit User Menu”屏幕上编辑“User”菜

单。

1 转动 MENU 旋钮选择 “User > Edit 
User Menu”，然后按一下此旋钮。

出现 “Edit User Menu”屏幕。

1 旋转 MENU 旋钮选择 “Edit User 
Menu > Add Item”，然后按一下此旋

钮。
随即显示可添加的项目。

2 旋转 MENU 旋钮选择一个项目，然后

按一下此旋钮。
出现用于选择要添加的子项目的屏幕。

3 转动 MENU 旋钮选择一个子项目，然

后按一下此旋钮。
勾选 “All”复选框添加所有子项目。

勾选个别复选框，指定要添加的子项目。

4 转动 MENU 旋钮选择 [OK]，然后按一

下此旋钮。
随即添加项目 / 子项目。

注意

同一项目或子项目不能注册两次。 此外，不能更改

项目或子项目的名称。

您可以指定要显示的子项目。

1 显示 “Edit User Menu”屏幕。

2 转动 MENU 旋钮选择要编辑的项目，
然后按一下此旋钮。
出现编辑功能列表。

编辑 “User”菜单

显示 “Edit User Menu”屏幕

添加项目和子项目

编辑子项目
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3 旋转 MENU 旋钮选择编辑功能列表中

的 “Edit Sub Item”，然后按一下此
旋钮。

出现 “Edit Sub Item”屏幕。

首次打开屏幕时，将勾选所有子项目

（显示所有子项目的功能）。

在 “User”菜单中，移除您不希望显示

的子项目的复选标记。

4 转动 MENU 旋钮选择 [OK]，然后按一

下此旋钮。
完成编辑。

1 显示 “Edit User Menu”屏幕。

2 转动 MENU 旋钮选择要编辑的项目，
然后按一下此旋钮。
出现编辑功能列表。

3 转动 MENU 旋钮选择编辑功能列表中
的 “Delete”，然后按一下此旋钮。

此时，该项目便已删除。

1 显示 “Edit User Menu”屏幕。

2 转动 MENU 旋钮选择要移动的项目，
然后按一下此旋钮。
出现编辑功能列表。

3 转动 MENU 旋钮选择编辑功能列表中
的 “Move”，然后按一下此旋钮。

该项目将高亮显示，并以三角形标记和

直线指示目的地位置。

4 旋转 MENU 旋钮，将三角形和直线移

动到所需目的地，然后按一下此旋钮。
此时，该项目便已移动。

删除项目

移动项目

指示移动目的地位置的三角形标记和直线
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1 转动 MENU 旋钮选择 “Edit User 
Menu > Customize Reset”，然后按一
下此旋钮。
出现 “Customize Reset”屏幕。

2 转动 MENU 旋钮选择 [Reset]，然后按
一下此旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。
“User”菜单恢复到工厂预设状态。

将 “User”菜单恢复到工厂预

设状态
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用户菜单在工厂预设状态时由下列项目组成。

• Format Media （请参见第 102 页）
• Rec Function （请参见第 103 页）
• Input/Output （请参见第 102 页）
• Clip （请参见第 111 页）
• Assignable Switch 1) （请参见第 104 页）
• Camera Config 2) （请参见第 125 页）

1)不包括子项目 <0>
2)仅包含 “User Menu Only”子项目

有关详情，请参见 “编辑 “User”菜单”（第 97 页）。

菜单列表

“User”菜单 （工厂预设配置）
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默认值会加粗显示。

“Operation”菜单

Operation

项目 子项目设置 说明

Format
设置系统频率、记录格

式和记录宽高比。

Frequency
59.94/50/29.97/25/23.98

选择系统频率 （通过选择 [Execute] 执行）

Rec Format

设置视系统屏幕设置而不

同。

选择记录格式 （通过选择 [Execute] 执行）。

XAVC-I 1080i
XAVC-I 720P
XAVC-L 50 1080P
XAVC-L 50 1080i
XAVC-L 50 720P
XAVC-L 35 1080P
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HD422 50 720P

HQ 1920 × 1080i
HQ 1440 × 1080i
HQ 1280 × 720P
SStP SR-Lite 422

DNxHD 220 × 1080i
DNxHD 145 1080i
ProRes 422 HQ 1080i 
ProRes 422 1080i 
MPEG IMX 50
DVCAM

当系统频率为 59.94 或 50 时。

XAVC-I 1080P
XAVC-L 50 1080P
XAVC-L 35 1080P
HD422 50 1080P
HD422 50 720P

HQ 1920 × 1080P
SStP SR-Lite 422

DNxHD 220 × 1080P
DNxHD 145 1080P
ProRes 422 HQ 1080P
ProRes 422 1080P

当系统频率为 29.97、 25 或 23.98 时

Aspect Ratio （SD）
16:9/4:3

选择 SD 模式宽高比。

Audio Length
24bit/16bit

选择 IMX 格式下记录的音频比特率。
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Format Media
格式化介质。

Media (A)
Execute/Cancel

初始化插槽 A 内的 SxS 存储卡 （通过选择

[Execute] 执行）。

Media (B)
Execute/Cancel

初始化插槽 B 内的 SxS 存储卡 （通过选择

[Execute] 执行）。

SD Card(Utility)
Execute/Cancel

初始化 UTILITY SD 卡插槽中的 SD 卡 （通

过选择 [Execute] 执行）。

SD Card(Proxy)
Execute/Cancel

初始化 PROXY SD 卡插槽中的 SD 卡 （通过

选择 [Execute] 执行）。

Input/Output
设置输入 / 输出信号。

Output Format

设置视系统屏幕设置而不

同。

选择输入格式 （通过选择 [Execute] 执行）。

设置视记录格式设置而不同 （请参见第 101
页）。

Source Select
Camera/External

为音频输入源选择摄像机图像 (Camera) 或
SDI IN 接口输入信号。

SDI Out1 Output
On/Off

打开 / 关闭 SDI OUT1 接口的输出信号。

SDI Out2 Output
On/Off

打开 / 关闭 SDI OUT2 接口的输出信号。

HDMI Output
On/Off

打开 / 关闭 HDMI 接口的输出信号。

SDI Out2/HDMI Super
Off/On

打开 / 关闭 SDI OUT2 接口的字符信息 （叠

加）。

Video Out Super
Off/On

打开 / 关闭 VIDEO OUT 接口的字符信息

（叠加）。

Down Converter
Edge Crop/Letter Box/
Squeeze

为 SD 信号的输出选择信号变换模式。

Edge Crop：修剪 16:9 图像的边缘，输出为

4:3 图像。

Letter Box：隐藏 4:3 图像的顶部和底部，

并以 16:9 图像形式显示在屏幕中央。

Squeeze：水平压缩 16:9 图像，作为 4:3 图

像输出。

Wide ID
Through/Auto

选择是否将宽图像 ID 信号添加至 SD 输出信

号。

Through：输出时不添加宽图像 ID 信号。

Auto：当宽图像 ID 信号设置为 “Squeeze”

时，添加并输出宽图像 ID 信号。

Wide Mode(Ext)
Auto/16:9

当输入信号为 SD 时，设置确定宽屏幕信息

的方法。

Auto：当输入信号的宽屏幕信息为

“Squeeze”时，以 16:9 的宽高比进行记

录。 否则，以 4:3 的宽高比进行记录。

16:9：以 16:9 的宽高比进行记录。

Operation

项目 子项目设置 说明
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Super Impose
设置要叠加的字符信息 /
标记。

Super(VF Display)
On/Off

当 “Input/Output >SDI2 Out2/HDMI Super”
或 “Input/Output >Video Out Super”设置为

“On”时，会分别从 SDI OUT 接口或

VIDEO OUT 接口输出的字符信息上进行叠

加。

Super(Menu)
On/Off

Super(Marker)
On/Off

当 “Input/Output >SDI2 Out2/HDMI Super”
或 “Input/Output >Video Out Super”设置为

“On”时，会分别从 SDI OUT 接口或

VIDEO OUT 接口输出的标记上进行叠加。

LCD
设置 LCD 监视器。

LCD Color

–99 到± 0 到 +99
调整 LCD 监视器的色深。

LCD Marker&Zebra
On/Off

打开 / 关闭 LCD 监视器中的标记和斑马纹图

案显示。

Rec Function
设置特殊记录模式。

Slow & Quick Motion
On/Off

打开 / 关闭慢 & 快动作。 （当设为 On 时，

其他特殊记录模式的此设置会设为 Off。）

Frame Rate

设置视记录格式设置而不

同。

当 “Slow & Quick Motion”设置为 On 时，

选择适合 Slow & Quick Motion 拍摄的帧频。

1 到 60/72/75/80/90/96/100/
110/120

当记录格式为 XAVC Intra 或 XAVC Long 时。

1 到 30 当记录格式为 MPEG2 HD 422 50M (1920 ×

1080)、 29.97P/23.98P 时。

1 到 25 当记录格式为 MPEG2 HD 422 50M (1920 ×

1080)、 25P 时。

Clip Continuous Rec
On/Off

打开 / 关闭剪辑连续记录模式。（当设为 On
时，其他特殊记录模式的此设置会设为

Off。）

Picture Cache Rec
On/Off

打开 / 关闭图像缓存记录模式。

（当设为 On 时，其他特殊记录模式的此设置

会设为 Off。）

Cache Rec Time

设置视记录格式设置而不

同。

当 “Picture Cache Rec”设为 “On”时，设

置图像缓存记录时间。

0 到 2/2 到 4/4 到 6/6 到 8
秒

当记录格式为 AVC-I 时。

0 到 2/2 到 4/4 到 6/6 到 8/
8 到 10/10 到 12/12 到 14/
13 到 15 秒

当记录格式为 XAVC-L、 MPEG2 HD 422、
PEG2 HD 420 或 MPEG IMX 50 时。

Simul Rec
On/Off

打开 / 关闭插槽 A 和 B 的同步记录。

Operation

项目 子项目设置 说明
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Proxy Recording Mode
设置代理记录。

Setting
On/Off

打开 / 关闭代理记录。

Size

1280 × 720(9Mbps)/
640 × 360(3Mbps)/
480 × 270(1Mbps)/
480 × 270(0.5Mbps)

选择代理记录格式的大小。

Frame Rate
23.98fps/25fps/29.97fps/
50fps/59.94fps

选择代理记录格式的帧频。

Bit Rate
9Mbps/3Mbps/1Mbps/
0.5Mbps

选择代理记录格式的比特率。

Audio Channel
CH1/CH2/CH3/CH4

选择要记录到代理数据的音频通道。

Assignable Switch
为可指定开关指定功能。

有关指定功能的详情，
请参见 “为可指定开关
指定功能”（第 133
页）。

<0>

请参见 第 133 页
将某个功能指定给 ASSIGN. 0 开关。

<1>

请参见 第 134 页
将某个功能指定给 ASSIGN. 1 开关。

<2>

请参见 第 134 页
将某个功能指定给 ASSIGN. 2 开关。

<3>

请参见 第 134 页
将某个功能指定给 ASSIGN. 3 开关。

<4>

请参见 第 134 页
将某个功能指定给 ASSIGNABLE 4 开关。

<5>

请参见 第 134 页
将某个功能指定给 ASSIGNABLE 5 开关。

Lens RET

请参见 第 136 页
为镜头上的 RET 键指定功能。

Color Temp.

请参见 第 134 页
为 COLOR TEMP. 键指定功能。

Zoom Speed

0 到 20 到 99
当 “Zoom”被指定给 ASSIGNABLE 4 或 5
开关时，指定变焦速度。

Operation

项目 子项目设置 说明
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VF Setting
设置取景器屏幕。

Color

–99 到± 0 到 +99
调整取景器图像的色深。

Color Mode
Color/B&W

选择取景器显示模式 （当使用 CBK-VF02
时）。

Color：彩色

B&W：黑色和白色

Peaking Type 选择凸出种类 （当使用 CBK-VF02 时）。

Normal：标准凸出

Color：彩色凸出

Peaking Frequency
Normal/High

选择 “Normal”或 “High”作为凸出频率

（当使用 CBK-VF02 时）。

Peaking Color
B&W/Red/Yellow/Blue

选择当 “Peaking Type”设为 “Color”时的

凸出颜色 （当使用 CBK-VF02 时）。

B&W：黑色和白色

Red：红色

Yellow：黄色

Blue：蓝色

VF Detail Level

–99 到± 0 到 +99
设置取景器的细节等级 （在摄像机上设置）

（当使用 HDVF-20A 时）。

Operation

项目 子项目设置 说明
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Marker
设置取景器中的标记显

示。

Setting
On/Off

打开 / 关闭所有标记的显示。

注意

将标记指定给 ASSIGN. 2 开关时，此设置会被
禁用。

Color
White/Yellow/Cyan/Green/
Magenta/Red/Blue

选择标记显示颜色。

Center Marker
1/2/3/4/Off

显示中央标记时，选择此类型。 不想显示标

记时，选择 Off。

Safety Zone
On/Off

打开 / 关闭安全区标记显示。

Safety Area
80%/90%/92.5%/95%

选择安全区范围。

Aspect Marker
Line/Mask/Off

要显示宽高标记时，请选择显示方式。不想

显示标记时，选择 Off。
Line：显示为白色的线。

Mask：对于标记范围外侧区域，显示较低视

频信号电平。

Aspect Select
15:9/14:9/13:9/4:3/1.66:1/
1.85:1/2.35:1/2.4:1

选择标记的宽高比。

Aspect Mask

0% 到 12% 到 15%
当宽高标记设置为面积时，这会将标记区域

外侧区域的视频信号电平设置为与标记区域

内侧区域的视频信号电平相关的百分比值。

Aspect Safety Zone
On/Off

打开 / 关闭宽高比安全区标记显示。

Aspect Safety Area
80%/90%/92.5%/95%

选择宽高比安全区标记的大小 （总屏幕大小

的百分比）。

100% Marker
On/Off

打开 / 关闭 100% 安全区标记指示灯。

User Box
On/Off

打开 / 关闭箱形光标显示。

User Box Width

40 到 500 到 999
设置箱形光标宽度 （从中央到左右边缘的距

离）。

User Box Height

70 到 500 到 999
设置箱形光标高度 （从中央到上下边缘的距

离）。

User Box H Position

–479 到 0 到 479
设置箱形光标中心点的水平位置。

User Box V Position

–464 到 0 到 464
设置箱形光标中心点的垂直位置。

Operation

项目 子项目设置 说明
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Gain Switch
设置增益值开关设置。

Gain<L>
–6dB/–3dB/0dB/3dB/6dB/
9dB/12dB/18dB/24dB/
30dB/36dB/42dB

选择 GAIN 开关的 L 位置的增益值。

Gain<M>
–6dB/–3dB/0dB/3dB/6dB/
9dB/12dB/18dB/24dB/
30dB/36dB/42dB

选择 GAIN 开关的 M 位置的增益值。

Gain<H>
–6dB/–3dB/0dB/3dB/6dB/
9dB/12dB/18dB/24dB/
30dB/36dB/42dB

选择 GAIN 开关的 H 位置的增益值。

Gain<Turbo>
–6dB/–3dB/0dB/3dB/6dB/
9dB/12dB//18dB/24dB/
30dB/36dB/42dB

选择指定给可指定开关的 Turbo Gain 功能的

增益值。

Shockless Gain
On/Off

打开 / 关闭减震增益 （切换增益时可以平滑

地切换的功能）。

Auto Iris
设置自动光圈。

Iris Override
On/Off

打开 / 关闭光圈优先 （非常规打开或关闭光

圈的设置）。

Mode
Backlight/Standard/
Spotlight

选择自动光圈的控制模式。

Backlight：背光模式 （避免被摄物体在背

光条件下变暗的模式）

Standard：标准模式 （使用可选的远程控制

连接时无法选择此模式）

Spotlight：聚光灯模式 （在聚光灯集中照射

被摄物体时减少淡出的亮区的模式）

Level

–99 到± 0 到 +99
设置收敛目标电平 （值越大，亮度越大）。

Speed

–99 到± 0 到 +99
设置控制速度 （更改视频时的响应速度）。 
（数值越大反应越快。）

Clip High light
On/Off

打开 / 关闭可忽略最亮区域以对高亮度区域

进行扁平化反应的功能。

Detect Window
1/2/3/4/5/6/Var

选择自动光圈检测区域的类型。

Var：变量

Detect Window Indication
On/Off

打开 / 关闭使用标记显示自动光圈检测区域

帧的功能。

Iris APL Ratio

–99 到± 0 到 +99
如果 “Auto Iris”的 “Mode”设置设为

“Standard”，设置峰值的混合比来表示自动

光圈检测值。

Iris Var Width

40 到 500 到 999
设置当 “Iris Window”设为 Var 时检测窗口

的宽度。

Iris Var Height

70 到 500 到 999
设置当 “Iris Window”设为 Var 时检测窗口

的高度。

Iris Var H Position

–479 到 0 到 479
设置当 “Iris Window”设为 Var 时检测窗口

的水平位置。

Iris Var V Position

–464 到 0 到 464
设置当 “Iris Window”设为 Var 时检测窗口

的垂直位置。

Operation

项目 子项目设置 说明
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Zebra
设置斑马纹图案的显示。

Zebra Select
1/2/Both

选择斑马纹图形类型 （斑马纹 1，斑马纹 2，
1&2）。

Zebra1 Level

50% 到 70% 到 107%
设置斑马纹 1 显示电平。

Zebra1 Aperture Level

1 到 10% 到 20%
设置斑马纹 1 光圈等级。

Zebra2 Level

52% 到 100% 到 109%
设置斑马纹 2 显示电平。

Display On/Off
选择要在取景器中显示

的项目。

Video Level Warning
On/Off

打开 / 关闭在视频电平太亮或太暗时出现的

警告。

Shutter Setting
On/Off

打开 / 关闭快门模式和快门速度指示灯。

ND Filter Position
On/Off

打开 / 关闭 ND 滤镜设置指示灯。

Gain Setting
On/Off

打开 / 关闭增益设置指示灯。

Rec/Play Status
On/Off

打开 / 关闭记录和播放指示灯。

Color Temp.
On/Off

打开 / 关闭色温度指示灯。

Frame Rate
On/Off

当在 Slow & Quick Motion 记录模式下时，打

开 / 关闭 S&Q 帧频指示器。

Battery Remain
On/Off

打开 / 关闭剩余电池电量和输入电压指示灯。

Timecode
On/Off

打开 / 关闭时间数据 （时间代码、用户位、

计数器、持续时间）的显示。

Audio Level Meter
On/Off

打开 / 关闭音频电平表的显示。

Media Status
On/Off

打开 / 关闭介质状态指示灯。

Focus Position
Meter/Feet/Off

打开 / 关闭镜头聚焦点指示灯并选择显示单

位。

Iris Position
On/Off

打开 / 关闭镜头光圈位置指示灯。

Zoom Position
On/Off

打开 / 关闭镜头变焦位置指示灯。

Extender
On/Off

打开 / 关闭镜头和数字扩展器指示灯。

ALAC
On/Off

打开 / 关闭镜头像差补正指示灯。

AE Mode
On/Off

打开 / 关闭 AE 模式和 AE 电平设置指示灯。

White Balance Mode
On/Off

打开 / 关闭白平衡模式指示灯。

CC5600K
On/Off

打开 / 关闭 CC5600K 指示灯。

Operation

项目 子项目设置 说明
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Display On/Off
选择要在取景器中显示

的项目。

Rec Format
On/Off

打开 / 关闭记录格式指示灯。

Gamma
On/Off

打开 / 关闭选定的 Gamma 类型指示灯。

Timecode Lock
On/Off

打开 / 关闭时间代码指示灯。

Wi-Fi Condition
On/Off

打开 / 关闭 Wi-Fi 信号强度指示灯。

Proxy Status
On/Off

打开 / 关闭代理状态指示灯。

GPS
On/Off

打开 / 关闭 GPS 接收状态指示灯。

Video Signal Monitor
Off/Waveform/Vector/
Histogram

选择是否显示视频信号以及要显示的视频信

号的类型。

注意

在以下环境中不会显示。
• 当设置菜单中的“Operation > Input/Output > 

SDI Out1 Select”和 “SDI Out2 Select”都设
为 Off 时。 

• 当设置菜单中的“Operation > Input/Output > 
Output Format”设为 720 × 480P 或 720 ×
576P 时。

Clip Name
On/Off

打开 / 关闭剪辑名称显示。

Focus Assist Indicator
On/Off

打开 / 关闭聚焦补正指示灯。

Focus Area Marker
On/Off

打开 / 关闭聚焦区域标记指示灯。

Lens Info
Meter/Feet/Off

选择是否显示景深以及要显示的单位。

WRR RF Level
On/Off

打开 / 关闭无线调谐器接收状态指示灯。

Clip Number
On/Off

打开 / 关闭剪辑信息显示。

“!” LED
在取景器中设置 “!”指

示灯。 （当使用 HDVF-
20A 时，此设置有效）。

Gain <!>
On/Off

打开 / 关闭增益设为 0 dB 以外的值时点亮 !
指示灯的功能。

Shutter <!>
On/Off

打开 / 关闭 SHUTTER 开关设为 ON 时点亮 !
指示灯的功能。

White Preset <!>
On/Off

打开或关闭 WHITE BAL 开关设为 PRST 时

点亮 ! 指示灯的功能。

ATW Run <!>
On/Off

打开或关闭使用 ATW 时点亮 ! 指示灯的功

能。

Extender <!>
On/Off

打开或关闭使用数字扩展器功能或镜头扩展

器时点亮 ! 指示灯的功能。

Filter <!>
On/Off

打开 / 关闭 ND 滤镜设为 1 以外的值时点亮 !
指示灯的功能。

Iris Override <!>
On/Off

打开 / 关闭自动光圈优先未设为 “标准”时

点亮 ! 指示灯的功能。

Operation
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White Setting
进行与白平衡调整有关

的设置。

White Switch<B>
Memory/ATW

设置通过 WHITE BAL 开关的 B 位置选择的

操作模式。

Memory：自动白平衡

ATW：自动跟踪白平衡

Shockless White
Off/1/2/3

选择当 WHITE BAL 开关设置被更改时的转

换时间 （1 为最快）。

ATW Speed
1/2/3/4/5

选择 ATW （自动跟踪白平衡）转换速度 （1
为最快）。

AWB Fixed Area
On/Off

在屏幕的中央运行自动 AWB （自动白平

衡）。

Filter White Memory
On/Off

当 “White Balance”设为 “Preset”或 ATW
时，为每个 FILTER 旋钮位置编号设置白平

衡数据保存区。

• 将 “Electrical CC”分配给可指定开关时，

此项会为 “Electrical CC A”、“Electrical 
CC B”、“Electrical CC C”和 “Electrical 
CC D”设置设置独立的白平衡数据保存

区。

• 将 “Electrical CC”分配给可指定开关时，

此项会为每个 FILTER 旋钮位置编号设置白

平衡数据保存区。

Offset White
进行与自动白平衡调整

有关的设置。

Offset White <A>
On/Off

选择是为存储器 A 中的白平衡添加 (On) 偏置

值还是不添加 (Off) 偏置值。

Warm Cool <A>

显示大致色温。

（约 1600K 到 3200K 到

16000K）

当 Offset White <A> 设为 On 时，此项会指定

要作为色温添加到存储器 A 中的白平衡的偏

置。（请注意，偏置色温越高，误差越大。 
请在查看实际图像时进行调整。）

Warm Cool Balance <A>

–99 到± 0 到 +99
当无法用 “Warm Cool <A>”设置获得满意

图像时，指定一个更精确的色温。

Offset White <B>
On/Off

设置为 On 时，此处调整的偏置值会被添加

到通道 B 的白平衡。

Warm Cool <B>

显示大致色温。

（约 1600K 到 3200K 到

16000K）

当 Offset White <B> 设为 On 时，此项会指定

要作为色温添加到存储器 A 中的白平衡的偏

置。（请注意，偏置色温越高，误差越大。

请在查看实际图像时进行调整。）

Warm Cool Balance <B>

–99 到± 0 到 +99
当无法用 “Warm Cool <B>”设置获得满意

图像时，指定一个更精确的色温。

Shutter
设置快门操作模式。

Mode
Speed/Angle

选择电子快门的操作模式。

Speed：以时间设置快门速度（单位：秒）。

Angle：以角度设置快门速度 （单位：度）。

Slow Shutter
设置低速快门。

Setting
On/Off

打开 / 关闭低速快门功能。

Number of Frames
2/3/4/5/6/7/8/16

选择低速快门功能的累积的帧数。

Time Zone
设置时区。

Time Zone

UTC + 13:30 到 UTC 
Greenwich到UTC - 12:00 
Kwajalein

以 30 分钟为跨度，选择一个不同于 UTC
（格林威治标准时间）的值。

Operation

项目 子项目设置 说明
110



Clip
进行与剪辑名称和管理

有关的设置。

注意

请勿分配以 “.”（句点）
符号开头的 剪辑名称。 无
法在计算机的应用软件中
查看名称首字符为 “.”的
剪辑。

Clip Naming
Title/Plan

选择剪辑命名格式。

Title：由 “Title Prefix”指定的名称。

Plan：计划元数据中指定的名称 （如果计划

元数据中未指定任何名称，则使用由

“Title Prefix”指定的名称。）

Title Prefix

文本输入

使用字符串输入屏幕设置剪辑的标题部分

（4 至 46 个字母数字字符）（请参见第 96
页）。

Number Set

设置视 “Clip Naming”设

置而有所不同。

设置剪辑名称的数字部分。

当 “Clip Naming”设为 “Title”时：0001

到 9999

当 “Clip Naming”设为 “Plan”且加载了计

划元数据文件时：00001 到 99999

Update Media
更新介质的管理文件。

Media (A)
Execute/Cancel

更新插槽 A 内的 SxS 存储卡的管理信息 （通

过选择 [Execute] 执行）。

Media (B)
Execute/Cancel

更新插槽 B 内的 SxS 存储卡的管理信息 （通

过选择 [Execute] 执行）。

GPS
打开 / 关闭位置信息

(GPS)。

GPS
On/Off

打开 / 关闭 GPS 功能。

Planning Metadata
进行与计划元数据操作

有关的设置。

Load Media (A)
Execute/Cancel

从 Solt(A) 中的 SxS 存储卡加载计划元数据。

选择 [Execute] 可显示 Solt(A) 中 SxS 存储卡

上所保存计划元数据文件的列表。选择文件

可显示属性屏幕。

Load Media (B)
Execute/Cancel

从 Solt(B) 中的 SxS 存储卡加载计划元数据。

选择 [Execute] 可显示 Solt(B) 中 SxS 存储卡

上所保存计划元数据文件的列表。选择文件

可显示属性屏幕。

Properties
Execute/Cancel

显示摄像机中所加载的计划元数据内容 （通

过选择 [Execute] 执行）。

Clear Memory
Execute/Cancel

清除摄像机中加载的计划元数据 （通过选择

[Execute] 执行）。

Clip Name Disp
Title1(ASCII)/
Title2(UTF-8)

选择当计划元数据中指定了剪辑名称的显示

格式 （请参见第 69 页）。

Operation
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默认值会加粗显示。

“Paint” 菜单

Paint

项目 子项目设置 说明

Switch Status
打开 / 关闭校正功能和测

试信号。

Gamma
On/Off

打开 / 关闭伽马功能。

Black Gamma
On/Off

打开 / 关闭黑色伽马功能。

Matrix
On/Off

打开 / 关闭矩阵功能。

Knee
On/Off

打开 / 关闭拐点功能。

White Clip
On/Off

打开 / 关闭白限制功能。

注意

如果设为 Off，当下一次启动电源时，此项会重
置为 On。

Detail
On/Off

打开 / 关闭细节功能。

Aperture
On/Off

打开 / 关闭光圈功能。

Flare
On/Off

打开 / 关闭眩光校正功能。

Test Saw
On/Off

打开 / 关闭测试信号。

White
设置色温并手动调整白

平衡。

Color Temp <A>

1500K 到 3200K 到
50000K

显示保存在白平衡存储器 A 中的白平衡色

温。

Color Temp Balance <A>

–99 到± 0 到 +99
设置保存在存储器 A 中的白平衡增益值 （与

R 增益和 B 增益关联）。

R Gain <A>

–99 到± 0 到 +99
指定保存在存储器 A 中的白平衡 R 增益值。

B Gain <A>

–99 到± 0 到 +99
指定保存在存储器 A 中的白平衡 B 增益值。

Color Temp <B>

1500K 到 3200K 到
50000K

显示保存在白平衡存储器 B 中的白平衡色

温。

Color Temp Balance <B>

–99 到± 0 到 +99
设置保存在存储器 B 中的白平衡增益值 （与

R 增益和 B 增益关联）。

R Gain <B>

–99 到± 0 到 +99
设置保存在存储器 B 中的白平衡 R 增益值。

B Gain <B>

–99 到± 0 到 +99
设置保存在存储器 B 中的白平衡 B 增益值。

Black
设置黑色电平 （图像

级，无光照）。

您可以通过将黑色电平

调成深黑或浅黑色获得

希望的效果。

Master Black

–99 到± 0 到 +99
设置主黑色电平。

R Black

–99 到± 0 到 +99
设置 R 黑色电平。

B Black

–99 到± 0 到 +99
设置 B 黑色电平。
112



Flare
进行与眩光校正有关的

设置。

眩光现象是由于图像明

亮区域的影响而导致整

个图像的视频电平增加，

从而导致较暗区域的亮

度增加，对比度降低。 
这是由镜头内部的反射

光引起的。

Setting
On/Off

打开 / 关闭眩光校正功能。

Master Flare

–99 到± 0 到 +99
设置主眩光校正电平。

R Flare

–99 到± 0 到 +99
设置红色眩光校正电平。

G Flare

–99 到± 0 到 +99
设置绿色眩光校正电平。

B Flare

–99 到± 0 到 +99
设置蓝色眩光校正电平。

Paint
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Gamma
进行与伽马校正有关的

设置。

伽马校正可让您调整图

像对比度以明显改变图

像效果。

Setting
On/Off

打开 / 关闭伽马校正功能。

Step Gamma

0.35 到 0.45 到 0.90
（幅度为 0.05）

以 0.05 的幅度设置伽马校正值。

Master Gamma

–99 到± 0 到 +99
设置主伽马电平。

R Gamma

–99 到± 0 到 +99
设置 R 伽马电平。

G Gamma

–99 到± 0 到 +99
设置 G 伽马电平。

B Gamma

–99 到± 0 到 +99
设置 B 伽马电平。

Gamma Category
STD/HG/User

选择伽马分类。

STD：适合视频信号的标准伽马曲线

HG：模仿拍摄电影时的层次和色彩再现的伽

马曲线

User： 使用 CvpFileEditorTM V4.2 创建的用

户定义的伽马曲线

Gamma Select

设置视 Gamma Category 设

置而不同。

选择用于伽马校正的伽马表。

当 “Gamma Category”为 STD 时

STD1 DVW：DVW 摄像机当量

STD2 x4.5：× 4.5 增益

STD3 x3.5：× 3.5 增益

STD4 240M：SMPTE-240M 当量

STD5 R709：ITU-R709 当量 （预设值）

STD6 x5.0：× 5.0 增益

当 “Gamma Category”为 HG 时

HG1 3250G36：将 325% 的视频输入压缩到

100% 的视频输出。

HG2 4600G30：将 460% 的视频输入压缩到

100% 的视频输出。

HG3 3259G40：将 325% 的视频输入压缩到

109% 的视频输出。

HG4 4609G33：将 460% 的视频输入压缩成

109% 的视频输出 （预设值）。

当 “Gamma Category”为 “User”时

User 1：User 1 中注册的伽马表 （预设值）

User 2：User 2 中注册的伽马表

User 3：User 3 中注册的伽马表

User 4：User 4 中注册的伽马表

User 5：User 5 中注册的伽马表

Paint
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Black Gamma
进行与黑色伽马校正有

关的设置。

黑色伽马校正可让您在

图像的黑色或近黑色

（暗）部分再现灰度和彩

色。

Setting
On/Off

打开 / 关闭黑色伽马校正功能。

注意

要启用黑色伽马功能，将 “Saturation 
Mode”设为 “Low Key”。

Range
Low/L.Mid/H.Mid

选择黑色伽马校正的效果范围。

Low：0 到 3.6%

L.Mid：0 到 7.2%

H.Mid：0 到 14.4%

Master Black Gamma

–99 到± 0 到 +99
设置主黑色伽马电平。

Knee
进行与拐点校正有关的

设置。

拐点校正通过压缩图像

的明亮部分以响应已记

录 / 输出图像的动态范围

上限，来防止出现淡出

的亮区。 拐点处理开始

位置的信号电平称为

“拐点” , 拐点压缩的斜

度称为 “拐点斜度”。

Setting
On/Off

打开 / 关闭拐点校正功能。

Point

75% 到 95% 到 109%
设置当 DCC 功能为 off 时的拐点。

Slope

–99 到± 0 到 +99
设置当 DCC 功能为 off 时的拐点斜度。

Knee Saturation
On/Off

打开 / 关闭拐点饱和度功能。

注意

要启用拐点饱和度功能，将 “Saturation Mode”
设为 “Knee”。

Knee Saturation Level

–99 到± 0 到 +99
设置拐点饱和电平。

White Clip
进行与白限制设置调整

有关的设置。

白限制设置用于限制视

频输出信号的最大电平。 
最大视频输出信号值被

称为 “白限制设置电

平”。

Setting
On/Off

打开 / 关闭白限制设置调整功能。

Level

90.0% 到 109.0%
预设值视系统频率设置而

不同。

设置白限制设置电平。

当系统频率为 59.94、29.97、24 或 23.98 时，

预设值为 108.0%。 当系统频率为 50.25 时，

此项的设置为 105.0%。

Paint
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Detail(HD)/Detail(SD)
进行与 HD 模式和 SD 模

式中的细节调整有关的

设置。

细节调整用于通过将细

节信号添加到被摄物体

的轮廓来提高图像清晰

度。

Setting
On/Off

打开 / 关闭细节调整功能。

Level

–99 到± 0 到 +99
设置细节等级。

H/V Ratio

–99 到± 0 到 +99
设置水平细节等级和垂直细节等级的混合

比。

Crispening

–99 到± 0 到 +99
设置勾边电平。

Level Depend
On/Off

打开 / 关闭电平决定调整功能。

Level Depend Level

–99 到± 0 到 +99
设置电平决定的电平。

Frequency

–99 到± 0 到 +99
设置垂直细节信号的中心频率 （数值越大，

细节越精确）。

Knee Aperture
On/Off

打开 / 关闭拐点光圈校正功能。

Knee Aperture Level

–99 到± 0 到 +99
设置拐点光圈等级。

Limit

–99 到± 0 到 +99
设置白色侧和黑色侧方向的细节限制器。

White Limit

–99 到± 0 到 +99
设置白色侧细节限制器。

Black Limit

–99 到± 0 到 +99
设置黑色侧细节限制器。

V Black Limit

–99 到± 0 到 +99
设置黑色侧 V 细节限制器。

V Detail Creation
NAM/Y/G/G+R

选择用于生成 V 细节信号的源信号。

NAM：从 R 信号创建的 V 细节信号、从 G

信号创建的 V 细节信号、或从 B 信号创

建的 V 细节信号，取其中电平最高的信

号。

Y：Y 信号

G：G 信号

G+R：按照 1:1 的比例混合 G 信号和 R 信号

的混合信号

Cross Color Suppress

(SD 模式 )
–99 到± 0 到 +99

设置细节的串色抑制电平。

注意

细节调整功能设为 Off 时以及设置菜单中的
“Operation > Format > Frequency”设为 50 或 25
时，此设置会被禁用。

Aperture
进行与光圈校正有关的

设置。

光圈校正用于通过将高

频光圈信号添加到视频

信号来提高分辨率，纠

正由于高频特性导致的

变形。

Setting
On/Off

打开 / 关闭光圈校正功能。

Level

–99 到± 0 到 +99
设置光圈等级。
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Skin Detail
进行与肤色细节校正有

关的设置。

肤色细节校正用于增加

或减少指定色彩范围的

细节等级，以获得优美

的肤色再现。

Setting
On/Off

打开 / 关闭肤色细节校正功能。

Area Detection
Execute/Cancel

显示用于检测肤色细节校正的色彩的色彩检

测屏幕 （通过选中 [Execute] 执行）。

Area Indication
On/Off

打开 / 关闭用于肤色细节校正的区域内斑马

纹图形的显示。

Level

–99 到± 0 到 +99
设置肤色细节等级。

Saturation

–99 到± 0 到 +99
设置用于肤色细节校正处理的色彩的饱和

度。

Hue

0 到 359
设置用于肤色细节校正处理的色彩的相位。

Width

0 到 40 到 90
设置用于肤色细节校正处理的色彩的相位范

围。

Matrix
进行与矩阵校正有关的

设置，用于调整图像的

色相和亮度。

您可以选择某个矩阵以

达到特殊目的，例如使

用 “Adaptive Matrix”控

制线性矩阵的效果或使

用 “预设矩阵”进行预

定义参数设置。 也可以

将用户定义的参数设为

“用户矩阵”。

Setting
On/Off

打开 / 关闭矩阵校正功能。

Adaptive Matrix
On/Off

打开 / 关闭自适应矩阵功能。

Preset Matrix
On/Off

打开 / 关闭预设矩阵功能。

Preset Select
1: SMPTE240M/
2: ITU-709/
3: SMPTE Wide/
4: NTSC/
5: EBU/
6: PAL

选择一个预设矩阵。

1: SMPTE240M：SMPTE-240M 当量

2: ITU-709：ITU-709 当量

3: SMPTE Wide：SMPTE WIDE 当量

4: NTSC：NTSC 当量

5: EBU：EBU 当量

6: PAL：PAL 当量

User Matrix
On/Off

打开 / 关闭用户矩阵校正功能。

Level

–99 到± 0 到 +99
设置整个图像的色彩的饱和度。

Phase

–99 到± 0 到 +99
设置整个图像的色调 （相位）。

User Matrix R-G

–99 到± 0 到 +99
设置一个用户定义的 R-G 用户矩阵。

User Matrix R-B

–99 到± 0 到 +99
设置一个用户定义的 R-B 用户矩阵。

User Matrix G-R

–99 到± 0 到 +99
设置一个用户定义的 G-R 用户矩阵。

User Matrix G-B

–99 到± 0 到 +99
设置一个用户定义的 G-B 用户矩阵。

User Matrix B-R

–99 到± 0 到 +99
设置一个用户定义的 B-R 用户矩阵。

User Matrix B-G

–99 到± 0 到 +99
设置一个用户定义的 B-G 用户矩阵。
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Multi Matrix
进行与多种矩阵校正有

关的设置。

多种矩阵校正使用 16 轴

色彩空间设置饱和度。

Setting
On/Off

打开 / 关闭多种矩阵校正功能。

Area Indication
On/Off

打开 / 关闭通过多种矩阵校正处理的彩色区

域内的斑马纹图形的显示。

Color Detection
Execute/Cancel

显示用于检测多种矩阵的色彩的色彩检测屏

幕 （通过选择 [Execute] 执行）。

Reset
Execute/Cancel

将每个轴的所有 [Hue] 和 [Saturation] 设置为

预设值 （通过选择 [Execute] 执行）。

Axis
B/B+/MG–/MG/MG+/R/R+/
YL–/YL/YL+/G–/G/G+/CY/
CY+/B–

设置用于多种矩阵校正处理的色彩 （16 轴模

式）

Hue

–99 到± 0 到 +99
为每个 16 轴模式设置用于多种矩阵校正处理

的色彩相位。

Saturation

–99 到± 0 到 +99
为每个 16 轴模式设置用于多种矩阵校正处理

的色彩饱和度。

V Modulation
进行与视频调制阴影校

正有关的设置。

视频调制阴影校正由于

镜头和棱镜之间的关系

导致的灵敏度垂直斜率。

Setting
On/Off

打开 / 关闭视频调制阴影校正功能。

Master V Modulation

–99 到± 0 到 +99
设置主视频调制电平。

R V Modulation

–99 到± 0 到 +99
设置 R 信号的视频调制电平。

G V Modulation

–99 到± 0 到 +99
设置 G 信号的视频调制电平。

B V Modulation

–99 到± 0 到 +99
设置 B 信号的视频调制电平。

Low Key Saturation
进行与暗色调饱和度校

正有关的设置。

校正图象较暗部分的色

彩饱和度。

Setting
On/Off

打开 / 关闭暗色调饱和校正功能。

注意

要启用暗色调饱和度功能，将 “Saturation 
Mode”设为 “Low Key”。

Level

–99 到± 0 到 +99
设置低亮度部分的色彩饱和度。

Range
Low/L.Mid/H.Mid

选择暗色调饱和启用时的亮度级别。

Saturation Mode
进行与饱和度校正有关

的设置。

Saturation Mode
Knee/Low Key

选择是在高级别 （“Knee”）还是低级别

（“Low Key”）使用饱和度功能。

Knee Saturation
On/Off

打开 / 关闭拐点饱和度功能。

Black Gamma
On/Off

打开 / 关闭黑色伽马校正功能。

Low Key Saturation
On/Off

打开 / 关闭低色调拐点饱和度功能。
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Noise Suppression
进行与噪音抑制 （噪音

抑制）有关的设置。

您可以在保留精确的边

缘分量的同时有效地抑

制被摄物体中的噪音分

量。

Setting
On/Off

打开 / 关闭噪音抑制功能。

Level
Low/Mid/High

选择噪音抑制电平。
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默认值会加粗显示。

“Maintenance”菜单

Maintenance

项目 子项目设置 说明

White Shading
进行与白阴影校正有关

的设置。

每个不同的镜头都需要

白阴影以校正由于镜头

特性导致的明亮区域中

亮度和颜色的不正常。

Channel Select
Red/Green/Blue

选择白阴影校正的目标。

White H Saw

–99 到± 0 到 +99
设置水平方向的锯齿白阴影校正值。

White H Para

–99 到± 0 到 +99
设置水平方向的抛物线白阴影校正值。

White V Saw

–99 到± 0 到 +99
设置垂直方向的锯齿白阴影校正值。

White V Para

–99 到± 0 到 +99
设置垂直方向的抛物线白阴影校正值。

White Saw/Para
On/Off

打开 / 关闭白阴影“锯齿” / “抛物线”校正

功能。

Black Shading
进行与黑阴影校正有关

的设置。

Channel Select
Red/Green/Blue

选择黑阴影校正的目标。

Black H Saw

–99 到± 0 到 +99
设置水平方向的锯齿黑阴影校正值。

Black H Para

–99 到± 0 到 +99
设置水平方向的抛物线黑阴影校正值。

Black V Saw

–99 到± 0 到 +99
设置垂直方向的锯齿黑阴影校正值。

Black V Para

–99 到± 0 到 +99
设置垂直方向的抛物线黑阴影校正值。

Black Saw/Para
On/Off

打开 / 关闭黑阴影“锯齿” / “抛物线”校正

功能。

Master Black

–99 到± 0 到 +99
设置主黑色电平。

Master Gain (TMP)
–6dB/–3dB/0dB/3dB/6dB/
9dB/12dB/18dB/24dB/
30dB/36dB/42dB

设置一个临时主增益值。
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Battery
进行与电池组有关的设

置。

Near End: Info Battery

5%/10%/15%…95%/100%
设置使用 BP-GL65/GL95 电池时用于显示

“Battery Near End”警告的阈值。

End: Info Battery
0%/1%/2%/3%/4%/5%

设置使用 BP-GL65/GL95 电池时用于显示

“Battery End”警告的阈值。

Near End: Sony Battery

11.5V 到 17V （幅度为

0.1V）

设置使用 BP-L60S/L80S 电池时用于显示

“Battery Near End”警告的阈值。

End: Sony Battery

11.0V 到 11.5V （幅度为

0.1V）

设置使用 BP-L60S/L80S 电池时用于显示

“Battery End”警告的阈值。

Near End: Other Battery

11.5V 到 11.8V 到 17.0V
（幅度为 0.1V）

设置使用非 Sony 电池时用于显示 “Battery 
Near End”警告的阈值。

End: Other Battery

11.0V 到 14.0V （幅度为

0.1V）

设置使用非 Sony 电池组时用于显示

“Battery End”警告的阈值。

Detected Battery
Sony Info Battery/
Sony Battery/Other Battery/
DC IN

显示自动电池类型检测的结果。

DC Voltage Alarm
设置与外部直流电压有

关的警报。

DC Low Voltage1

11.5V 到 17V （幅度为

0.1V）

设置当外部电源连接到 DC IN 接口时用于显

示 “Battery Near End”警告的阈值。

DC Low Voltage2

11.0V 到 14.0V （幅度为

0.1V）

设置当外部电源连接到 DC IN 接口时用于显

示 “Battery End”警告的阈值。

Audio
进行与音频有关的设置。

Front MIC Select
Mono/Stereo

选择前麦克风是单声道 （Mono）还是立体

声 （Stereo）。

Rear XLR Auto
On/Off

打开 / 关闭用于检测后面板上的 AUDIO IN 
CH-1/CH-2 接口的电缆连接的自动检测功

能。

Front MIC CH1 Ref
–70dB/–60dB/–50dB/
–40dB/–30dB

选择通道 1 的前麦克风的参考电平。

Front MIC CH2 Ref
–70dB/–60dB/–50dB/
–40dB/–30dB

选择通道 2 的前麦克风的参考电平。

Rear MIC CH1 Ref
–70dB/–60dB/–50dB/
–40dB/–30dB

选择当 AUDIO IN CH1 开关设为 MIC 时的参

考输入电平。

Rear MIC CH2 Ref
–70dB/–60dB/–50dB/
–40dB/–30dB

选择当 AUDIO IN CH2 开关设为 MIC 时的参

考输入电平。

Line Input Ref
+4dB/0dB/–3dB/EBUL

选择当 AUDIO IN CH1 和 AUDIO IN CH2 开

关都被设置为 LINE 时的参考输入电平。
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Audio
进行与音频有关的设置。

Min Alarm Volume
Off/Set

选择当 ALARM 旋钮被完全关闭时的音量。

Off: 不可听

Set: 可听

Speaker Attenuate
Off/3dB/6dB/9dB/12dB

选择监视器扬声器的音量 （不影响耳机音

量）。

Headphone Out
Mono/Stereo

选择耳机是单声道 （Mono）还是立体声

（Stereo）。

Reference Level
–20dB/–18dB/–16dB/
–12dB/EBUL

设置 1 kHz 测试信号的输出电平。

Reference Out
0dB/+4dB/–3dB/EBUL

设置相对于参考信号输入电平的输出电平。

CH1&2 AGC Mode
Mono/Stereo

自动调整记录到通道 1 和 2 的模拟音频信号

的输入电平，选择是单独调整各通道 (Mono)
还是在立体声模式 (Stereo) 中调整。

CH3&4 AGC Mode
Mono/Stereo

自动调整记录到通道 3 和 4 的模拟音频信号

的输入电平，选择是单独调整各通道 (Mono)
还是在立体声模式 (Stereo) 中调整。

AGC Spec
–6dB/–9dB/–12dB/–15dB/
–17dB

选择 AGC 特性 （饱和电平）。

Limiter Mode
Off/–6dB/–9dB/–12dB/
–15dB/–17dB

选择手动调整音频输入电平时高输入信号的

限制器特性 （饱和电平）。 如果未使用限制

器，请选择 Off。

Output Limiter
On/Off

打开 / 关闭音频输出限制器。

CH1 Wind Filter
On/Off

打开 / 关闭通道 1 降风噪滤波器。

CH2 Wind Filter
On/Off

打开 / 关闭通道 2 降风噪滤波器。

CH3 Wind Filter
On/Off

打开 / 关闭通道 3 降风噪滤波器。

CH4 Wind Filter
On/Off

打开 / 关闭通道 4 降风噪滤波器。

1kHz Tone on Color Bars
On/Off/Auto

设置在彩条模式中是输出 (On) 还是不输出

(Off) 1 kHz 测试信号。

Auto：仅当 AUDIO SELECT CH1 开关被设

置为 AUTO 时才输出测试信号。
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Audio
进行与音频有关的设置。

MIC CH1 Level
Side1/Front/Front+Side1

选择当记录从通道 1 上的前麦克风输入的音

频时用于调整音频电平的旋钮。

Side1：侧面板上的 LEVEL 旋钮 （左侧）

Front：前面板上的 MIC LEVEL 旋钮

Front+Side1：LEVEL 旋钮（左侧）和 MIC 

LEVEL 旋钮 （关联控制）。

MIC CH2 Level
Side2/Front/Front+Side2

选择当记录从通道 2 上的前麦克风输入的音

频时用于调整音频电平的旋钮。

Side2：侧面板上的 LEVEL 旋钮 （右侧）

Front：前面板上的 MIC LEVEL 旋钮

Front+Side2：LEVEL 旋钮（右侧）和 MIC 

LEVEL 旋钮 （关联控制）。

Rear1/WRR Level
Side1/Front/Front+Side1

选择用于调节无线麦克风或与后面板上的

AUDIO IN CH-1 接口连接的设备的音频电平

的旋钮。

Side1：侧面板上的 LEVEL 旋钮 （左侧）

Front：前面板上的 MIC LEVEL 旋钮

Front+Side1：LEVEL 旋钮（左侧）和 MIC 

LEVEL 旋钮 （关联控制）。

Rear2/WRR Level
Side2/Front/Front+Side2

选择用于调节无线麦克风或与后面板上的

AUDIO IN CH-2 接口连接的设备的音频电平

的旋钮。

Side2：侧面板上的 LEVEL 旋钮 （右侧）

Front：前面板上的 MIC LEVEL 旋钮

Front+Side2：LEVEL 旋钮（右侧）和 MIC 

LEVEL 旋钮 （关联控制）。

Audio CH3 Level
Side3/Front/Front+Side3

选择用于调节记录到通道 3 的音频电平的旋

钮。

Side3：侧面板上的 LEVEL 旋钮

Front：前面板上的 MIC LEVEL 旋钮

Front+Side3：LEVEL 旋钮和 MIC LEVEL

旋钮 （关联控制）。

Audio CH4 Level
Side4/Front/Front+Side4

选择用于调节记录到通道 4 的音频电平的旋

钮。

Side4：侧面板上的 LEVEL 旋钮

Front：前面板上的 MIC LEVEL 旋钮

Front+Side4：LEVEL 旋钮和 MIC LEVEL

旋钮 （关联控制）。
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WRR Setting
进行与无线调谐器有关

的设置。

WRR Valid CH Sel
All/CH1

选择是启用无线调谐器的通道 1 和 2
（All），还是只启用通道 1(CH1)。

WRR CH Select
TX1/TX2

选择要在菜单中显示的接收通道。

TX1：显示通道 l。

TX2：显示通道 2。

WRR Delay Comp
On/Off

选择是启用 (On) 还是禁用 (Off) 用于无线输

入音频的延迟补偿功能。 （当选择 On 时，

所有 E-E 输出音频都会延迟约 8 ms。）

TX
---

显示在 WRR CH Select 选定的通道上正在接

收信号的发射器的名称。

TX Audio Peak
---/Peak

显示在 WRR CH Select 选定的通道上正在接

收信号的发射器的 AF 电平是否超过峰值。

TX Input Level 
---/Mic/Line

显示在 WRR CH Select 选定的通道上正在接

收信号的发射器的输入电平是被设置为麦克

风 （Mic）还是线路 （Line）。

TX ATT Level
---

设置在 WRR CH Select 选定的通道上正在接

收信号的发射器的 ATT 电平。 （设置范围取

决于发射器。）

TX LCF Frequency
---

设置在 WRR CH Select 选定的通道上正在接

收信号的发射器的低截止滤波器。（设置范

围取决于发射器。）

TX System Delay

Auto/0.0ms 到 8.0ms
设置音频延迟量。

Auto：自动校正延迟量，以使从无线调谐器

收到的音频延迟为零。

0.0ms 到 8.0ms：当通过音频混音器等设备

正在使用多个无线系统时，设置估计的

无线系统延迟量，

Time Code 
进行与时间码有关的设

置。

TC Out 
Auto/Generator

选择时间代码输出。

Auto：输出记录过程中的时间代码发生器

值，以及播放过程中的时间代码读取器

值。

Generator：输出记录和播放过程中的时间

代码发生器值。

DF/NDF
DF/NDF

设置失帧 (DF)/ 全帧模式 (NDF)。

LTC UBIT
Fix/Time

设置以 LTC 用户位值记录的数据。

Fix：记录用户指定的数据。

Time：记录当前的时间。

Counter Display 
Counter/Duration

选择用于重置取景器屏幕上显示的计数器值

的方法。

Counter：继续增加直到按下 RESET 键。

Duration：重置每次开始记录的时间。
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Essence Mark
进行与基本标记有关的

设置。

Find Mode
Clip/Rec Start

设置按下 NEXT/PREV 键时的操作。

Rec Start：分别移至下一个或上一个记录开

始标记。

Clip：按下 NEXT 键时移至下一剪辑的开

头。 当按下 PREV 键时，移至当前剪辑

的开头 （如果在剪辑开头处按下 PREV

键，则会移至上一剪辑的开头）。

Camera Config
进行与各种摄像机操作

有关的设置。

HD SDI Remote I/F
Off/Characters/
Green Tally/Red Tally

设置是否为连接到本摄像机 SDI OUT 1/2 接

口 （HD SDI 输出）的外部设备启用记录控

制功能。 如果启用此功能，则会选择用于显

示外部设备记录状态的指示灯。

Off：禁用记录控制功能。

Chara：使用取景器中状态显示上的外部设

备控制指示灯显示。

G-Tally：使用取景器中的 TALLY 指示灯

（绿色讯号指示灯）显示。

R-Tally：使用取景器中的 REC 指示灯 （记

录红色讯号指示灯）显示。

Color Bars Select
ARIB/100%/75%/SMPTE

选择彩条类型。

User Menu Only
On/Off

选择在摄像机显示菜单时是仅显示 “User”
菜单 (On) 还是显示菜单列表 (Off)。

RM Common Memory
On/Off

选择在使用远程控制设备连接时和在本地操

作摄像机时之间是共享 (On) 还是不共享

(Off) 设置。

RM Rec Start
RM/Camera/PARA

选择连接有远程控制设备时要启用哪个记录

开始 / 停止键。

RM：远程控制设备

Camera：摄像机

PARA：远程控制部件 / 摄像机

SET Key on Thumbnail
Pause/Play

选择当仅选择一个缩略图时按下 MENU 旋钮

时的操作。

ALAC
Auto/Off

设置是否自动执行 ALAC （镜头自动彩色误

差校正）。

Auto：当安装了 ALAC- 兼容镜头、 ALAC

功能处于开启状态时，自动执行 ALAC。

Off：不执行。
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Preset White
进行与白平衡预设值有

关的设置。

Color Temp <P>

1500K 到 3200K 到
50000K

设置白平衡预设值。

C.Temp BAL <P>

–99 到± 0 到 +99
设置在无法用 Color Temp <P> 获得满意的图

像时使用的精细色温设置。

R Gain <P>

–99 到± 0 到 +99
设置 R 增益预设值。

B Gain <P>

–99 到± 0 到 +99
设置 B 增益预设值。

AWB Enable <P>
On/Off

当 WHITE BAL 开关设为 PRST 时，打开 / 关
闭 AWB （自动白平衡）功能的执行。

Color Temp <P>

1500K 到 3200K 到
50000K

设置白平衡预设值。

C.Temp BAL <P>

–99 到± 0 到 +99
设置在无法用 Color Temp <P> 获得满意的图

像时使用的精细色温设置。

R Gain <P>

–99 到± 0 到 +99
设置 R 增益预设值。

B Gain <P>

–99 到± 0 到 +99
设置 B 增益预设值。

AWB Enable <P>
On/Off

当 WHITE BAL 开关设为 PRST 时，打开 / 关
闭 AWB （自动白平衡）功能的执行。

White Filter
进行与滤镜有关的设置。

ND Filter C.Temp
On/Off

打开 / 关闭将电子 CC 滤镜指定给 ND 滤镜的

功能。

ND FLT C.Temp<1>
3200K/4300K/5600K/
6300K

选择当电子 CC 滤镜被分配给 ND 滤镜 （滤

镜 1）时的色温。

ND FLT C.Temp<2-4>
3200K/4300K/5600K/
6300K

选择当电子 CC 滤镜被分配给 ND 滤镜 （滤

镜 2 到 4）时的色温。

Electrical CC<A>
3200K/4300K/5600K/
6300K

选择当电子色彩纠正滤镜切换功能被指定给

某个可指定开关时的色温。

Electrical CC<B>
3200K/4300K/5600K/
6300K

选择当电子色彩纠正滤镜切换功能被指定给

某个可指定开关时的色温。

Electrical CC<C>
3200K/4300K/5600K/
6300K/---

选择当电子色彩纠正滤镜切换功能被指定给

某个可指定开关时的色温。 如果未使用 C，
请选择 “----”。

Electrical CC<D>
3200K/4300K/5600K/
6300K/---

选择当电子色彩纠正滤镜切换功能被指定给

某个可指定开关时的色温。 如果未使用 D，

请选择 “----”。
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DCC Adjust
进行与 DCC （动态对比

度控制）有关的设置。

DCC Function Select
DCC/Fix

当 OUTPUT/DCC 开关设置为 CAM 且 DCC
打开时，选择拐点的设置方法。

DCC：自动调整拐点以符合被摄物体的亮

度。

Fix：设置拐点为固定值。

DCC D Range
400%/450%/500%/550%/
600%

设置当 OUTPUT/DCC 开关设置为 CAM 且

DCC 打开时的动态范围。

DCC Point

–99 到± 0 到 +99
设置 DCC 最小拐点。

DCC Gain

–99 到± 0 到 +99
设置相对于 DCC 检测值的增益。

DCC Delay Time

–99 到± 0 到 +99
设置 DCC 控制速度 （更改视频时的响应速

度）。

DCC Peak Filter

–99 到± 0 到 +99
调整相对于 DCC 检测值峰值的响应灵敏度。

Genlock
进行与强制同步有关的

设置。

Genlock
On/Off

打开 / 关闭强制同步功能。

Reference
Internal/External(HD)/
External(SD)

显示本摄像机使用的参考信号类型。

Auto Shading
执行自动黑阴影校正。

Auto Black Shading
Execute/Cancel

执行自动黑阴影校正 （通过选择 [Execute] 执
行）。

Reset Black Shading
Execute/Cancel

清除黑阴影校正值 （通过选择 [Execute] 执
行）。

Master Gain (TMP)
–6dB/–3dB/0dB/3dB/6dB/
9dB/12dB/18dB/24dB/
30dB/36dB/42dB

设置一个临时主增益值。 （该值与用 GAIN
开关选择的值相同。）

APR
进行与自动像素噪音降

低有关的设置。

APR
Execute/Cancel

执行自动像素噪音降低功能以抑制 SLS 模式

中的白斑 （通过选择 [Execute] 执行）。

复位
Execute/Cancel

删除通过执行 APR 和自动黑平衡调整功能添

加的白斑数据 （通过选择 [Execute] 执行）。

Basic Authentication
进行与基本验证有关的

设置。

User Name

（输入当前 User Name。）

设置用户名 （用于基本验证的任意名称）。 
工厂预设为 “admin”。

Password
*******

设置密码 （用于基本验证）。 工厂预设为

“pxw-x500”。
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Wi-Fi
进行与 Wi-Fi 连接有关的

设置。

Setting
Access Point/Station/Off

设置无线 LAN 连接的操作模式。

Channel
Auto/CH1/CH2/CH3/CH4/
CH5/CH6/CH7/CH8/CH9/
CH10/CH11/CH12/CH13

设置无线 LAN 通道。

SSID & Password

（SSID 显示）

（Password 显示）

显示 SSID 和密码。

WPS
Execute/Cancel

启动 Wi-Fi Protected Setup(WPS) （通过选择

[Execute] 执行）。

IP Address 显示本摄像机的 IP 地址。

Subnet Mask 显示 Subnet Mask。

MAC Address 显示安装到本摄像机的 USB Wireless LAN 
Module 的 MAC 地址。

Regenerate Password
Execute/Cancel

重新生成密码 （通过选择 [Execute] 执行）。

File Transfer
进行与本摄像机中 SxS
存储卡上数据的 Wi-Fi 传
输有关的设置。

File Transfer
Execute/Cancel

切换到传输模式 （通过选择 [Execute] 执
行）。

Clock Set
设置内部时钟。

Date Mode
YYMMDD/MMDDYY/
DDMMYY

选择日期显示格式。

12H/24H
12H/24H

选择时钟显示格式。

Date 显示日期设置屏幕。

Time 显示时间设置屏幕。

Language
选择消息显示语言。

Select
English/ /
Español/

选择消息显示语言。

Hours Meter
进行与数字小时表有关

的设置。

Hours (System)
xxxxH

（其中 “xxxx”是小时

数）

显示累积使用的小时数 （无法重置）。

Hours (Reset)
xxxxH

（其中 “xxxx”是小时

数）

显示累积使用的小时数 （可以重置）。

Reset
Execute/Cancel

将 “Hours (Reset)”显示重设为 0 （通过选

择 [Execute] 执行）。

Network Reset
将与网络有关的设置返

回到工厂预设状态。

Reset
Execute/Cancel

重置网络设置 （通过选择 [Execute] 执行）。

Fan Control
设置风扇控制模式。

Setting
Auto/Minimum/Off in Rec

选择风扇控制模式。

Maintenance
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Option
检查软件选件并执行操

作。

Type

选件型号名称

显示已安装选件的型号名称 （PXWK-501、
PXWK-502、 PXWK-503），一行一个名称。

Install Option
Execute/Cancel

显示安装选件的屏幕 （通过选择 [Execute] 执
行）。

Remove Option 显示移除选件的屏幕。

Version
显示摄像机的版本，及

进行摄像机的版本升级。

Number 显示摄像机的软件版本 （Vx.xx）。

Version Up
Execute/Cancel

摄像机的版本升级 （通过选择 [Execute] 执
行）。

注意

未插入版本更新器 SD 卡时无法选中。

Net-Func Version Number 显示摄像机的无线 LAN 连接功能的固件版本
(Vx.xx)

Net-Func Ver.Up
Execute/Cancel

更新无线 LAN 连接功能的固件 （通过选择

“Execute”执行）。
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默认值会加粗显示。

“File”菜单

File

项目 子项目设置 说明

User Menu Item
进行与用户菜单项目操

作有关的设置。

Load SD Card 显示用于从 SD 卡加载用户菜单项目设置的

屏幕。

Save SD Card 显示用于向 SD 卡保存用户菜单项目设置的

屏幕。

File ID 显示用于显示 / 编辑用户菜单项目的文件 ID
的屏幕。

User File
进行与用户文件操作有

关的设置。

Load SD Card 显示用于从 SD 卡加载用户文件设置的屏幕。

Save SD Card 显示用于向 SD 卡保存用户文件设置的屏幕。

File ID 显示用于显示 / 编辑用户文件的文件 ID 的屏

幕。

Recall User Preset
Execute/Cancel

将 “User”菜单中注册的菜单项目的值返回

到工厂预设值 （通过选择 [Execute] 执行）。

Store User Preset
Execute/Cancel

将 “User”菜单项目中注册的菜单项目的值

存储为工厂预设值 （通过选择 [Execute] 执
行）。

Clear User Preset
Execute/Cancel

将 “User”菜单项目中注册的当前设置和预

设值返回到工厂预设值 （通过选择 [Execute]
执行）。

Load Customize Data
On/Off

设置是否在执行 [Load SD Card] 时加载

“User”菜单自定义的信息。

Load White Data
On/Off

设置是否在执行 [Load SD Card] 时加载白平

衡信息。

All File
进行与全文件操作有关

的设置。

Load SD Card 显示用于从 SD 卡加载 “All File”设置的屏

幕。

Save SD Card 显示用于向 SD 卡保存 “All File”设置的屏

幕。

File ID 显示用于显示 / 编辑 “All File”的文件 ID
的屏幕。

All Preset
Execute/Cancel

将所有项目返回到它们的预设值 （通过选择

“Execute”执行）。

Store All Preset
Execute/Cancel

将所有项目的当前设置存储为预设值 （通过

选择 [Execute] 执行）。

Clear All Preset
Execute/Cancel

将 “All File”菜单项目的当前设置和预设值

返回到工厂预设值 （通过选择 “Execute”
执行）。

3Sec Clear Preset
On/Off

当向上推 MENU CANCEL/PRST/ESCAPE 开

关并在 CANCEL/PRST 位置保持 3 秒时，可

打开 / 关闭清除各项目当前设置和预设值的

功能。
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Scene File
进行与场景文件操作有

关的设置。

Recall Internal Memory 显示用于从内存调用场景文件的屏幕。

Store Internal Memory 显示用于在内存中存储场景文件的屏幕。

Load SD Card 显示用于从 SD 卡加载场景文件的屏幕。

Save SD Card 显示用于向 SD 卡存储场景文件的屏幕。

File ID 显示用于显示 / 编辑场景文件的文件 ID 的屏

幕。

Scene White Data
On/Off

设置是否反映调用场景文件时场景文件的白

平衡数据。

Reference File
进行与参考文件操作有

关的设置。

Store Reference
Execute/Cancel

将参考文件目标菜单项目的当前设置存储为

工厂预设值 （通过选择 [Execute] 执行）。

Clear Reference
Execute/Cancel

将参考文件目标菜单项目的当前设置和预设

值返回到工厂预设值 （通过选择 [Execute] 执
行）。

Load Reference(SD Card)
Execute/Cancel

从 SD 卡加载参考文件设置并设置预设值

（通过选择 [Execute] 执行）。

Save Reference(SD Card)
Execute/Cancel

将参考文件目标菜单项目的预设值存储到 SD
卡 （通过选择 [Execute] 执行）。

File ID 显示用于显示 / 编辑参考文件的文件 ID 的屏

幕。

Lens File
显示已安装镜头的型号

名称。

Display Mode
Model Name/Lens ID

选择要在保存或加载文件时出现的列表框中

显示的项目。

Recall Internal Memory 显示用于从内存调用镜头文件的屏幕。

Store Internal Memory 显示用于在内存中存储镜头文件的屏幕。

Load SD Card 显示用于从 SD 卡加载镜头文件的屏幕。

Save SD Card 显示用于向 SD 卡存储镜头文件的屏幕。

File ID 显示用于显示 / 编辑镜头文件的文件 ID 的屏

幕。

File Source 显示选定文件的编号。

Clear Lens Offset
Execute/Cancel

清除镜头文件 （通过选择 [Execute] 执行）。

Lens Auto Recall
Off/On(Lens Name)/
On(Serial Number)

设置是否在安装了支持串行通讯的镜头时自

动调用镜头文件。

Lens Serial Number 显示已安装镜头的序列号 （仅限支持串行通

讯的镜头）。

Lens Name 显示已安装镜头的型号名称 （仅限支持串行

通讯的镜头）。

File
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Lens File
显示已安装镜头的型号

名称。

Lens Manufacturer 显示已安装镜头的制造商名称 （仅限支持串

行通讯的镜头）。

Master V Modulation

–99 到± 0 到 +99
在镜头文件中设置垂直方向的锯齿阴影校正

值。

Lens Center H

–40 到± 0 到 +40
设置镜头文件中央标记的水平位置。

Lens Center V

–40 到± 0 到 +40
设置镜头文件中央标记的垂直位置。

R Flare

–99 到± 0 到 +99
设置镜头文件中 R 眩光电平。

G Flare

–99 到± 0 到 +99
设置镜头文件中 G 眩光电平。

B Flare

–99 到± 0 到 +99
设置镜头文件中 B 眩光电平。

White Offset R

–99 到± 0 到 +99
设置镜头文件中镜头的白平衡偏置 R 通道校

正值。

White Offset B

–99 到± 0 到 +99
设置镜头文件中镜头的白平衡偏置 B 通道校

正值。

Shading Ch Select
Red/Green/Blue

选择白阴影校正的目标。

Shading H SAW

–99 到± 0 到 +99
设置镜头文件中水平方向的锯齿白阴影校正

值。

Shading H PARA

–99 到± 0 到 +99
设置镜头文件中水平方向的抛物线白阴影校

正值。

Shading V SAW

–99 到± 0 到 +99
在镜头文件中设置垂直方向的锯齿白阴影校

正值。

Shading V PARA

–99 到± 0 到 +99
设置镜头文件中垂直方向的抛物线白阴影校

正值。

User Gamma
进行与用户伽马有关的

设置。

Current Settings 显示当前用户伽马文件设置的列表屏幕 （文

件名）。

Load SD Card 显示用于从 SD 卡加载 “User Gamma”设置

的屏幕。

Reset
1/2/3/4/5/All

重置选定用户伽马文件中的设置 （通过选择

[Execute] 执行）。

选择 [All] 重置所有伽马文件。

File
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通过使用 “操作”菜单的可指定开关项目，可以将用户指定的功能分配到 ASSIGN. 0 到 3 开

关、 ASSIGNABLE 4 和 5 开关、 COLOR TEMP. 键以及镜头上的 RET 键。

下表列出摄像机出厂时各开关的定义情况。

为可指定开关指定功能

开关或键 功能 可指定开关设置

ASSIGN. 0 开关 不指定 Off

ASSIGN. 1 开关 不指定 Off

ASSIGN. 2 开关 不指定 Off

ASSIGN. 3 开关 不指定 Off

ASSIGNABLE 4 开关 不指定 Off

ASSIGNABLE 5 开关 不指定 Off

RET 键 Rec Review （如果允许播放） Lens RET

COLOR TEMP. 键 使用 5600K 预设值调整白平衡。 Color Temp SW 5600K

可以指定给 ASSIGN. 0 开关的功能

可指定开关设置 功能 下一次打开摄像机电

源的状态

Off 不指定 —

Marker 打开 / 关闭所有标记的显示。 设置被保留

ATW Hold 保持 ATW （自动跟踪白平衡）模式中的白平衡设置 —

Picture Cache 打开 / 关闭图像缓存记录模式。 设置被保留

Focus Magnifier 打开或关闭焦距放大功能。 设置不保留

Zebra 打开或关闭斑纹彩色图形显示。 设置不保留

Shot Mark1 写入拍摄标记 1。 —

Shot Mark2 写入拍摄标记 2。 —

OK Mark 添加或删除 OK 标记。 —

Clip Flag OK 在记录或播放的剪辑上添加 / 清除 OK 标记。 设置不保留

Clip Flag NG 在记录或播放的剪辑上添加 / 清除 NG 标记。 设置不保留

Clip Flag Keep 在记录或播放的剪辑上添加 / 清除 KP （保持）标

记。

设置不保留
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注意

将某个功能指定给 ASSIGN. 2 开关或切换记录格式后，开关的设置可能无法立即与本摄像机的内部状态匹

配。 指定某个功能后，请切换 ASSIGN. 2 开关或关闭并再次打开本摄像机的电源。

注意

a) 指定 “Picture Cache”后，“Operation >Rec Function”会被禁用 （变灰）且不能设置。

可以指定给 ASSIGN. 2 开关的功能

可指定开关设置 功能

Off 不指定

Front Mic 当连接立体声麦克风时，在立体声和单声道之间切换。

Marker 打开 / 关闭所有标记的显示。

Picture Cache a)
打开 / 关闭图像缓存记录模式。

Zebra 打开或关闭斑纹彩色图形显示。

Clip Continuous Rec 打开 / 关闭剪辑连续记录模式。

Digital Extender × 2 打开或关闭屏幕放大功能 ( × 2)。

Digital Extender × 3 打开或关闭屏幕放大功能 ( × 3)。

Digital Extender × 4 打开或关闭屏幕放大功能 ( × 4)。

Rec Source 切换摄像机图像和外部输入之间要记录的信号。 （如果本摄像机当前正在

进行记录或播放，则切换将在记录或播放结束后生效。）

可以指定给 ASSIGN. 1 和 3 开关、 ASSIGNABLE 4 和 5 开关、以

及 COLOR TEMP. 键的功能

可指定开关设置 功能 下一次打开摄像机电

源的状态

Off 不指定 —

Front Mic 当连接立体声麦克风时，在立体声 (On) 和单声道

(Off) 之间切换。

设置被保留

Marker 打开 / 关闭所有标记的显示。 设置被保留

ATW 打开或关闭 ATW （自动跟踪白平衡）模式。 设置不保留

ATW Hold 保持 ATW 模式中的白平衡设置。 —

Turbo Gain 根据 “Operation > Gain Switch > Gain Turbo”的设置

执行 “Turbo Gain”。

设置不保留

Rec Review 进行记录预览。 —

Rec 开始或停止记录。 —

Picture Cache 打开 / 关闭图像缓存记录模式。 设置被保留

Spotlight 打开或关闭自动光圈模式的聚光灯功能。 设置被保留

Backlight 打开或关闭自动光圈模式的背光功能。 设置被保留

VF Mode 在黑白 (On) 和彩色 (Off) 之间切换取景器屏幕。 设置被保留

Video Signal Monitor 切换视频信号监视器显示功能。 设置被保留

Lens Info 在关闭、以米为单位显示和以英尺为单位显示之间切

换景深指示。

设置被保留
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Zoom Tele/Wide 当安装支持串行通讯的镜头时，将 “Zoom Tele”功

能指定给 ASSIGNABLE 4，并将 “Zoom Wide”功能

指定给 ASSIGNABLE 5 （仅在 <4> 和 <5> 已设置时

显示）。

—

Zoom Wide/Tele 当安装支持串行通讯的镜头时，将 “Zoom Wide”功

能指定给 ASSIGNABLE 4，并将 “Zoom Tele”功能

指定给 ASSIGNABLE 5 （仅在 <4> 和 <5> 已设置时

显示）。

—

Focus Magnifier 打开或关闭焦距放大功能。 设置不保留

Zebra 打开或关闭斑纹彩色图形显示。 设置不保留

Lens RET 显示返回视频信号。

当未连接摄像机扩展单元时：Rec Review （如果允许

播放）

—

Return Video 显示返回 1 视频信号。 —

Return Video2 显示返回 2 视频信号。 —

Return Video3 显示返回 3 视频信号。 —

Return Video4 显示返回 4 视频信号。 —

Shot Mark1 写入拍摄标记 1。 —

Shot Mark2 写入拍摄标记 2。 —

OK Mark 添加或删除 OK 标记。 —

Clip Flag OK 在记录或播放的剪辑上添加 / 清除 OK 标记。 设置不保留

Clip Flag NG 在记录或播放的剪辑上添加 / 清除 NG 标记。 设置不保留

Clip Flag Keep 在记录或播放的剪辑上添加 / 清除 KP （保持）标记。 设置不保留

Color Temp SW 3200K 使用 3200K 预设值调整白平衡。 设置被保留

Color Temp SW 4300K 使用 4300K 预设值调整白平衡。 设置被保留

Color Temp SW 5600K 使用 5600K 预设值调整白平衡。 设置被保留

Color Temp SW 6300K 使用 6300K 预设值调整白平衡。 设置被保留

Electrical CC 使用白平衡调整值切换电子的色彩纠正滤镜 （3200K/
4300K/5600K/6300K）。

按每次按下开关 / 键的顺序排序：
3200Kt4300t 5600Kt6300K

可使用菜单设置进行更改 (Electrical 
CC<A><B><C><D>)。

注意

此功能在设置菜单中的 “Maintenance > White Filter > ND 
Filter C.Temp”被设置为 On 时不可用。
如果您在指定该功能后将 “ND Filter C.Temp”设置为
On，可指定开关将停止作用。

设置被保留

CC5600K 将 5600K 电子 CC 滤镜用于白平衡调整值。 设置被保留

Clip Continuous Rec 打开 / 关闭剪辑连续记录模式。 设置不保留

Slot Select 当卡插槽 A 和 B 内都装有记录介质时，选择您要使用

的卡。

—

Digital Extender × 2 打开或关闭屏幕放大功能 ( × 2)。 设置不保留

Digital Extender × 3 打开或关闭屏幕放大功能 ( × 3)。 设置不保留

Digital Extender × 4 打开或关闭屏幕放大功能 ( × 4)。 设置不保留

可指定开关设置 功能 下一次打开摄像机电

源的状态
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Digital Extender

× 2 × 3 × 4
切换屏幕放大功能的放大状态。

每按一次此开关或键，都会按 Offt × 2t × 3t

× 4tOff 顺序显示。

设置不保留

可指定开关设置 功能 下一次打开摄像机电

源的状态

可以指定给镜头上的 RET 键的功能

可指定开关设置 功能 下一次打开摄像机电

源的状态

Off 不指定 —

Lens RET 显示返回视频信号。

当未连接摄像机扩展单元时：Rec Review （如果允许

播放）

—

Return Video 显示返回视频信号。 —

Rec Review 进行记录预览。 —

Shot Mark1 写入拍摄标记 1。 —

Shot Mark2 写入拍摄标记 2。 —

Clip Flag OK 在记录或播放的剪辑上添加 / 清除 OK 标记。 设置不保留

Clip Flag NG 在记录或播放的剪辑上添加 / 清除 NG 标记。 设置不保留

Clip Flag Keep 在记录或播放的剪辑上添加 / 清除 KP （保持）标记。 设置不保留

OK Mark 添加或删除 OK 标记。 —

Focus Magnifier 打开或关闭焦距放大功能。 设置不保留

Digital Extender × 2 打开或关闭屏幕放大功能 ( × 2)。 设置不保留

Digital Extender × 3 打开或关闭屏幕放大功能 ( × 3)。 设置不保留

Digital Extender × 4 打开或关闭屏幕放大功能 ( × 4)。 设置不保留

Digital Extender

× 2 × 3 × 4
切换屏幕放大功能的放大状态。

每按一次此开关或键，都会按 Offt × 2t × 3t

× 4tOff 顺序显示。

设置不保留
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您可以将设置菜单的设置保存在本摄像机的

内存和 SD 卡中。 您可以通过这些设置文件

迅速将摄像机调整为合适的状态。

设置数据按照下列类别保存。

用户文件：用户文件存储了自定义 “User”
菜单的设置项目和数据。 一张 SD 卡上最

多可保存 64 个文件。 将此文件加载到摄

像机内存，即可自定义 “User”菜单的

设置。

User Menu Item 文件：用户菜单项目文件可

保存“User”菜单中的项目。 一张 SD 卡

上最多可保存 64 个文件。

ALL 文件：全文件存储了所有菜单的设置数

据。 一张 SD 卡上最多可保存 64 个文

件。

注意

设备特定数据 （阴影、输出电平以及指定的设

备中需要调整的其它数据）不保存。

场景文件：场景文件保存用来拍摄特定场景

的 “Paint”菜单项目的调节结果。 本摄

像机的内存中最多可保存 5 个文件， SD
卡上最多可保存 64 个文件。

参考文件：参考文件会保存场景文件标准设

置 （当 “File ID”为 “Standard”时）。 
您可以在摄像机的内存中保存一个文件，

在 SD 卡中保存一个文件。

镜头文件：镜头文件存储了用于补偿若干镜

头特性 （例如：眩光、白阴影、白平衡

和中央标记）的设置数据。 本摄像机的

内存中最多可保存 32 个镜头文件， SD
卡上最多可保存 64 个镜头文件。

伽马文件：内存中最多可保存 5 个用户定义

的伽马表数据文件 （User Gamma Data 
File）。

继续前请将一张可写入的 SD 卡 （请参见第
58 页）插入 UTILITY SD 卡插槽中。

1 在设置菜单中选择 “File >User File 
>Save SD Card”。
出现选择用户文件保存目的地的屏幕。

2 转动 MENU 旋钮选择一个目的地，然
后按一下旋钮。
可以使用 “No File”的文件 ID 保存行中

的文件。选择带有指定文件 ID 名称的行

将覆盖所选文件。

文件 ID 自动生成，但您可进行修改。

3 转动 MENU 旋钮，在确认消息屏幕上
选择 [Execute]，然后按一下此旋钮。

更改文件 ID

1 在设置菜单中选择 “File >User File 
>File ID”。
出现编辑 “File ID”的屏幕。

2 选择字符并输入文件 ID。

3 转动 MENU 旋钮选择 [Done]，然后按
一下此旋钮。
文件 ID 即已更新。

第 7章 保存和加载用户设置数据

保存和加载设置 保存或加载用户文件

保存用户文件
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1 在设置菜单中选择 “File >User File 
>Load SD Card”。
出现用户文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并
按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

注意

摄像机将在加载设置数据后自动重启。

继续前请将一张可写入的 SD 卡 （请参见第
58 页）插入 UTILITY SD 卡插槽中。

1 在设置菜单中选择“File > User Menu 
Item > Save SD Card”。
出现选择 User Menu Item 文件保存目的

地的屏幕。

2 转动 MENU 旋钮选择一个目的地，然
后按一下旋钮。
可以使用空的文件 ID 保存行中的文件。

选择带有指定文件 ID 名称的行将覆盖所

选文件。

文件 ID 自动生成，但您可进行修改。

3 转动 MENU 旋钮，在确认消息屏幕上
选择 [Execute]，然后按一下此旋钮。

更改文件 ID

1 在设置菜单中选择“File > User Menu 
Item > File ID”。
出现编辑 “File ID”的屏幕。

2 选择字符并输入文件 ID。

3 转动 MENU 旋钮选择 [Done]，然后按
一下此旋钮。
文件 ID 即已更新。

1 在设置菜单中选择“File > User Menu 
Item > Load SD Card”。
出现 “User Menu Item”文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并
按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

加载用户文件 保存或加载用户菜单项
目文件

保存用户菜单项目文件

加载用户菜单项目文件
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继续前请将一张可写入的 SD 卡 （请参见第
58 页）插入 UTILITY SD 卡插槽中。

1 在设置菜单中选择 “File > All File > 
Save SD Card”。
出现选择全文件保存目的地的屏幕。

2 转动 MENU 旋钮选择一个目的地，然

后按一下旋钮。
可以使用 “No File”的文件 ID 保存行中

的文件。 选择带有指定文件 ID 名称的行

将覆盖所选文件。

文件 ID 自动生成，但您可进行修改。

3 转动 MENU 旋钮，在确认消息屏幕上

选择 [Execute]，然后按一下此旋钮。

如果出现错误消息

在执行保存过程中或者在您选择 [Execute]
时，可能会出现以下错误消息之一。 在这种

情况下，无法保存文件。

注意

未保存参考文件 （保存了场景文件标准设置 （当

“File ID”为 “Standard”时）的文件）。 请使用

“Reference File”菜单保存和加载与参考文件对应

的设置。

更改文件 ID

1 在设置菜单中选择 “File > All File > 
File ID”。
出现编辑 “File ID”的屏幕。

2 选择字符并输入文件 ID。

3 转动 MENU 旋钮选择 [Done]，然后按

一下此旋钮。
文件 ID 即已更新。

1 在设置菜单中选择 “File > All File > 
Load SD Card”。
出现一个全文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并

按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。

注意

• 从 SD 卡中加载文件时，将覆盖本摄像机内存中保

存的数据。

• 当从一台设备到另一台设备加载文件时，如果两

台设备的固件版本不一致，将不会加载目标设备

上不支持的功能的设置值。

• 摄像机将在加载设置数据后自动重启。

如果出现错误消息

在执行加载过程中或者在您选择 [Execute]
时，可能会出现以下错误消息之一。 在这种

情况下，无法加载文件。

在本文档中，用户配置 / 保存的初始设置菜

单的设置称为 “预设值”。

即使在加载了用于设置摄像机的文件并用新

设置覆盖了初始文件后，您仍然可以通过恢

复预设值来重置文件内容。

1 在设置菜单中选择“File >All File >All 
Preset”。
出现一个确认对话框。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

保存或加载所有文件

将设置数据另存为全文件

错误消息 问题 解决方案

NG:Cannot 
Save

未插入任何可

记录介质。

插入可记录介

质。

NG:Media 
Full

介质容量已满。 使用有空闲剩

余空间的储存

卡。

加载设置数据

错误消息 问题 解决方案

NG:No Data • 没有可记录介

质

• 介质上没有指

定文件

插入包含所需文

件的介质。

将所有当前设置恢复为预设值
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1 在设置菜单中选择 “File >All File 
>Store All Preset”。
出现一个确认对话框。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

1 在设置菜单中选择 “File > All File > 
Clear All Preset”。
出现一个确认对话框。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

注意

摄像机将在切换系统频率后自动重启。

场景文件允许您保存下列数据类型。

• 在 “Paint”菜单中设置的值

• 在标准模式或 ECS 模式中设置的快门速度

• 白平衡数据

保存和加载的数据取决于设置菜单中“File 
> Scene File > Scene White Data”的设置。

场景文件可储存在本摄像机内存中或 SD 卡

上。

还可以将场景文件载入本摄像机。

继续前请将一张可写入的 SD 卡 （请参见第
58 页）插入 UTILITY SD 卡插槽中。

在内存中保存场景文件

1 在设置菜单中选择“File > Scene File 
> Store Internal Memory”。
出现场景文件列表屏幕。

若将文件 ID 设置为 “Standard”目的

地，将保存预配置的标准设置。

2 转动 MENU 旋钮选择一个目的地，然

后按一下旋钮。
场景文件被保存在所选目的地，并且覆

盖所有现有文件。

3 转动 MENU 旋钮，在确认消息屏幕上
选择 [Execute]，然后按一下此旋钮。

在 SD 卡上保存场景文件

1 在设置菜单中选择“File > Scene File 
> Save SD Card”。
出现场景文件保存目的地屏幕。

2 转动 MENU 旋钮选择一个目的地，然
后按一下旋钮。
可以使用 “No File”的文件 ID 保存行中

的文件。选择带有指定文件 ID 名称的行

将覆盖所选文件。

文件 ID 自动生成，但您可进行修改。

将所有当前设置保存为预设值

将当前设置和预设值重置为出
厂默认设置

保存或加载场景文件

保存场景文件
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3 转动 MENU 旋钮，在确认消息屏幕上

选择 [Execute]，然后按一下此旋钮。

更改文件 ID

1 在设置菜单中选择“File > Scene File 
> File ID”。
出现编辑 “File ID”的屏幕。

2 选择字符并输入文件 ID。

3 转动 MENU 旋钮选择 [Done]，然后按

一下此旋钮。
文件 ID 即已更新。

从内存中加载场景文件

1 在设置菜单中选择“File > Scene File 
> Recall Internal Memory”。
出现场景文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并
按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

从 SD 卡中加载场景文件

1 在设置菜单中选择“File > Scene File 
> Load SD Card”。
出现场景文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并
按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

参考文件可储存在本摄像机内存中或 SD 卡

上。

如果使用 SD 卡，请在继续前将可写入 SD 卡

（请参见第 58 页）插入到 UTILITY SD 卡插

槽中。

将当前设置保存为预设值

1 在设置菜单中选择 “File >Reference 
File >Store Reference”。
出现一个确认对话框。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

将当前设置作为预设值保存在 SD 卡
上

1 在设置菜单中选择 “File >Reference 
File >Save Reference(SD Card)”。
出现一个确认对话框。

2 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。

更改文件 ID

1 在设置菜单中选择 “File >Reference 
File >File ID”。
出现编辑 “File ID”的屏幕。

2 选择字符并输入文件 ID。

3 转动 MENU 旋钮选择 [Done]，然后按
一下此旋钮。
文件 ID 即已更新。

加载场景文件

保存和加载参考文件

保存参考文件
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1 在设置菜单中选择 “File >Reference 
File >Load Reference(SD Card)”。
出现一个确认对话框。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

1 在设置菜单中选择 “File >Reference 
File >Clear Reference”。
出现一个确认对话框。

2 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

继续前请将一张可写入的 SD 卡 （请参见第
58 页）插入 UTILITY SD 卡插槽中。

使用设置菜单中的 “File >Lens File”设置镜

头文件中的数据。

您可以设置下列数据并将其保存为镜头文

件。

在内存中保存镜头文件

1 在设置菜单中选择“File > Lens File > 
Store Internal Memory”。
出现镜头文件列表屏幕。

2 转动 MENU 旋钮选择一个目的地，然
后按一下旋钮。
可以使用 “No offset”的文件 ID 保存行

中的文件。选择带有指定文件 ID 名称的

行将覆盖所选文件。

文件 ID 自动生成，但您可进行修改。

3 转动 MENU 旋钮，在确认消息屏幕上

选择 [Execute]，然后按一下此旋钮。

从 SD 卡加载参考文件

将当前设置和预设值重置为出
厂默认设置

保存或加载镜头文件

设置镜头文件数据

设置数据 子项目

视频调制阴影校正值 M V Modulation

中央标记位置 Lens Center H
Lens Center V

闪光电平 R Flare
G Flare
B Flare

白平衡校正值 White Offset R
White Offset B

白色阴影校正值 Shading Ch Select
Shading H SAW
Shading H PARA
Shading V SAW
Shading V PARA

保存镜头文件
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在 SD 卡上保存镜头文件

1 在设置菜单中选择“File > Lens File > 
Save SD Card”。
出现镜头文件保存目的地屏幕。

2 转动 MENU 旋钮选择一个目的地，然

后按一下旋钮。
可以使用 “No File”的文件 ID 保存行中

的文件。选择带有指定文件 ID 名称的行

将覆盖所选文件。

文件 ID 自动生成，但您可进行修改。

3 转动 MENU 旋钮，在确认消息屏幕上

选择 [Execute]，然后按一下此旋钮。

更改文件 ID

1 在设置菜单中选择“File > Lens File > 
File ID”。
出现编辑 “File ID”的屏幕。

2 选择字符并输入文件 ID。

3 转动 MENU 旋钮选择 [Done]，然后按

一下此旋钮。
文件 ID 即已更新。

从内存中加载镜头文件

1 在设置菜单中选择“File > Lens File > 
Recall Internal Memory”。
出现镜头文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并
按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

从 SD 卡中加载镜头文件

1 在设置菜单中选择“File > Lens File > 
Load SD Card”。
出现镜头文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并

按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。

当您正在使用支持串行通讯的镜头时，可以

通过自动加载与该镜头设置相关的镜头文件

来设置摄像机 （自动加载镜头文件功能）。

要使用自动加载镜头文件功能，请将设置菜

单中的 “File > Lens File > Lens Auto Recall”
设置为下列选项之一。

Off：不使用自动加载镜头文件功能。

On （Lens Name）：加载与镜头型号名对应

的镜头文件。

On （Serial Number）：加载与镜头型号名称

和序列号对应的镜头文件 （当本镜头支

持该序列号的通讯时）。

如果本镜头不支持该系列号的通讯，则即使

设置为 “On (Serial Number)”，仍然加载与

镜头型号名对应的镜头文件。
加载镜头文件

自动加载镜头文件
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1 在设置菜单中选择 “File > User 
Gamma > Current Settings”。
出现当前已配置的用户伽马文件列表。

1 在设置菜单中选择 “File > User 
Gamma > Load SD Card”。
出现用户伽马文件列表屏幕。

2 转动 MENU 旋钮选择要加载的文件并

按一下 MENU 旋钮。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后

按一下此旋钮。

使用通过 CvpFileEditorTM V4.3 创
建的用户伽马文件

在 SD 卡的 “PRIVATE/SONY/PRO/
CAMERA/HD_CAM”目录中保存创建的用

户伽马文件。

1 在设置菜单中选择 “File > User 
Gamma > Reset”。
出现伽马文件编号重置屏幕。

2 转动 MENU 旋钮选择要重置的伽马文

件编号 （1 至 5）。
要重置所有伽马文件，选择 [All]。
出现一个确认对话框。

3 转动 MENU 旋钮选择 [Execute]，然后
按一下此旋钮。

保存或加载伽马文件

检查当前伽马文件设置 （文件
名）

从 SD 卡加载用户伽马文件

将用户伽马文件重置为初始状
态
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可连接控制设备如 RM-B150/B170/B750 远程控制单元或 RCP-1001/1501 远程控制面板并操作该

摄像机。有关远程控制设备的连接和操作的详情，请参见 “通过 REMOTE 接口操作”（第 71
页）。

选择输出信号并使用适合连接该监视器的电缆。

无论信号是 HD 还是 SD，外部监视器上显示

的状态信息和菜单与取景器屏幕中显示的相

同。

注意

当设置菜单中的“Operation > Input/Output > Output 
Format”设为 “720 × 486i”或 “720 × 576i”
时， SD 信号下变换输出将启用。

第 8章 连接外部设备

连接外部监视器

BNC 电缆 （不附带）

BNC 电缆
（未随附）
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SDI OUT 接口 (BNC)
SDI OUT 接口可用于连接支持 SDI 的设备。 
设备类型可以是监视器、切换器或者是 VTR 
或其它记录设备。

您可以使用设置菜单中的“Operation > Input/
Output > SDI Out1 Output/SDI Out2 Output”来

打开或关闭此接口的输出 （请参见第 102
页）。

请使用 BNC 电缆 （不附带）连接。

VIDEO OUT 接口

VIDEO OUT 接口可用于连接支持模拟复合信

号的设备。 设备类型可以是监视器或者是 
VTR 或其它记录设备。

输出信号与设置菜单中的“Operation > Input/
Output > Output Format”的设置关联。

要将 VIDEO OUT 接口输出的信号输入到外

部模拟复合设备，可能需要将外部设备的输

入信号设置更改为与 VIDEO OUT 接口的模

拟复合信号设置相匹配。

要将摄像机输出的音频输入到外部设备 （例

如，监视器、 VTR 或其它记录设备），请将

AUDIO OUT 接口的音频输出连接到外部设

备的音频输入。

请使用 BNC 电缆 （不附带）连接。

HDMI OUT 接口 （A 型接口）

您可以使用设置菜单中的 “Operation >Input/
Output >HDMI Output”来打开 / 关闭本摄像

机的输出信号。

使用设置菜单中的“Operation > Input/Output 
> Output Format”设置输出信号格式。

使用市面有售的 HDMI 电缆进行连接。

对本摄像机记录在 SxS 存储卡上的剪辑，可

以通过计算机进行管理，或用选购的非线性

编辑软件进行编辑。

要达到这些目的，可以通过将 SxS 存储卡直

接插到电脑上或者通过使用 USB 电缆将选购

的 SBAC-US30 SxS 存储卡 USB 读写器连接

到电脑，来操作卡上的剪辑。

如果电脑配备有 ExpressCard/34 或

ExpressCard/54，您可以直接插入包含用此摄

像机记录的剪辑的 SxS 存储卡并存取文件。

注意

• 必须将SxS设备驱动程序软件下载并安装到您的计

算机上。 有关下载软件的详情，请参见 “软件下
载”（第 10 页）。

• 不能保证在所有计算机上都能正常工作。

有关驱动程序上的支持信息，请访问以下 URL：

http://www.sony.net/SxS-Support/

在 Windows 中

查看 “我的电脑”中是否出现 “可移动硬

盘”。 这表示正常状态。

在 Macintosh 中

菜单条上显示一个图标。

用电脑管理 / 编辑剪辑

要使用电脑的 ExpressCard 插

槽

SxS PRO   8
GB

插入 ExpressCard
插槽。

SxS 存储卡
安装有 SxS Device 
Driver Software 的
电脑。
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取出 SxS 存储卡

在 Windows 中

1 单击电脑任务条上的 “Safely 
Remove Hardware”图标。

2 选择显示菜单中的 “Safely remove 
SxS Memory Card - Drive(X:)”。

3 出现 “Safe To Remove Hardware”
消息后取出存储卡。

在 Macintosh 中

将桌面上的 SxS 存储卡图标拖动到 Trash 中。

如果 SxS 存储卡图标在 Finder 上，单击弹出

图标。

准备工作

当您使用 USB 电缆 （不附带）将摄像机连

接至电脑时，电脑会将插槽中的存储卡识别

为扩展驱动器。

当摄像机中装有两张存储卡时，电脑会将它

们识别为两个独立的扩展驱动器。

注意

• 打开摄像机并等待至屏幕上显示图像和信息，然

后将 USB 电缆连接到摄像机。

• 将 USB 电缆连接到电脑时，请仔细检查 USB 接口

的形状和方向。

• 本摄像机无法通过电脑的总线供电。

开始 USB 连接

当您用 USB 电缆 （不附带）将电脑连接到

PC 接口时，显示 “Connect USB Now?”消

息，提示您确认您想要启动 USB 连接。

如果您选择 “Cancel”或向下推 MENU 
CANCEL/PRST/ESCAPE 至 ESCAPE 位置，

或者如果断开 USB 电缆，则 “Connect USB 
Now?”消息消失。

如果您选择 “Execute”并按一下 MENU 旋

钮， USB 连接被启用且摄像机被识别为扩展

驱动器。

如果在记录 / 播放过程中启用 USB 连接，操

作被停止且消息 “USB Connecting”将出现

在取景器屏幕上。

此时，从 VIDEO OUT 接口和 SDI OUT 1/2
接口输出的信号变为黑色信号。

注意

• 当显示 “USB Connecting”时，摄像机无法进行

记录、播放等操作。

• 当电脑存取装在摄像机中的存储卡时，不要试图

执行下列操作。

- 操作本摄像机 （打开 / 关闭电源、切换操作模

式等）

- 从处于激活状态的插槽 （电脑正在访问）中取

出或插入存储卡

- 断开或连接 USB 电缆

停用 USB 连接

要停用 USB 连接，按照与从电脑上移除设备

相同的步骤操作。

要再次启用 USB 连接，请先断开 USB 电缆，

然后重新连接。 消息 “Connect USB Now?”
再次出现。

取出 SxS 存储卡

在 Windows 中

1 单击电脑任务条上的 “Safely 
Remove Hardware”图标。

2 选择显示菜单中的 “Safely remove 
SxS Memory Card - Drive(X:)”。

3 出现 “Safe To Remove Hardware”
消息后取出存储卡。

在 Macintosh 中

将桌面上的 SxS 存储卡图标拖动到 Trash 中。

如果 SxS 存储卡图标在 Finder 上，单击弹出

图标。

与电脑进行 USB 连接

USB 电缆
（未随附）
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使用应用软件

若要将剪辑复制到计算机的本地硬盘，必须

下载专用应用程序软件并安装到计算机上。 
有关下载软件的详情，请参见 “软件下载”
（第 10 页）。

虽然记录素材的相关数据存储在多个文件和

文件夹中，使用专用应用程序软件可方便地

对剪辑进行处理，而无需考虑数据和目录结

构。

注意

如果您使用 Explorer （Windows）或 Finder
（Macintosh）操作 （例如，复制 SxS 存储卡上的剪

辑），剪辑包含的附属数据可能不被保留。

使用非线性编辑系统

在非线性编辑系统中，需要用到支持本摄像

机记录格式的编辑软件 （选件）。

使用附带的应用软件预先将要编辑的剪辑保

存到电脑的 HDD 上。

某些编辑软件可能无法正常工作。 务必在使

用之前确认该软件与本摄像机使用的记录格

式是否相符。
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您可以将 CA-FB70/TX70 高清摄像机适配器安装到摄像机并连接摄像机控制单元 (CCU)。
这样，您可配置由多台带摄像机扩展单元的摄像机组成并连接远程控制单元的拍摄和记录系统。

有关 CA-FB70 和 CA-TX70 的更多信息，请参见其相应的操作手册。

注意

• 该系统使用摄像机时，不要将视频灯连接到摄像机上。

• 仅支持 XAVC 和 MPEG HD 记录。

• 不支持代理记录和无线 LAN 连接功能。

按照如下方式配置系统的 tally 和 call 指示灯。

配置拍摄和记录系统

Tally 和 Call 指示灯

接收自系统的数据 HDVF LED 指示灯 取景器屏幕上的文本显示

Tally Green 
Tally

CA 调

用

非 CA
调用

REC/
TALLY 
LED

GREEN 
TALLY 
LED

“z”（红色）

指示灯

“z”（绿色）

指示灯

“CALL”指

示灯

OFF OFF OFF OFF 不亮 不亮 不显示 不显示 不显示

OFF OFF OFF ON On 不亮 “z”（红色） 不显示 “CALL”
（红色）

OFF OFF ON OFF 不亮 不亮 不显示 不显示 “CALL”
（红色）

OFF OFF ON ON On 不亮 “z”（红色） 不显示 “CALL”
（红色）

OFF ON OFF OFF 不亮 On 不显示 “z”（绿色） 不显示

OFF ON OFF ON On On “z”（红色）“z”（绿色）“CALL”
（红色）

OFF ON ON OFF 不亮 On 不显示 “z”（绿色）“CALL”
（红色）

OFF ON ON ON On On “z”（红色）“z”（绿色）“CALL”
（红色）

ON OFF OFF OFF On 不亮 “z”（红色） 不显示 不显示

ON OFF OFF ON 不亮 不亮 不显示 不显示 “CALL”
（红色）

ON OFF ON OFF On 不亮 “z”（红色） 不显示 “CALL”
（红色）

ON OFF ON ON 不亮 不亮 不显示 不显示 “CALL”
（红色）

ON ON OFF OFF On On “z”（红色）“z”（绿色） 不显示

ON ON OFF ON 不亮 On 不显示 “z”（绿色）“CALL”
（红色）

ON ON ON OFF On On “z”（红色）“z”（绿色）“CALL”
（红色）

ON ON ON ON 不亮 On 不显示 “z”（绿色）“CALL”
（红色）
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注意

连接 CA-FB70/TX70 摄像机适配器时，警告显示中使用 tally 指示灯的警报指示并不会显示。

拍摄 / 记录系统支持的格式和限制

由下表中显示的摄像机、摄像机适配器以及摄像机控制单元组成的拍摄 / 记录系统支持的格式和

操作限制。

操作菜单 摄像机适配器 / 摄像机控

制单元的系统格式

摄像机限制

Format Input/Output 返回视频显

示Frequency Rec Format Output Format

SDI

59.94 XAVC-L 50 1080P 1920 × 1080i 1920 × 1080 59.94i No

XAVC-L 35 1080P

XAVC-I 1080i 1920 × 1080i 1920 × 1080 59.94i Yes

XAVC-L 50 1080i

XAVC-L 35 1080i

XAVC-L 25 1080i

HD422 50 1080i

HQ 1920 × 1080i

HQ 1440 × 1080i
XAVC-I 720P 1280 × 720P 1280 × 720 59.94P Yes

XAVC-L 50 720P

HD422 50 720P

HQ 1280 × 720P
29.97 XAVC-I 1080P 1920 × 1080PsF 1920 × 1080 29.97PsF a)

1920 × 1080 59.94i

Yes

XAVC-L 50 1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920 × 1080P
HD422 50 720P 1280 × 720P 1280 × 720 59.94P No

23.98 XAVC-I 1080P 1920 × 1080i
(2-3PD)

1920 × 1080 59.94i No

XAVC-L 50 1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920 × 1080P
HD422 50 720P 1280 × 720P

(2-3PD)
1280 × 720 59.94P No
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a) 连接CA-TX70摄像机适配器时，建议使用PsF设置。

注意

在拍摄 / 记录系统中，不能同时使用特殊记录功能，例如无线 LAN 连接功能或慢 & 快动作功

能。

50 XAVC-L 50 1080P 1920 × 1080i 1920 × 1080 50i No

XAVC-L 35 1080P

XAVC-I 1080i 1920 × 1080i 1920 × 1080 50i Yes

XAVC-L 50 1080i

XAVC-L 35 1080i

XAVC-L 25 1080i

HD422 50 1080i

HQ 1920 × 1080i

HQ 1440 × 1080i
XAVC-I 720P 1280 × 720P 1280 × 720 50P Yes

XAVC-L 50 720P

HD422 50 720P

HQ 1280 × 720P
25 XAVC-I 1080P 1920 × 1080PsF 1920 × 1080 25PsF a)

1920 × 1080 50i

Yes

XAVC-L 50 1080P

XAVC-L 35 1080P

HD422 50 1080P

HQ 1920 × 1080P
HD422 50 720P 1280 × 720P 1280 × 720 50P No

操作菜单 摄像机适配器 / 摄像机控

制单元的系统格式

摄像机限制

Format Input/Output 返回视频显

示Frequency Rec Format Output Format

SDI
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您可以记录连接到摄像机 SDI IN 接口的设备

中的 SDI 信号。

要输入并记录输入信号而不是摄像机图像，

请将设置菜单中的“Operation > Input/Output 
> Source Select”设为 [External]。
有关输入 SDI 信号支持的记录格式，请参见

（请参见第 153 页）。

注意

• 在 “Slow & Quick Motion”模式下无法记录外部

输入信号。 选择 “Slow & Quick Motion”模式

后，如果将设置菜单中的 “Operation > Input/
Output > Source Select”设为 [External]，记录模式

将取消。

• 当设置菜单中的 “Operation > Input/Output > 
Source Select”设为 [External] 时，执行自动调整

功能，如自动黑平衡以及播放、记录预览等操

作，且缩略图显示结束。 摄像机进入停止模式，

然后摄像机图像切换为外部输入。

• 如果在记录外部输入时输入信号受到干扰，可能

会停止记录。 输入信号恢复正常后，将自动恢复

记录。

• 不支持代理记录和无线 LAN 连接功能。

记录外部输入信号
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支持的外部输入信号格式和摄像机记录格式

HD/SD 设置菜单中的 “Operation 
> Format > Rec Format”

设置菜单中的 “Operation 
> Format > Frequency”

支持的外部输入信号格式

HD XAVC-I 1080i 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

XAVC-I 720P 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

XAVC-L 50 1080i 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

XAVC-L 50 720P 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

HD422 50 1080i 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

HD422 50 720P 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

HQ 1920 × 1080i 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

HQ 1440 × 1080i 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

HQ 1280 × 720P 59.94 HD 1920 × 1080 29.97PsF/59.94i
HD 1280 × 720 59.94P

50 HD 1920 × 1080 25PsF/50i
HD 1280 × 720 50P

SD MPEG IMX 50 59.94 SD 486 59.94i

50 SD 576 50i

DVCAM 59.94 SD 486 59.94i

50 SD 576 50i
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准备拍摄之前，请先检查摄像机的功能。 此
时，请记录和播放视频和音频信号。

用吹灰器清洁取景器镜筒内的 CRT 屏幕和反

射镜。

用市场上出售的镜头清洁剂清洁镜头和防护

滤镜。

注意

不要使用稀释剂等有机溶剂。

清洁时要取下接目镜 （例如：HDVF-
20A）

1 将接目镜与取景器镜筒分离。

有关分离步骤的详情，请参见 “分离接目
镜”（第 29 页）。

2 从取景接目罩支架上取下取景接目罩。

3 从取景接目罩支架中取出防护滤镜和

垫圈。

第 9章 维护

测试摄像机 维护

清洁取景器

1取景器镜筒
2取景接目罩支架
3防护滤镜
4垫圈
5取景接目罩
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4 将防护滤镜与垫圈分离。

防雾滤镜

由于温度和湿度的影响，防护滤镜可能会因

水蒸气或呼吸而出现雾气。 为了确保取景器

始终清晰，请用防雾滤镜 （维修部件号 1-
547-341-11）更换防护滤镜。

安装防雾滤镜

用防雾滤镜更换垫圈上的防护滤镜。

请务必正确安装防雾滤镜、垫圈和取景接目

罩，以使安装后的接目镜可以防水。

注意

清洁防雾滤镜时，请用软布轻轻擦拭，以防损坏防

雾膜。

本机的电池端子 （电池组和交流适配器的接

头）是一个可消耗部件。

如果电池端子的引脚因震动或晃动而弯曲或

变形，或者由于长时间在户外使用而腐蚀，

则可能无法向本机正常供电。

建议您进行定期检查以使本机正常运行并延

长其使用寿命。

有关检查的详细信息，请联系 Sony 服务或销售
代理商。

关于电池端子的注意事项
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本摄像机上若发生警告、注意事项或需要确认的操作情况，取景器中将显示一条消息，相应的

指示灯将开始闪烁，并发出声音警告。

您可以使用 ALARM 旋钮调整声音警告的音量。 若将 ALARM 旋钮调到最小，则不会发出声音

警告。

出现以下显示时，本摄像机将停止运行。

出现以下显示时，请按照所提供的说明进行操作。

错误 / 警告系统

错误显示

错误消息 警告音 WARNING
指示灯

讯号 /REC
指示灯

原因与解决方案

E + 错误代码 连续 – 高速闪烁 表示摄像机中发生异常情况。

关闭摄像机，检查已连接设备、电缆或

介质是否有任何问题。

（若将 POWER 开关调到 OFF 时无法关

闭摄像机，请取出电池或断开直流电

源。）

再次打开摄像机时，若错误依然存在，

请联系 Sony 服务代理商。

警告显示

警告消息 警告音 WARNING
指示灯

讯号 /REC
指示灯

原因与解决方案

Media Near Full 间歇性 闪烁 闪烁 SxS 存储卡上的剩余容量偏低。

请尽早更换。

Media Full 连续 亮起 高速闪烁 SxS 存储卡上无剩余容量，无法记录、

复制或分割剪辑。

请立即更换。

Battery Near End 间歇性 闪烁 闪烁 电池的剩余电量偏低。

请尽早充电。

（电池指示灯在取景器中闪烁。）

Battery End 连续 亮起 高速闪烁 电池电量耗尽。

无法进行记录。

将电源连接到 DC IN 并停止操作摄像机

以便为电池充电。

（电池指示灯在取景器中闪烁。）

Temperature High 间歇性 闪烁 闪烁 内部温度过高。

关闭摄像机，待其冷却后再进行操作。

Voltage Low 间歇性 闪烁 闪烁 DC IN 电压过低 （1 级）。

请检查电源。

Insufficient Volage 连续 亮起 高速闪烁 DC IN 电压过低 （2 级）。

无法进行记录。

请连接其他电源。

（电池指示灯在取景器中闪烁。）
156



以下注意和操作消息可能会出现在屏幕中间。 请按照所提供的说明解决问题。

1)插槽 B 中的存储卡显示为 “(B)”。

注意和操作确认显示

显示屏指示 原因与解决方案

Battery Error
Please Change Battery

检测到电池错误。

请使用正常的电池进行更换。

Backup Battery End
Please Change

备用电池剩余电量不足。

请更换备用电池。

Unknown Media(A) 1)

Please Change
所插入的存储卡已分区或所插入的存储卡包含的剪辑超出了本摄

像机的处理能力。

无法在本摄像机中使用该卡，必须进行更换。

Media Error
Media(A) 1) Needs to be Restored

存储卡上发生错误，必须进行恢复。

弹出存储卡并重新插入，然后对卡进行修复。

Media Error
Cannot Record to Media(A) 1)

存储卡可能已损坏，无法继续用来记录。

可进行播放，建议创建副本并更换存储卡。

Media Error
Cannot Use Media(A) 1)

存储卡可能已损坏，无法继续用来记录或播放。

无法在本摄像机中使用该卡，必须进行更换。

Will Switch Slots Soon 本摄像机即将切换存储卡插槽。

请检查两个插槽中是否都有存储卡。

Cannot Use Media(A) 1)

Unsupported File System
插入了使用不同文件系统的卡或未格式化的卡。

无法在本摄像机中使用该卡，必须进行更换或使用摄像机进行格

式化。

Media(A) 1) Error
Playback Halted

从存储卡中读取时发生错误，无法继续播放。

若该问题持续存在，请创建副本并更换存储卡。

Media(A) 1) Error 存储卡上发生错误，已停止记录。

若该问题持续存在，请更换存储卡。

Different Media is Inserted
Cannot Use Media(A) 1)

插入了不同的介质。 弹出已插入的卡，然后插入和之前插入的卡

相同类型的卡。
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风扇和电池是需要定期更换的消耗性部件。

如果在室温环境下操作，正常的更换周期约

为 5 年。但是，这一更换周期仅代表一般原

则，不表示这些部件的寿命保证可以达到预

期寿命长度。关于部件更换的详细信息，请

联系经销商。

正常操作温度和使用条件下 （每天 8 小时；

每月 25 天），交流适配器和电解质电容器的

预计使用寿命约为 5 年。如果超过上述正常

使用频率，则预计使用寿命可能会相应减

少。

使用和存放

避免摄像机受到剧烈震动

• 否则可能会损坏内部机械装置或者使主体

结构弯曲变形。

• 如果安装在附件定位靴上的附件受到剧烈

冲击，则可能损坏附件定位靴。 若发生这种

情况，请停止使用并联系您的经销商或

Sony 服务代表。

操作过程中不要盖住摄像机

例如，用布盖住摄像机将导致内部热量积累

过多。

使用后

一定要关闭 POWER 开关。

在长时间放置摄像机之前

取下电池。

运输

• 运输摄像机时请取出介质。

• 如果要通过卡车、轮船、飞机或其他交通

工具运输摄像机，请将摄像机放在装运纸

箱中运送。

注意保护摄像机

用吹灰器清洁镜头或滤光镜表面的灰尘。

如果摄像机变脏，请用柔软的干布清洁。 在
特殊情况下，使用浸有少量中性洗涤剂的抹

布擦拭，然后用干布擦干。 不要使用酒精或

稀释剂等有机溶剂，否则可能导致摄像机的

涂层变色或其他损坏。

发生操作问题时

如果您有任何有关摄像机的问题，请联系

Sony 服务代表。

使用和存放地点

请存放在平坦、通风的环境中。

避免在以下环境中使用或存放摄像机。

• 过热或过冷环境 （操作温度范围：–5 ℃至

+40 ℃）

请注意，在夏天或温暖的环境下，车窗关

闭的汽车内的温度很容易超过 50 ℃。

• 潮湿或灰尘较多的地方

• 摄像机可能会暴露在雨水中的地方

• 暴露在剧烈震动的地方

• 强磁场附近

• 靠近会产生较强电磁场的无线电或电视发

射器的地方

• 长时间受到阳光直射或者靠近加热器

防止受到便携式通信设备的电磁干扰

在摄像机附近使用手机和其它通信设备时会

使其产生误操作，并会干扰本机的音频和视

频信号。

建议您关闭摄像机附近的便携式通信设备的

电源。

凝结

如果将设备突然从寒冷的地方带到温暖的场

所，或者室温突然升高，设备的外表面和内

部可能会形成水汽。这称为冷凝。如果发生

冷凝，请关闭设备电源，待到冷凝消失后才

能操作设备。冷凝仍然存在时使用设备可能

会导致设备损坏。

安装变焦镜头

正确地安装镜头很重要，否则可能导致损

坏。 请务必参见 “安装后调整镜头”（第 31
页）部分。

附录

使用注意事项
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取景器

不要将摄像机的目镜镜头直接对着太阳。

目镜镜头可以集中太阳光并融化取景器的内

部。

关于 LCD 面板

此监视器所用 LCD 面板是采用高精密技术生

产的，有效像素率达至少达到 99.99%。因此

有很少一部分像素可能会表现为 “亮点”，

或者始终是暗点 （黑色）、变亮 （红色、绿

色或蓝色）或者呈现闪烁状。此外，经过长

时间的使用后，由于液晶显示本身的物理特

性，也可能会出现这种 “亮点”。这些问题

并非故障。请注意，任何此类问题都不会影

响记录的数据。

影像传感器特有的现象

注意

影像中可能会出现以下影像传感器特有的现象。它

们并非故障。

白斑

虽然图像传感器是采用高精度技术生产的，

但由于宇宙射线等的影响，其屏幕上可能会

出现细小的白斑 （极少数情况）。

这与图像传感器的原理有关，出现的白斑并

不是故障。

在以下情况中，比较容易出现白斑：

• 在高温环境下进行操作时

• 提高倍率 （灵敏度）时

• 当使用慢快门时

垂直拖影

拍摄亮度极高的物体 （如强聚光灯或闪光

灯）时，屏幕上可能出现垂直尾线，图像也

可能出现扭曲。

图形失真

拍摄微小的图案、条纹或线条时，它们可能

呈锯齿状或出现闪烁现象。

分裂

如果图像不能正常记录 / 再现，尝试格式化

记录介质。

长时间利用某个记录媒体重复记录 / 播放图

像时，媒体中的文件可能分裂，无法进行正

常记录 / 储存。在这种情况下，为媒体中的

剪辑制作备份，然后用设置菜单的

“Operation > Format Media”（请参见第 102
页）进行格式化。

监视器屏幕
图像上的垂直拖尾显示

高亮物体 （如强聚光灯、
强反射光、闪光灯、阳光）
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摄像机的内部时钟通过锂电池供电。 如果取

景器中出现 “BackUp Battery End”消息，必

须更换电池。 请联系 Sony 服务代表。
重量 约3.8 kg(仅机身)
尺寸 (单位：mm，不含突出部分，

仅机身)1)

1)尺寸值为近似值。

电源要求 12 V直流（11 V到17.0 V）

功耗 约35 W （仅机身，以XAVC
格式记录且LCD监视器打

开时）

约37 W （CBK-VF02取景

器、手动镜头、麦克风，

以XAVC格式记录且LCD
监视器打开时）

注意

• 请勿连接功耗为 50 W 或更高的视频
灯。

• 使用电池时，请勿让连接的外围设备
的总功耗超过 40 W。

• 使用 AC-DN10 时，请勿让连接的外围
设备的总功耗超过 50 W。

• 使用 AC-DN2B 时，请勿让连接的外围
设备的总功耗超过 85 W。

更换内部时钟的电池 规格说明

一般规格

332

26
9

15
0 
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• DC OUT 接口仅能连接电流消耗不超过
1.8 A 的设备。

操作温度 –5 ℃至+40 ℃

储存温度 –20 ℃至+60 ℃

文件系统 exFAT
连续工作时间

约130分钟(使用BP-L80S时)
记录格式 （视频）

SR SStP
MPEG-4 Simple Studio 

Profile、 SR-Lite 422
Apple ProRes （使用PXWK-

501选件时）

ProRes 422 HQ、
ProRes 422

Avid DNxHD®（使用

PXWK-502选件时）

DNxHD 220x （10位
4:2:2）、 DNxHD 145
（8位4:2:2）

XAVC Intra

XAVC-I模式：CBG、

112 Mbps （最大值）、
MPEG-4 AVC/H.264

XAVC Long

XAVC-L 50模式：VBR、
50 Mbps （最大值）、
MPEG-4 AVC/H.264

XAVC-L 35模式：VBR、
35 Mbps （最大值）、
MPEG-4 AVC/H.264

XAVC-L 25模式：VBR、
25 Mbps （最大值）、
MPEG-4 AVC/H.264

MPEG-2 Long GOP

MPEG HD422模式：

CBR、50 Mbps、MPEG-2 
422P@HL

MPEG HD420 HQ模式：

VBR、 35 Mbps （最大

值）、 MPEG-2 MP@HL
MPEG IMX

CBR、 50 Mbps

DVCAM

CBR、 25 Mbps
Proxy

AVC/H.264 Main Profile 
4:2:0 Long GOP

1280 × 720/9 Mbps、
640 × 360/3 Mbps、
480 × 270/1 Mbps、 
500 Kbps (VBR)

记录格式（音频）
SR SStP

LPCM 24位、 48 kHz、
4通道

Apple ProRes （使用PXWK-
501选件时）

LPCM 24位、 48 kHz、 
4通道

Avid DNxHD®（使用

PXWK-502选件时）

LPCM 24位、 48 kHz、 
4通道

XAVC Intra

LPCM 24位、 48 kHz、
4通道

XAVC Long

LPCM 24位、 48 kHz、
4通道

MPEG-2 Long GOP

MPEG HD422模式：

LPCM 24位、 48 kHz、
4通道

MPEG HD420 HQ模式：

LPCM 16位、 48 kHz、
4通道

MPEG IMX

LPCM 16/24位、 48 kHz、
4通道

DVCAM

LPCM 16位、 48 kHz、
2通道

Proxy

AAC-LC、 128 kbps、 2通
道
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记录/播放时间
SStP SR-Lite 422

59.94i/29.97P

约65分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约30分钟：使用SBP-64C/
SBS-64G1B (64 GB)

50i/25P/23.98P

约75分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约35分钟：使用SBP-64C/
SBS-64G1B (64 GB)

Apple ProRes 422 HQ （使用

PXWK-501选件时）
59.94i/29.97P

约55分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约25分钟：使用SBP-64C/
SBS-64G1B (64 GB)

50i/25P/23.98P

约70分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约35分钟：使用SBP-64C/
SBS-64G1B (64 GB)

Apple ProRes 422 （使用

PXWK-501选件时）
59.94i/29.97P

约85分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约40分钟：使用SBP-64C/
SBS-64G1B (64 GB)

50i/25P/23.98P

约105分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约50分钟：使用SBP-64C/
SBS-64G1B (64 GB)

Avid DNxHD® 220x （使用

PXWK-502选件时）
59.94i/29.97P

约65分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约30分钟：使用SBP-64C/
SBS-64G1B (64 GB)

50i/25P/23.98P

约75分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约35分钟：使用SBP-64C/
SBS-64G1B (64 GB)

Avid DNxHD® 145 （使用

PXWK-502选件时）
59.94i/29.97P

约95分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约45分钟：使用SBP-64C/
SBS-64G1B (64 GB)

50i/25P/23.98P

约115分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约55分钟：使用SBP-64C/
SBS-64G1B (64 GB)

XAVC Intra

XAVC-I模式
59.94i/29.97P

约120分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约60分钟：使用SBP-64C/
SBS-64G1B (64 GB)

约30分钟：使用SBS-
32G1B (32 GB)

50i/25P/23.98P

约140分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约70分钟：使用SBP-64C/
SBS-64G1B (64 GB)
162



约35分钟：使用SBS-
32G1B (32 GB)

XAVC Long

XAVC-L 50模式

约240分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约120分钟：使用SBP-
64C/SBS-64G1B (64 GB)

约60分钟：使用SBS-
32G1B (32 GB)

XAVC-L 35模式

约340分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约170分钟：使用SBP-
64C/SBS-64G1B (64 GB)

约85分钟：使用SBS-
32G1B (32 GB)

XAVC-L 25模式

约440分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约220分钟：使用SBP-
64C/SBS-64G1B (64 GB)

约110分钟：使用SBS-
32G1B (32 GB)

MPEG-2 Long GOP

MPEG HD422模式

约240分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约120分钟：使用SBP-
64C/SBS-64G1B (64 GB)

约60分钟：使用SBS-
32G1B (32 GB)

MPEG HD420 HQ模式

约360分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约180分钟：使用SBP-
64C/SBS-64G1B (64 GB)

约90分钟：使用SBS-
32G1B (32 GB)

MPEG IMX

约240分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约120分钟：使用SBP-
64C/SBS-64G1B (64 GB)

约60分钟：使用SBS-
32G1B (32 GB)

DVCAM

约440分钟：使用SBP-
128C/SBS-128G1B 
(128 GB)

约220分钟：使用SBP-
64C/SBS-64G1B (64 GB)

约110分钟：使用SBS-
32G1B (32 GB)

注意

记录 / 播放时间可能会因使用条件和存
储器特性而不同。

记录帧频
SR SStP

1920 × 1080/59.94i、50i、
29.97P、 23.98P、 25P

Apple ProRes （使用PXWK-
501选件时）

1920 × 1080/59.94i、50i、
29.97P、 23.98P、 25P

Avid DNxHD®（使用

PXWK-502选件时）

1920 × 1080/59.94i、50i、
29.97P、 23.98P、 25P

XAVC Intra

   XAVC-I模式

1920 × 1080/59.94i、50i、
29.97P、 23.98P、 25P
1280 × 720/59.94P、 50P

XAVC Long

   XAVC-L 50模式

1920 × 1080/59.94P、
50P、 59.94i、 50i、
29.97P、 23.98P、 25P
1280 × 720/59.94P、 50P
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   XAVC-L 35模式

1920 × 1080/59.94P、
50P、 59.94i、 50i、
29.97P、 23.98P、 25P

   XAVC-L 25模式

1920 × 1080/59.94i、 50i
MPEG-2 Long GOP

   MPEG HD422模式

1920 × 1080/59.94i、50i、
29.97P、 23.98P、 25P
1280 × 720/59.94P、50P、
29.97P、 23.98P、 25P

   MPEG HD420 HQ模式

1920 × 1080/59.94i、50i、
29.97P、 23.98P、 25P
1440 × 1080/59.94i、 50i
1280 × 720/59.94P、 50P

MPEG IMX

720 × 486/59.94i
720 × 576/50i

DVCAM

720 × 480/59.94i
720 × 576/50i

Proxy

主线1920 × 1080：
29.97P、 25P、 23.98P
主线1280 × 720：
59.94P、 50P、 29.97P、
25P、 23.98P

输入

GENLOCK IN：

BNC型、1.0 Vp-p、75 Ω、不

平衡

TC IN： BNC型、 0.5 V至18 Vp-p、
10 kΩ 

AUDIO IN CH1/CH2：
XLR型、 3芯孔型

可在LINE / AES/EBU / MIC / 
MIC+48V之间切换

LINE：+4、 0、 –3 dBu
AES/EBU：兼容AES3

MIC：–70到–30 dBu
MIC IN： XLR型、 5芯孔型

–70到–30 dBu
WRR: D-sub 15芯

模拟CH1:–40 dBu
数字CH1/CH2：–40 dBFS

SDI IN： 兼容SMPTE 292M/259M标准

4通道音频

输出

VIDEO OUT：
BNC型、可在SD模拟复合信

号/HD-Y之间切换

SDI OUT 1/2：
BNC型、 0.8 Vp-p、不平衡

（可在3G HD/1.5G HD/SD
之间切换）

SMPTE ST424/425 A/B级、

兼容292M/259M标准

4通道音频

AUDIO OUT：
XLR型、 5芯、针型

+4/0/–3 dBu （平衡）

TC OUT：BNC型、 1.0 Vp-p、 75 Ω
EARPHONE （立体声微型插孔）： 

–11 dBu （参考电平输出、最

大监视器音量、 16-Ω负

载）

HDMI: A型、 19芯
其他

DC IN： XLR型， 4芯、针型

11 V至17 V直流

DC OUT：圆头型4芯、 11 V至17 V直

流、 1.8 A最大额定电流

LENS： 12芯、镜头电源 （11 V至17 
V直流、 1.0 A最大额定电

流）

REMOTE：8芯
LIGHT： 2芯
USB： 4芯（A型） (2)、4芯（B型）

VF： 矩型26芯、圆头型 20芯

输入 / 输出部分
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图像传感器

 2/3英寸型、 CCD、 
有效像素：1920 (H) × 
1080 (V)

类型 3芯RGB
光学系统 F1.4棱镜系统

ND滤镜 1：清除

2：1/4ND
3：1/16ND
4：1/64ND

灵敏度 F11 (系统频率：59.94i)
F12 （系统频率：50i）
(2000 lx、 89.9%反射率、

3200K)

最小照度 0.016 lx (F1.4、 +42 dB、
累积16帧）

图像信噪比

 60 dB （噪音抑制打开）

水平分辨率

 1000 TVL （TV线）或更大

调制深度 45%或更高（27.5 MHz、在

屏幕中心）

黑色电平 3 ±1% （设置菜单中的 “黑

度”设为［±0］）
快门速度 59.94i/P、 50i/P：1/60到

1/2000秒
29.97P：1/40到1/2000秒
25P：1/33到1/2000秒
23.94P：1/32到1/2000秒

慢速快门 2到8、 16帧
动态范围 600%

460% （1080/29.97P、 1080/
25P、 1080/23.98P）

拖尾 –135 dB

采样频率 48 kHz
量化 16/24位
动态范围上限

20 dB （工厂预设）（20、
18、 16、 12 dB)、 EBUL

频率响应 20 Hz到20 kHz （±3 dB或更

低)
动态范围 90 dB （典型）

失真 0.08%或更低 （–40 dBu输入

电平）

内置扬声器

单声道、 300 mW输出

LCD监视器

屏幕尺寸

对角线8.8 cm
宽高比例

16:9

像素值

960 (H) × 540 (V)

SxS卡插槽

外形因素：Express Card/34
插槽数量：2
接口：兼容PCMCIA Express 

Card

写入速率：50 Mbps或更快

读取速率：50 Mbps或更快

SD卡插槽

Proxy (1)、 Utility (1)

肩带(1)
冷靴套件(1)
镜头座盖

USB无线LAN模块(IFU-WLM3)
保护盖(2)
防护装置 (1)
OPERATION GUIDE(操作指南) (1)
操作手册(CD-ROM) (1)

摄像机部分

音频部分

显示屏部分

存储卡部分

附件
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选件密钥

PXWK-501/502 （编解码器选件）

PXWK-503 （Slow&Quick选件）

电源和相关设备

交流适配器
AC-DN10/DN2B

电池 BP-L80S
电池充电器

BC-L160/L500/L70

镜头、取景器和相关设备

镜头仅限 2/3英寸型刀环镜头

取景器 HDVF-20A/200/C30WR/
C35W/EL75/L750/L770
CBK-VF02

取景器旋转架
BKW-401

远程控制设备

远程控制设备
RM-B170/B750
RCP-1000/1500/1530
RCP-1001/1501

注意

不支持命令网络单元 (CNU)。

高清摄像机适配器

CA-FB70/TX70

注意

如果在安装了 CA-FB70 时使用
SDIOUT2，请使用 L 形适配器。

介质适配器

MEAD-SD02 （适用于SDXC卡）

XQD ExpressCard 适配器

QDA-EX1 （适用于XQD存储卡）

记录介质

SxS存储卡

SxS PRO+系列

SxS PRO系列

SxS-1系列

音频设备

麦克风 ECM-678/674/673/680S
麦克风支架

CAC-12

无线麦克风
DWR-S02D
WRR-855S/860C/861/862

其它外围设备

三角架安装
VCT-14/U14

视频灯 UC-D200A （Nippon视频系

统- NIPROS）
Ultralight (Anton Bauer)

托 CBK-SP01软式肩托

用于维护和便于使用的产品

硬式携带盒
LC-H300

携带软包 LC-DS300SFT
维护手册

设计与技术规格如有变更恕不另行通
知。

相关设备
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注意

• 在记录前，请始终进行记录测试，并
确认记录是否成功。
SONY 对任何损坏概不负责。由于本
机故障或由记录介质、外部存储系统
或者任何其他介质或储存系统记录的
任何形式的记录内容的损害不作 （包
括但不限于）退货或赔偿。

• 在使用前请始终确认本机运行正常。
无论保修期内外或基于任何理由，
SONY 对任何损坏概不负责。由于本
机故障造成的利润损失等，无论是在
保修期以内或者以外， Sony 均不作
任何赔偿。

• SONY 对本产品用户或第三方的任何
索赔概不负责。

• SONY 对内部存储系统、记录介质、
外部存储系统或任何其他介质或存储
系统上记录的任何数据的丢失、修复
和还原概不负责。

• SONY 对因任何情况导致终止或停止
使用本机相关服务概不负责。
167



外围设备和附件表

a) 携带软包足够大，可容纳装有镜头和麦克风的摄像机。 但是，如果它们凸出主机前端 25 cm
以上，请将其卸下。

ECM-680S/678/
674/673 麦克风

CAC-12 
麦克风支架

HD 监视器 /SD 监视器

XDCAM HD 系列录像机
PDW-F1600/HD1500, PDW-F75

HDW-2000 系列、 HDW-S280
HDCAM 系列录像机

PXW-X500 a)

RM-B170/B750
RCP-1000/1500/1530
RCP-1001/1501
远程控制设备

VCT-14 
三角架安装

三角架

LC-DS300SFT
携带软包 a)

AC-DN10/DN2B 
交流适配器

WRR-855S/862/861 UHF 合成调谐器装置
DWR-S02D 数字无线接收器

BC-L500 
电池充电器

BC-L160 电池
充电器

BC-L70 电池
充电器

BP-L80S 
电池

SxS 存储卡
SBS-32G1B、 SBP-64C/SBS-64G1B、 
SBP-128C/SBS-128G1B

LC-H300
硬式携带盒

CBK-VF02 取景器

CA-TX70 HD 摄像机控制单元

MEAD-SD02 介质适配器

HDVF-20A/200/
C30WR/C35W/EL75/
L750/L770 取景器

QDA-EX1 XQD ExpressCard 适配器

CA-FB70 高清摄像机适配器

BC-L90 电池
充电器
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本产品经 MPEG-4 Visual Patent Portfolio 许可

证的许可，用于个人和非商业使用的消费者

（i）编码符合 MPEG-4 Visual 标准

（“MPEG-4 VIDEO”）的视频

和 / 或
（ii）解码通过个人和非商业使用的用户编

码，和 / 或从经 MPEG LA 许可提供 MPEG-4
视频的提供者获得的 MPEG-4 视频。

不包括任何其他用途的明示或暗示许可。附

加信息包括，可能可以从 MPEG LA, LLC 获

得有关业务、内部和商业使用的许可。请参

见 HTTP://WWW.MPEGLA.COM

MPEG LA 为 （i）任何保存 MPEG-4 Visual 
视频信息的存储介质的生产 / 销售 （ii）以任

何形式 （例如，在线视频发行服务、互联网

广播、电视广播）发行 / 广播 MPEG-4 Visual 
视频信息提供许可。本产品的其它用途可能

需要获得 MPEGLA 许可。有关更多信息，请

联系 MPEG LA。 MPEG LA、 L.L.C.、 250 
STEELE STREET、 SUITE 300、 DENVER、
COLORADO 80206、 http://www.mpegla.com

除了用户个人使用外，未经 MPEG LA, L.L.C
（250 STEELE STREET, SUITE 300, DENVER, 
COLORADO 80206）的 MPEG-2 专利文件中

的适用专利的许可，禁止以任何形式使用符

合 MPEG-2 标准编码的视频信息

PACKAGED MEDIA。

“PACKAGED MEDIA”表示用于保存 DVD
电影等出售 / 发行给普通客户的 MPEG-2 视

频信息的存储介质。 PACKAGED MEDIA 的

光盘制作商或销售商需要从 MPEG LA 获得

经营许可证。 有关详情请联系 MPEG LA。 
MPEG LA. L.L.C., 250 STEELE STREET, 
SUITE 300, DENVER, COLORADO 80206
http://www.mpegla.com

MPEG-4 Visual 
Patent Portfolio 许可

证

MPEG-2 Video 
Patent Portfolio 许可

证
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本产品采用从 Ricoh Company, Ltd 购买的

RICOH 位图字体。

IMPORTANT: 
BEFORE USING THE SOFTWARE 
CONTAINED IN THE CAMCORDER, 
PLEASE READ THIS END USER LICENSE 
AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE 
ACCEPTING THE TERMS OF THIS EULA. IF 
YOU DO NOT ACCEPT THE TERMS OF THIS 
EULA, YOU MAY NOT USE THE 
SOFTWARE.

This EULA is a legal agreement between you and 
Sony Corporation (“SONY”). This EULA 
governs your rights and obligations regarding the 
software of SONY and/or its third party licensors 
(including SONY’s affiliates) and their respective 
affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the camcorder, 
together with any updates/ upgrades provided by 
SONY, any printed, on-line or other electronic 
documentation for such software, and any data 
files created by operation of such software 
(collectively, the “SOFTWARE”). 

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user 
license agreement (including, but not limited to, 
GNU General Public license and Lesser/Library 
General Public License) shall be covered by such 
applicable separate end user license agreement in 
lieu of the terms of this EULA to the extent 
required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, music, text 
and “applets” incorporated into the SOFTWARE) 

关于位图字体 最终用户许证可协议
170



is owned by SONY or one or more of the THIRD-
PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the 
SOFTWARE solely in connection with the 
camcorder and only for your individual use. 
SONY and the THIRD-PARTY SUPPLIERS 
expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual 
property rights) in and to the SOFTWARE that 
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or 
create any derivative works from or of the 
SOFTWARE unless such derivative works are 
intentionally facilitated by the SOFTWARE. You 
may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. 
You may not bypass, modify, defeat or 
circumvent any of the functions or protections of 
the SOFTWARE or any mechanisms operatively 
linked to the SOFTWARE. You may not separate 
any individual component of the SOFTWARE 
for use on more than one camcorder unless 
expressly authorized to do so by SONY. You may 
not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not 
share, distribute, rent, lease, sublicense, assign, 
transfer or sell the SOFTWARE. The software, 
network services or other products other than 
SOFTWARE upon which the SOFTWARE’S 
performance depends might be interrupted or 
discontinued at the discretion of the suppliers 
(software suppliers, service suppliers, or SONY). 
SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other 
products will continue to be available, or will 
operate without interruption or modification. 

EXCLUDED SOFTWARE AND OPEN 
SOURCE COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE 
may include EXCLUDED SOFTWARE. Certain 
EXCLUDED SOFTWARE may be covered by 
open source software licenses (“Open Source 
Components”), which means any software 
licenses approved as open source licenses by the 
Open Source Initiative or any substantially 

similar licenses, including but not limited to any 
license that, as a condition of distribution of the 
software licensed under such license, requires 
that the distributor make the software available in 
source code format. If and to the extent disclosure 
is required, please visit www.sony.com/linux or 
other SONY-designated web site for a list of 
applicable OPEN SOURCE COMPONENTS 
included in the SOFTWARE from time to time, 
and the applicable terms and conditions 
governing its use. Such terms and conditions may 
be changed by the applicable third party at any 
time without liability to you. To the extent 
required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will 
apply in lieu of the terms of this EULA. To the 
extent the terms of the licenses applicable to 
EXCLUDED SOFTWARE prohibit any of the 
restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will 
not apply to such EXCLUDED SOFTWARE. To 
the extent the terms of the licenses applicable to 
Open Source Components require SONY to make 
an offer to provide source code in connection with 
the SOFTWARE, such offer is hereby made.

USE OF SOFTWARE WITH 
COPYRIGHTED MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties. Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements. You agree to 
use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such 
content. You acknowledge and agree that SONY 
may take appropriate measures to protect the 
copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are 
not limited to, counting the frequency of your 
backup and restoration through certain 
SOFTWARE features, refusal to accept your 
request to enable restoration of data, and 
termination of this EULA in the event of your 
illegitimate use of the SOFTWARE.

CONTENT SERVICE
PLEASE ALSO NOTE THAT THE 
SOFTWARE MAY BE DESIGNED TO BE 
USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF 
THE SERVICE AND THAT CONTENT IS 
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SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU 
DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE 
LIMITED. You acknowledge and agree that 
certain content and services available through the 
SOFTWARE may be provided by third parties 
over which SONY has no control. USE OF THE 
CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT 
SERVICE MAY BE DISCONTINUED AT ANY 
TIME.

INTERNET CONNECTIVITY AND THIRD 
PARTY SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet 
connection for which you are solely responsible. 
Further, you are solely responsible for payment of 
any third party fees associated with your Internet 
connection, including but not limited to Internet 
service provider or airtime charges. Operation of 
the SOFTWARE may be limited or restricted 
depending on the capabilities, bandwidth or 
technical limitations of your Internet connection 
and service. The provision, quality and security of 
such Internet connectivity are the sole 
responsibility of the third party providing such 
service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export 
and re-export restrictions and regulations of the 
area or country in which you reside, and not to 
transfer, or authorize the transfer, of the 
SOFTWARE to a prohibited country or otherwise 
in violation of any such restrictions or 
regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, 
aircraft navigation or communication systems, air 
traffic control, direct life support machines, or 
weapons systems, in which the failure of the 
SOFTWARE could lead to death, personal injury, 
or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of 
the THIRD-PARTY SUPPLIERS, and each of 
their respective affiliates specifically disclaim 
any express or implied warranty, duty or 

condition of fitness for HIGH RISK 
ACTIVITIES. 

EXCLUSION OF WARRANTY ON 
SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you are 
responsible for use of the SOFTWARE. The 
SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, 
EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, 
NONINFRINGEMENT AND FITNESS FOR A 
PARTICULAR PURPOSE. SONY DOES NOT 
WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE 
FUNCTIONS CONTAINED IN ANY OF THE 
SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE 
UPDATED, (B) THAT THE OPERATION OF 
ANY OF THE SOFTWARE WILL BE 
CORRECT OR ERROR-FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED, (C) THAT 
THE SOFTWARE WILL NOT DAMAGE ANY 
OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, 
NETWORK SERVICES (INCLUDING THE 
INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE 
SOFTWARE’S PERFORMANCE DEPENDS 
WILL CONTINUE TO BE AVAILABLE, 
UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE 
IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR 
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN 
AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE 
THE SCOPE OF THIS WARRANTY. SHOULD 
THE SOFTWARE PROVE DEFECTIVE YOU 
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ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR 
CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THESE EXCLUSIONS 
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES FOR BREACH OF ANY EXPRESS 
OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR UNDER ANY OTHER LEGAL 
THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY 
DAMAGES ARISING OUT OF LOSS OF 
PROFITS, LOSS OF REVENUE, LOSS OF 
DATA, LOSS OF USE OF THE SOFTWARE 
OR ANY ASSOCIATED HARDWARE, DOWN 
TIME AND USER’S TIME, EVEN IF ANY OF 
THEM HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN ANY 
CASE, EACH AND ALL OF THEIR 
AGGREGATE LIABILITY UNDER ANY 
PROVISION OF THIS EULA SHALL BE 
LIMITED TO THE AMOUNT ACTUALLY 
PAID FOR THE PRODUCT. SOME 
JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION 
OR LIMITATION MAY NOT APPLY TO 
YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but 
not limited to information about (i) the 
SOFTWARE and (ii) the software applications, 
contents and peripheral devices that interact with 
your camcorder and the SOFTWARE 
(“Information”). Information includes, but is not 
limited to: (1) unique identifiers relating to your 
camcorder and its components; (2) performance 

of the camcorder, the SOFTWARE and their 
components; (3) configurations of your 
camcorder, the SOFTWARE and the software 
applications, contents and peripheral devices that 
interact with the camcorder and the 
SOFTWARE; (4) use and frequency of use of the 
functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral 
devices that interact with the SOFTWARE; and 
(5) location data, as indicated below. SONY and 
its affiliates, partners and agents may use and 
disclose Information subject to applicable laws in 
order to improve its products and services or to 
provide products or services to you. Such uses 
include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to 
improve, service, update or upgrade the 
SOFTWARE; (c) improving, developing and 
enhancing the current and future products and 
services of SONY and other parties; (d) to 
provide you with information about the products 
and services offered by SONY and other parties; 
(e) complying with applicable laws or 
regulations; and (f) to the extent offered, 
providing you with location-based services of 
SONY and other parties, as indicated below. In 
addition, SONY retains the right to use 
Information to protect itself and third parties from 
illegal, criminal or harmful conduct.

Certain services available through the 
SOFTWARE may rely upon location 
information, including, but not limited to, the 
geographic location of the camcorder. You 
acknowledge that for the purpose of providing 
such services, SONY, the THIRD-PARTY 
SUPPLIERS or their partners may collect, 
archive, process and use such location data, and 
that such services are governed by the privacy 
policies of SONY or such third party. By using 
any such services, you agree that you have 
reviewed the privacy policies applicable to such 
services and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally 
identify the owner or user of the SOFTWARE 
without your knowledge or consent. Any use of 
Information will be in accordance with the 
privacy policies of SONY or such third party. 
Please contact applicable contact address of each 
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area or country for SONY’s current privacy 
policy.

Please contact applicable third parties for privacy 
policies relating to personally identifiable and 
other information you provide when you use or 
access third party software or services.

Information may be processed, stored or 
transferred to SONY, its affiliates or agents which 
are located in countries outside of your country of 
residence. Data protection and information 
privacy laws in certain countries may not offer the 
same level of protection as your country of 
residence and you may have fewer legal rights in 
relation to Information processed and stored in, or 
transferred to, such countries. SONY will use 
reasonable efforts to take appropriate technical 
and organizational steps to prevent unauthorized 
access to or disclosure of Information, but does 
not warrant it will eliminate all risk of misuse of 
such Information.

AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-PARTY 
SUPPLIERS may automatically update or 
otherwise modify the SOFTWARE, including, 
but not limited to, for purposes of enhancement of 
security functions, error correction and 
improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may 
delete or change the nature of features or other 
aspects of the SOFTWARE, including, but not 
limited to, functions you may rely upon. You 
acknowledge and agree that such activities may 
occur at SONY’s sole discretion and that SONY 
may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of 
such update or modifications. Any updates/
modifications shall be deemed to be, and shall 
constitute part of, the SOFTWARE for purposes 
of this EULA. By acceptance of this EULA, you 
consent to such update/ modification. 

ENTIRE AGREEMENT, WAIVER, 
SEVERABILITY 
This EULA and SONY’s privacy policy, each as 
amended and modified from time to time, 
together constitute the entire agreement between 
you and SONY with respect to the SOFTWARE. 
The failure of SONY to exercise or enforce any 
right or provision of this EULA shall not 

constitute a waiver of such right or provision. If 
any part of this EULA is held invalid, illegal, or 
unenforceable, that provision shall be enforced to 
the maximum extent permissible so as to maintain 
the intent of this EULA, and the other parts will 
remain in full force and effect. 

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for 
the International Sale of Goods shall not apply to 
this EULA. This EULA shall be governed by the 
laws of Japan, without regards to conflict of laws 
provisions. Any dispute arising out of this EULA 
shall be subject to the exclusive venue of the 
Tokyo District Court in Japan, and the parties 
hereby consent to the venue and jurisdiction of 
such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this 
EULA to the contrary, you acknowledge and 
agree that any violation of or non-compliance 
with this EULA by you will cause irreparable 
harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that 
SONY deems necessary or appropriate in such 
circumstances. SONY may also take any legal 
and technical remedies to prevent violation of 
and/or to enforce this EULA, including, but not 
limited to, immediate termination of your use of 
the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to 
violate this EULA. These remedies are in addition 
to any other remedies SONY may have at law, in 
equity or under contract.

TERMINATION
Without prejudice to any of its other rights, 
SONY may terminate this EULA if you fail to 
comply with any of its terms. In case of such 
termination, you must: (i) cease all use, and 
destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section 
below entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND 
ANY OF THE TERMS OF THIS EULA AT ITS 
SOLE DISCRETION BY POSTING NOTICE 
ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL 
ADDRESS PROVIDED BY YOU, BY 
PROVIDING NOTICE AS PART OF THE 
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PROCESS IN WHICH YOU OBTAIN 
UPGRADES/ UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, 
you should promptly contact SONY for 
instructions. Your continued use of the 
SOFTWARE after the effective date of any such 
notice shall be deemed your agreement to be 
bound by such amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended third-party beneficiary of, and shall have 
the right to enforce, each provision of this EULA 
with respect to the SOFTWARE of such party.

Should you have any questions concerning this 
EULA, you may contact SONY by writing to 
SONY at applicable contact address of each area 
or country.

Copyright © 2012 Sony Corporation.

本产品基于 Sony 与软件版权持有者之间的许

可证合同使用开放式软件。

为满足软件版权持有者的要求， Sony 有义务

告知您这些许可证的内容。

有关这些许可证的内容，请参见附带的 CD-
ROM “License”文件夹中的

“License1.pdf”。

开放式软件许可证
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• Android和Google Chrome是Google, Inc.的商

标或注册商标。

• Microsoft、 Windows 和 Windows Vista 是

Microsoft Corporation 在美国和 / 或其他国

家 / 地区的注册商标或商标。

• Apple、Macintosh、Safari 和 iPhone 及其徽标

是 Apple Inc. 在美国和其他国家 / 地区的商

标或注册商标。

• HDMI、 HDMI High-Definition Multimedia 
Interface 和 HDMI 标识是 HDMI Licensing 
LLC 在美国和其他国家的商标或注册商标。

• 所有系统名称和产品名均是其各自所有者

的注册商标或商标。 本文档未使用 ® 或 ™
符号表示商标项目。

商标
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本手册中包含的材料是属于 Sony Corporation
的财产的信息，仅供本手册中所述设备的购

买者使用。

Sony Corporation 明确禁止在未得到 Sony 
Corporation 明确书面许可的情况下对本手册

的任何部分进行复制或用于对本手册中所述

设备进行操作或维护以外的任何用途。
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